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CHAPTER 1
The ARGUS Developer Workplace

This section provides an explanation of the items you see on the screen.

You should install your copy of Developer before you begin reading this user guide. For 
detailed instructions on installing, activating and licensing ARGUS Developer, please refer to 
the ARGUS Developer Installation Guide.

Starting ARGUS Developer
You can start ARGUS Developer by double-clicking its icon in the program folder, or double-
clicking on the shortcut created on the desktop.

When you start the program for the first time, you will be prompted to activate your license.

If you are evaluating ARGUS Developer for the first time or you have purchased a new license, 
you will need an activation code to start up. If you are upgrading an existing license (in other 
words, evaluation to full or increasing a network license from 2 users to 4 users) then you will 
require an upgrade code.

For more detailed instructions on licensing ARGUS Developer, please refer to the ARGUS 
Developer Installation Guide.

What’s on the Screen?
This section provides an overview of the major elements on the ARGUS Developer screen, such as 
title bar, toolbar, phase tab and status bar.

The Main ARGUS Developer Screen
When you start ARGUS Developer, a new, blank project is created. The following illustration 
identifies each part of the ARGUS Developer screen.
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Title bar
The title bar appears at the very top of the page and shows the name of the file you are working on. 
For new projects, the name will be shown as [Untitled] until you save it under a different name.

Tool bar
If you have a mouse, you can use the buttons on the toolbar at the top of the screen, beneath the 
title bar, to access commonly used commands. You can display or hide the toolbar by selecting 
Options from the Tools menu, then either select or clear the Show Project Toolbar option.

Phase Group selector
In multi-phased projects, you can selectively group together any of the phases in any combination 
for analysis purposes. The phase group selector drop-down box allows you to choose any of the 
phase groups. When you choose a phase group, the program reformats the phase tab to show only 
the phases in the current group. You can find the selector on the bottom left-hand corner of the 
screen.

Phase tabs
The phase tab is used to navigate between individual phases in a project. Each time you select a 
phase tab, all the information relating to that phase is revealed to you, the finance calculations are 
reworked and the results are shown on the results bar and on reports.

In multi-phased projects, there is a tab titled “Merged Phases”. Choose this tab when you want to 
see the overall valuation for a group of phases. When this tab is chosen, the following happens:

1. The program re-calculates each phase in the group to determine the correct land value and 
interest charges.

2. The items in each of the grouped phases are placed in the cash flow and an overall interest 
charge is calculated.
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3. The results of the overall calculation are shown in the Results Bar.

4. The items in Definition are disabled to prevent editing of any items.

Status bar
The field you are currently working on determines what information is shown in the status bar, at 
the bottom of the screen.

The status bar displays a brief description of the currently selected field in the Definition tab. If you 
are saving or loading a project, that status bar displays a progress meter to inform you that the task 
is under way.

ARGUS Zone sidebar
The ARGUS Zone sidebar (on the left-hand side of the window) allows you to work with 
Developer files that you have stored on ARGUS Zone. The sidebar provides access to folders 
within the Zone that you can use for collaborative purposes, wherever you are in the world. 
ARGUS Zone (formerly known as RealPulse) provides access to services and resources that aid 
you in your use of ARGUS products.

You can log into the Zone using the sidebar, or via the use of the ARGUS Zone website:

http://www.arguszone.com

On occasions when you are not using the ARGUS Zone sidebar, you can hide it by clicking on the 
arrow button that appears between the Zone sidebar and the tabs in the main window.

See “Using the ARGUS Zone sidebar” on page 230 for further information.

Licensing information
A part of ARGUS Developer that is particularly useful (especially when calling technical support) 
is the About ARGUS Developer dialog.

To display this dialog, use the Help | About ARGUS Developer menu option:

About dialog box

This dialog contains contact details for ARGUS Software and information about the version 
number of the software, licensing and modules installed.

http://www.arguszone.com
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CHAPTER 2
Starting Work - Assumptions

This section explains the basic procedures for creating new projects, saving your work, opening 
existing projects and printing.

Creating a Project

To create a new project at any time, click on the Start New Project button on the toolbar.

If you are currently working on a project, you will be prompted to save it before the new project is 
created.

You will be asked to select the template you require if more than one template is available. Users 
are able to compile many templates, each template containing the common, core information 
required for a development type.

The new project will be created with your standard calculation options already set.

Project Details
The Project Tab is used to enter general details, including the title, address, user’s name and project 
start date.
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You can also change settings for Calculation Assumptions, Timescale, Finance and Residual 
targets.

Titles You can enter two title descriptions of up to 80 characters each.

Address Three fields are available for the property address, each of which can be up to 80 
characters long.

Created By Enter your name or initials into this field.

Start Date and Timescale Adjustment
Project Start Date Enter the starting date or click onto the Project Start Date hypertext link and 
use the Date Picker to pick a date:

If you change the project start date with the Date Picker, you will see a dialog like the following:

If you just wish to accept the date you have chosen with the Date Picker, just click on OK without 
changing any of the settings in this dialog.

This dialog will allow you to specify how your phases and timescale should be adjusted.

First, specify how you want the phase start date to be adjusted, using the controls in the Phase 
Start Dates section:

• Keep Phase Start Dates - This option allows you to keep the phase start dates for phases after 
the project start date. Any phases with start dates before the project start date will be adjusted.

• Keep the same lead in period from the Project Start Date - This option allows you to keep 
the same lead in period between the project start date and the phase start date.
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• Align Phase Start Dates to the Project Start Date - This option allows you to change the 
phase start dates so they align with the project start date you have chosen with the Date Picker.

After this, you can specify how you want the phase timescale to be adjusted, using the controls in 
the Phase Timescale Adjustments section. Here, you can adjust a phase’s timing relative to a 
specific date, period or the project date.

• Keep Specific Date/Period/Offsets to Project Start/End - These options allow you to keep the 
date, period or offsets that you have specified. By default, when you choose a date with the 
Date Picker, the Keep Specific Date option will be automatically selected.

• Adjust Date/Period/Offsets to maintain timing relative to the Phase Start - These options 
allow you to specify that ARGUS Developer will automatically adjust the project start date 
timing in order to maintain a relative timing with the phase start. You can do this by specifying 
that the adjustment is to be made by date, period or timing offset.

Calculation Assumptions
Before working with ARGUS Developer for the first time, you should check the assumptions for 
calculation. For example, you might want to:

• Specify the distribution curve type for construction payments;

• Check the assumptions for receipts and income flow;

• Specify the finance setup - Structured Financing or 100% debt funding;

• Specify Residual targets for Acquisition Price.

To change the assumptions for calculation

Click on the Assumptions button on the toolbar.
The Assumptions dialog box is divided into several tabs. When you select a tab, the options for that 
tab are displayed. Settings are determined by selecting or clearing the check boxes or by typing or 
selecting new information. The new settings take effect when you close the dialog box, and remain 
in effect until you change them.
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Expenditure Tab
See above picture for screenshot.

You can make settings for Professional Fees, Purchaser’s Costs and Sales Fees on this page.

Professional Fees
Professional fees are related to the base construction costs. In addition, you may include 
Contingency and Demolition/Road payments.

Purchaser’s Costs
Note:  To show options for purchaser’s costs in the appraisal, select File | Administration | 
System Configuration and then tick Show Purchaser’s Costs.

Purchaser’s Costs may be viewed in two ways - as (a) a deduction from the Gross Capitalization, or 
(b) as an addition to the total costs:

• To deduct Purchaser’s Costs from the Gross Capitalization and place them in the Realization 
section of the Project Pro Forma, select Deducted from Revenue.

• To add Purchaser’s Costs to the total project costs and show them in the Costs section of the 
Project Pro Forma, select Added to Costs.

There are two options for the calculation of Purchaser’s Costs. They can be calculated on the Gross 
Development Value or on the Net Development Value.

In some circumstances, it will be appropriate to include Unit Sales in addition to Capitalized Rent 
in the calculation of Purchaser’s Costs. Check the Apply to Unit Sales box to include any unit 
sales.

Unit sales may include housing for example, where the net value, or price, of the house is the 
known value. Capitalized rents would, conversely, be discounted to calculate the price from a 
known gross value which includes purchaser’s costs.

Sales Fees
Sales Fees may be viewed in two ways - as (a) a deduction from the Gross Capitalization, or (b) as 
an addition to the total costs.

• To deduct Sales Fees from the Gross Capitalization and place them in the Realization section of 
the Project Pro Forma, select Deducted from Revenue.

• To add Sales Fees to the total project costs and show them in the Cost section of the Project Pro 
Forma, select Added to Costs.

There are two options for the calculation of Sales Fees. They can be calculated on the Gross 
Development Value or on the Net Development Value.
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Receipts Tab
Options for tenants’ rental flow and capitalization methods.

Tenant’s Rent
ARGUS Developer can automatically generate income streams for tenants where developments are 
retained as investments or where pre-lets are achieved. Before an income stream can be generated, 
valid lease terms must have been entered for the appropriate tenants. Where lease terms have not 
been entered, no income stream will be generated. 

To Do this
Generate an income flow from the tenant’s lease Check the Show tenant’s true income 

stream check box.
Use the income streams to offset development 
costs

Check the Offset income against 
development costs check box.

Add the income streams to the project’s revenue 
balance

Uncheck the Offset income against 
development costs check box.

Set the rent payment cycle for existing tenants 
definitions and each new tenant

Select the rent payment cycle from the drop-
down box and check the Apply Cycle to all 
tenants check box.

Set the rent payment cycle for new tenants, 
leaving the existing tenants alone

Select the rent payment cycle from the drop-
down box and uncheck the Apply Cycle to 
all tenants check box.

Apply a Vacancy and Rent Free period for the 
first lease renewal only

Check the Vacancy and Rent Free apply 
to first renewal only check box.

Specify a Vacancy and Rent Free period for all 
lease renewals

Uncheck the Vacancy and Rent Free apply 
to first renewal only check box.

Specify that the escalation starts from the Lease 
Start Date.

Check the Growth starts from  Lease Start 
Date check box.

Specify that the Ground Rent is deducted from 
Stepped Rent.

Check the Deduct Ground Rent From 
Stepped Rent check box.
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Note: When income is generated, the Rent Free Cost options will be disabled, as the Rent 
Free period will be accounted for within the cash flow.

Capitalization

When the Capital Value is Modified
When you are editing area-based items in the Cash flow, ARGUS Developer will update the linked 
area definition. However, when a Capitalized Rent is modified, there are two possibilities:

• Keep the Rent the same and recalculate the Cap Rate;

or:

• Keep the Cap Rate the same and recalculate the Rent Rate or the Market Rental Value. 

Select Recalculate the Cap Rate or Recalculate the Rent Rate or Market Rental Value as 
appropriate.

Valuation Tables
You can choose the way in which rents and ground leases are valued from the Valuation Tables 
option. Options available are: Annually in Arrears, Quarterly in Advance (Effective) and 
Quarterly in Advance (Nominal).

To Do this

Use the hardcore method for capitalization (not 
used in the US).

In the Capitalization Method drop-down, 
select the “Hardcore” option.

Use the Capitalize Sale Date NOI method for 
capitalization (formerly called “initial yield 
method” in previous versions).

In the Capitalization Method drop-down, 
select the “Capitalize Sale Date NOI” 
option.

Use the Capitalize 12 Month NOI method for 
capitalization.

In the Capitalization Method drop-down, 
select the “Capitalize 12 Month NOI” 
option. See “Calculation of NOI for 
Capitalization based on 12 months from 
date of sale” on page 11.

Apply a default capitalization rate to a new 
tenant as it is created.

Enter the desired capitalization rate into the 
Default Capitalization Rate field.

Apply the same capitalization rate to all existing 
tenants and to all new tenants.

Check the Apply Cap Rate to all tenants 
check box.

Allow users to establish a tenant by tenant 
capitalization rate.

Uncheck the Apply Cap Rate to all 
tenants check box.

Automatically assign a sale date to each tenant. Check the Default stage for Sale Date and 
choose a stage from the drop-down list.

Synchronize the end of the income flow with the 
sale of the property.

Check the Align end of income stream to 
Sale Date check box.

Synchronize the end of the income flow with the 
sale of the property to all tenants.

Check the Apply Alignment to all tenants 
check box.

Remove TI costs and Lease Commissions from 
the capitalization.

Check the Deduct post-sale TI costs and 
Lease Commissions from Capital Value 
check box.

Reduce the proceeds of sale when the 
“Capitalize 12 Month NOI” method is active.

Check the Deduct Post-Sale TI Costs and 
Lease Commissions from Capital Value 
check box.
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Rent Free Cost Methods
There are several approaches to the calculation of Rent Free Costs.

If you have elected to generate income streams for each tenant, the start of the rent flow will be 
delayed by the length of the Rent Free period. The options shown in the Rent Free Costs section 
will be unavailable.

In cases where income streams are not required, there are two options to represent the loss of 
income:

1. Change the Capital Value by applying a Present Value calculation to each tenant. Each Capital 
Value will be discounted, or deferred, by the length of the Rent Free period using the 
Capitalization Rate.

2. Take a proportion of the MRV and either deduct it from the Revenue balance, or add it to the 
Cost balance.

Calculation of NOI for Capitalization based on 12 months from date of 
sale
Calculations

The “Capitalize 12 month NOI” option uses the following calculation methodology:

1. Base Rental Income - includes the following:

• Base Rent from current term at the time of sale and continuing as per the actual term of the 
lease (such as escalations or steps if any).

• If the current term ends during the 12 month period, market rental value during any vacant and/
or free rent periods.

• Renewal rent for any subsequent term(s) that fall within the 12 month period.

All of these are subject to any vacancy percentage or fixed amount that was applied at the point of 
sale (in other words, under the Capitalization section of the Area form). The aggregate of these is 
the basis of capitalization for the base income component. No further adjustment is made where 
there is rental loss due to vacancy or free rent.

2. % Rent - if there is any percentage rent calculated, it would only apply for the remainder of the 
term in effect at the time of sale (maximum of 12 months), plus any renewal (only where there 
is no vacancy  or free rent between terms) that falls within the 12 month period. No adjustment 
would be made for “market” percentage rent or any renewals where there has been a vacancy or 
free period.

3. Rent Additions and Costs - only those that are capitalized are included. Rent Additions and 
Costs are calculated during periods of free rent, so only the treatment of Rent Additions and 
Costs during vacancy need to be considered. Since Base Rent is being calculated during periods 
of Vacancy, Rent Additions and Costs are included also to simulate having a lease in place. 
Therefore, Rent Additions and Costs are included during the entire 12 month period, with no 
need to do separate calculations for each base term/vacant/renewal segment that could be 
included in the 12 months. These are not subject to vacancy at this time.

4. TIs and Lease Commissions - it is possible to have TIs and/or Commission costs payable in 
respect of a new or renewal lease that would commence during the 12 month projection.
On the Receipts tab in the “Capitalization” area, if the Deduct Post-Sale TI Costs and Lease 
Commissions from Capital Value check box is checked on, this reduces the proceeds of sale 
when this Capitalization method is active.

Escalation and Inflation

During the 12 month run off period, it is assumed that escalation will continue on rent, turnover  
(percentage) rent and Additional Rent revenues. Inflation will continue on TI costs and Additional 
Rent costs.
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Historic Data Files

Existing files are defaulted to calculate according to the current calculation methodology, in respect 
of capitalization (in other words, “off”) so values will not change on existing files.

Finance Tab

Finance in ARGUS Developer can be analyzed in different ways:

1. Basic (Interest Sets) offers 100% debt funding.

2. Structured Financing.

Please see “Structured Finance” on page 135. for a detailed explanation on Structured Finance.

Select Basic (Interest Sets) and many of the options on this page will be available. Select 
Structured Finance and the options on this page will be disabled, since the values are input 
elsewhere in the program.

The Structured Finance functionality is a separate module of the ARGUS Developer program. It 
may or may not be available depending on the contract entered into by the user. The module can be 
activated later if it is not currently available. This can be done without the need to upgrade the 
software but using an alphanumeric code that enables the module. This ensures that Structured 
Financing can be switched on quickly.

Compounding Period
This is only available when Basic (Interest Sets) is selected.

The period at which the interest will be added to the principal amount. Possible values are 
Monthly, Quarterly, Semi Annually and Annually.

Charging Period
The period in which the interest amount will be charged and shown in the cash flow. This setting 
does not affect the calculation of interest.

Calculate Interest on Payments/Receipts in Final Period
Selecting this option will allow interest to be rolled up into the Exit Period of the cash flow. Untick 
this option and interest will not be charged in the Exit Period.
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Include Interest and Finance Fees in IRR Calculations
Selecting this option will use the interest values and finance arrangement fees when calculating the 
IRR for the project. This option is available for both Basic (Interest Sets) and Structured Financing 
methods.

Automatic Inter-Account Transfers
When this option is selected, a surplus in any of the interest accounts will be used to pay off costs 
in other accounts. This option is normally left unchecked.

Manual Finance Rate for Profit Erosion
If this option is selected, you can enter the finance rate that will be used to calculate the Profit 
Erosion. Profit Erosion is displayed on the Project Pro Forma page.

Repeat Interest In End Period
If selected, this will repeat the penultimate month’s interest in the sale period.

Calculation Tab

Note: The options you see displayed on this tab depend on what has been selected in the 
System Configuration window. To display all options, select File | Administration | System 
Configuration and then tick the appropriate check boxes.

The timing of Payments and Receipts is specified on this page. Site Payments can be timed 
differently from other payments.

Timing
The following controls are available in the Timing section:

Site Payments

If site payments take place at the beginning of each period, select Advance. If they take place at the 
end of each period, select Arrears.
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Other Payments

If payments other than site payments take place at the beginning of each period, select Advance. If 
they take place at the end of each period, select Arrears.

Negative Land

If negative land payments take place at the beginning of each period, select Advance. If they take 
place at the end of each period, select Arrears.

Receipts

If receipts take place at the beginning of each period, select Advance. If they take place at the end 
of each period, select Arrears. Receipts are usually in Advance.

IRR Options
The following controls are available in the IRR Options section:

Initial Guess Rate

The IRR calculation requires a starting point. This option is used to specify that point and is 
defaulted to 8%. It will not normally be necessary to change this value.

The Minimum and Maximum IRR options refer to the thresholds within which an IRR will be 
reported. If the calculated IRR is outside either of the specified thresholds, it will be reported as 
“Out of Range” in the Results bar.

Minimum

Here, you can specify a lower threshold.  If it is under this threshold, an IRR will be reported as 
“Out of Range”.

Maximum

You can use this field to specify a higher threshold. If it is over this threshold, an IRR will be 
reported as “Out of Range”.

IRR Tolerance

When calculating an IRR, ARGUS Developer discounts the cashflow repeatedly until the Net 
Present Value falls between zero and the IRR Tolerance.

Discounting Options
The following controls are available in the Discounting Options section:

Manual Discount Rate

Where the cash flow is to be discounted at a rate other than the IRR, select this option and enter the 
discount rate. The Present Value and rate will be shown in the Performance Measures section of the 
Project Pro Forma report.

Leasing/Rent Review Fees calculated on
Leasing and rent review fees can either be calculated off the gross Market Rental Value (Gross 
MRV) or the MRV after deductions (MRV Net of Deductions).

Note: To enable these calculation options in the Assumptions for Calculation form, select File 
| Administration | System Configuration and then tick Show Leasing/Rent Review Fees 
options.

Vacancy Costs calculated on
Vacancy costs can either be calculated off the gross area (Gross Area) or the area after deductions 
(Net  Area).
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Development Yield, Rent Cover
The performance measures Development Yield and Rent Cover can be calculated on the gross exit 
MRV, or the exit MRV after deductions for service charges and/or ground rent. You can specify the 
calculation method by selecting either of the following radio buttons:

• MRV at Sale Date(s)

• Rent at Sale Date(s)

To allow backwards compatibility with older versions of ARGUS Developer, Development Yield 
options available here are:

• Include Tenants with no Capital Value
If a tenant has no capital value because of a zero yield or Initial Yield Valuation, you can 
include the MRV by checking this check box.

• Include Turnover Rent
This option will only be visible if you have selected Show Net Development Yield option in 
the System Configuration window (see “System Configuration” on page 257). This option 
allows you to include Turnover (or percentage) rent in the Development Yield calculation.

• Net of Non-Recoverable Costs
To deduct percentage and/or fixed deductions from MRV, check this check box.

• Net of Ground Rent
To deduct Ground Rent from MRV, check this check box.

• Net of Rent Additions/Costs
To include Rent Additions/Costs, check this check box.

Note: To enable these calculation options in the Assumptions for Calculation form, select File 
| Administration | System Configuration and then tick the Show Net Development Yield 
option.

Interest/PR Sets Tab
ARGUS Developer enables interest to be calculated by applying Interest and Preferred Return (PR) 
Sets to every item in the cash flow. A default interest set is automatically applied to each new cost 
and receipt as it is entered.

A Set is a group of interest rates that are identified by name and are entered by the user.

A common debit and credit interest rate, or Preferred Return, set is used when the Structured 
Financing option is selected. Note that when Structured Financing is used, an Interest Set is 
applied to a Source’s total contributions, not to individual cost or receipt items.

Separate debit and credit rates are available when Basic (interest sets) are used.

ARGUS Developer defaults to use the first set from the list shown to the left hand side of the 
window. Highlight an entry from the list and the relevant rates are shown in detail on the right.

Users can vary interest rates over time by entering changing rates and the number of months over 
which each interest rate will run. Rates are entered as annual equivalent values. Enter a rate for zero 
months and ARGUS Developer will run this rate in perpetuity or, in reality, to the end of the cash 
flow.

All items with the same interest set will use the same rates when calculating finance. If you modify 
the rates within a set, ARGUS Developer recalculates the finance costs for all items attached to that 
set.

Interest is calculated on the net total amount in each period. Where the net period total is negative 
(in other words, an outflow), the Debit rate is applied. Where the net period total is positive (in 
other words, an income), the Credit rate is applied.

An interest set called “Construction Loan” is always created automatically when you start a new 
project.
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Enter the Debit and Credit rates, and the number of months, into the table.

The example above features only two Sets. Many more could be entered, however. “Construction 
Loan” is highlighted on the left hand side and the individual rates appear to the right. The 
development appraisal above is currently running Basic (Interest Sets), so both debit and credit 
rate columns are shown. Select Structured Financing and one interest rate column appears. The 
values entered are used for both interest charging and Preferred Return purposes.

Users can enter multiple interest rates against each loan type or Set. Interest calculations can 
therefore take account of anticipated interest rate changes over time. Whether the percentage rate is 
anticipated to run for 6 months or 36, the percentage rate is always an annual value. Entering zero 
months against a percentage rate means that rate will run in perpetuity from that point in time. We 
suggest users always enter zero months against the last rate. This ensures interest will always 
continue to be charged if the length of the cash flow is extended by one month or 30 years.

To add an Interest Set, click on the Add button on the toolbar. Enter the Debit and Credit rates into 
the table as applicable.

To delete an Interest Set, highlight the relevant Set and click on the Delete button on the toolbar.

Inflation and Escalation Tab
The following topic refers to Inflation, but the principles apply equally to Rent Escalation sets.

Inflation Sets
Cost Inflation is incorporated by attaching an Inflation Set - essentially a list of rates - to a cost in 
either the Definitions page or the Cash Flow. An inflation set is a shorthand way of identifying 
inflation rates by a name. All costs attached to an inflation set will use the same rate when 
calculating inflation. If you modify the rate within a set, ARGUS Developer recalculates the 
inflation for all costs attached to that set.
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A set called “Inflation Set 1” is created for each new project and more can be added when 
necessary. By default, inflation is not applied to any cost. A set can hold up to 10 different inflation 
rates, each of which becomes active on a specified date.

When a cost has inflation applied to it, the inflated figure is shown on all screens and reports.

To add an Inflation/Escalation Set, click the Add button on the toolbar. Enter a name to identify the 
set and then type the rates and dates for each step. Note that the rate will be used in perpetuity, 
unless a number of months is entered or a date is entered against the next step.

To delete an Inflation/Escalation Set, click the Delete button on the toolbar. Any cost that used the 
deleted set will now have inflation/escalation ignored. If you want inflation applied to these items, 
you will need to attach another inflation/escalation set.

Stepped
When selected, this allows you to step inflation/escalation on an annual basis. If selected, the 
anniversary month becomes active and you can choose which month coincides with the increase.

Anniversary Month
This is the month from which the inflation/escalation starts. Select the month from the drop-down 
list. Before you can use this control, you must first check the Stepped check box.

Pro-Rate to First Anniversary
This starts the calculation from the first period, using a compounding approach. Before you can use 
this control, you must first check the Stepped check box.

Full Rate on First Anniversary
This uses the full annual rate on the first anniversary, rather than a monthly proportion of the annual 
rate. Before you can use this control, you must first check the Stepped check box.
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Advance or Arrears
Use this drop-down list to specify whether the inflation/escalation will be applied in advance or in 
arrears.

Residual Tab
Use the Residual option for projects where the land cost is the unknown element. If you want to 
enter the land cost manually, you should select Fixed Land Value.

The options that control the residual calculations are:

• Fixed Land Value, where you enter the known land cost;

• Allow Residualized Land Only, where the program calculates the land value using a target 
type;

• Allow Residualized and Fixed Land, where you can enter a manual land value and then ask 
for the program to include the value when it does the overall residual calculation.

When you click on one of the Residual options, the following screen appears:

If you choose the Fixed Land Value, there are no further selections to make on this screen.

If you choose the Allow Residualized Land Only or Allow Residualized and Fixed Land 
options, further options are available.

You can choose a target type and rate to calculate the residualized land cost.

Target Type Click on the Target Type drop-down box and select a target. There are six target 
measures: Profit on Cost, Profit on GDV, Profit on NDV, Project IRR, Development Yield and 
Profit Amount.

Target Rate The Target Rate is the value that the residual function will use to determine whether 
the correct Land Value has been found. All Target Types will require an entry to be made for each 
defined phase.

Locked Value This allows you to exclude a phase from the residual calculation in situations where 
the land cost is fixed. Using this option, you can mix both known and unknown phase land values 
in the same project.

To allow entry of a known land cost on the Definition page, put a check in this field.

Treat Negative Land as Revenue  There may be some developments where the costs far outweigh 
any income receivable from the sale. If you are looking for a specific return in these circumstances, 
a negative land value may be generated. In essence, the program treats a negative land value as if it 
were an injection of money into the project so that a profit can be realized. Due to the sensitivity of 
the residual targeting function, it may be necessary to treat the negative land as an income rather 
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than a cost. If the program is not producing a value, try checking the Treat Neg. Land as Revenue 
check box.

Multi-Phasing - Single Land Cost
If you are working with a multi-phased project, you can elect to calculate a single, up front land 
value for all linked phases. When this option is active, the program will merge all linked phase cash 
flows before calculating a single land cost.

When viewing the cash flow or summary for individual phases, there will be no land cost or fees 
shown. To show the residual land cost valuation together with fees, select the Merged Phase tab in 
Original Linked Phases mode or in a new grouping.

If you are entering Land Transfer Tax and Acquisition Fees as percentage values, they must be 
entered into the first phase of your linked scheme. When the program is residualizing to a Land 
Value, it will use the fee structure from the first linked phase.

To calculate a single land cost:

1. Select Single Land Residual at project start from the Multi-Phasing drop-down list.

2. Choose a target type from the drop-down list.

3. Enter a value into the Single Value (target rate) field.

Multi-Phasing - Separate Valuations
You may elect to perform separate valuations for each phase in a linked scheme. When you select 
the Merged Phases tab, the individual valuations from each phase will be added together.

When viewing the Cash Flow or Project Pro Forma for individual phases, the land cost and fees 
will be included.

To calculate separate land costs:

1. Select Separate Land Residual for each phase from the Multi-Phase drop-down list.

2. Choose a target type from the drop-down list.

3. Enter a value into the target rate field. You may enter different target rates for each phase.

Distribution Tab
You can make settings for the timing of Construction Payments, Sales Receipts and Sales 
Deposits on this page.

Construction Payments
Choose the manner in which Construction Costs will be distributed in the Appraisal. The default is 
S-Curve. This may be changed by selecting a curve type from the drop-down menu.
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If a Weighted payment is selected, you can enter the weighting % value. A value less than 50% 
shows a straight-line curve whose values rise and a value greater than 50%, a curve whose values 
fall.

Sales Receipts
Choose the manner in which Sales Receipts will be distributed in the Appraisal. The default curve 
type is Single. This may be changed by selecting a curve type from the drop-down menu.

Sales Deposits
Choose the manner in which Sales Receipts will be distributed in the Appraisal. The default is an 
Even distribution. This may be changed by selecting a curve type from the drop-down menu.

If you change the option for Construction Costs, you will be asked to confirm your change, and 
whether you wish to recurve existing construction items, when you click on the OK command 
button.
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CHAPTER 3
Timescale & Phasing

This section explains the Development Timescale and Phasing options in ARGUS Developer.

Development Timescale

Before you start to enter data, you should define the Timescale.

To define a new timescale or change an existing timescale, add, delete and copy phases, choose the 
Timescale and Phasing button from the toolbar.

When the Timescale and Phasing window appears, you can enter the project start date and a phase 
name, and fill out the duration of the phase.

Stages of Development
There are 7 predefined stages of development that can be used to describe the timescale of a phase. 
Their order in the table follows the typical sequence of a development project. Each stage records 
its duration and start date, plus other information about how the stage is anchored to others.

Every cost and receipt entered into the Appraisal is linked to the one of the stages defined on this 
page. If you change the duration of any stage, all dependent costs and receipts will be automatically 
re-timed.
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Stages are normally linked together so that a change in one stage’s duration automatically re-times 
the others. The default setup is to have the timing run from Purchase to Sale, with each stage 
starting only after the previous one is completed.

Other scenarios are possible:

• Stages are linked, but you choose the order;

• Stages can be unlinked and manually timed to any date in the timescale;

• Stages can run concurrently.

Stage Name Each of the stages has a default name. You can change the name of any of the stages 
to suit your particular development. Changing the name, however, does not change the stage’s 
purpose. To change a stage name, click into the Development Stage field and press F2 to edit.

Stage Duration The duration of each stage is measured in months. You do not have to enter the 
duration for every stage. Where your project does not have a need for a stage, enter zero (0). The 
most commonly used stages are Pre-Construction, Construction and Leasing.

Start Date The starting date for the development stage.

End Date The end date for the development stage (this is a read-only calculated field).

Entering the Timescale
The timescale for a phase is entered by typing the duration of each stage into the timetable. When 
the lengths of each stage have been entered, you can modify how the stages are linked together. 
Stages can be modified using the keyboard, or by dragging bars around the time chart with the 
mouse.

To modify the timescale using the keyboard

Click on the Extra Detail Columns button on the toolbar to show detailed stage information.
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To modify the timescale using the mouse
Click into the chart part of the timetable:

To reset the timescale and re-link all stages

Click the Reset Stages to Default Layout button on the toolbar, or use the File | Reset Stages to 
Default Layout menu option.

This will reset any manual changes you have made to the stages (such as a stage being moved to a 
position before the previous stage):

Resetting will set the stages so they follow on in a neatly stepped layout, in the order in which they 
are listed:

To Do this

Change a stage’s Start Date Click in the Start Date column and select a 
date from the Date Picker.

Link a stage to another stage Select a stage from the Anchored To column.
Link a stage to the start of another stage Choose Start from the Align column.
Link a stage to the end of another stage Choose End from the Align column.
Offset a stage by a number of months from the 
start or end of another stage

Enter the number of months into the Offset 
column.

Unlink the stage and let it have its own start 
date

Select Fixed Date from the Anchored To 
column.

To Do this

Change the Start Date and unlink it from other 
stages

Click on the left end of a bar and drag either to 
the left or the right.

Change the duration independently of other 
stages and keep the start date

Click on the right end of a bar and drag to the 
left or the right.

Change the duration and change the start date 
independently of other stages

Hold down the Shift key, click on the left end 
of a bar and drag to the left or the right.

Move the stage and any dependent stages Hold down the Shift key, click into the middle 
of a bar and drag to the left or the right.

Move the stage independently of other stages Click into the middle of a bar and drag to the 
left or the right.
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Changing the timeline scale
To change the timeline to show a different scale, you can use the options provided in the Options | 
Phase Timeline Scale menu. The choices here are:

• Scale To Fit - This is the default option; it scales the display automatically to fit the number of 
months being represented.

• Monthly - This changes the display to show months.

• Quarterly - This changes the display to show quarters.

• Semi-Annual - This changes the display to show six-monthly blocks of time.

• Annual - This changes the display to show years.

Phase Details
Project Start Date To change the project start date, click on the Date Picker button. When the Date 
Picker appears, choose the Month and Year and click on OK. All dates are assumed to start on the 
first of the month.

If you change the Project Start Date, you will be asked to confirm the realignment of Phase Start 
Dates and Lease Start Dates.

Phase Start Date The start date of a phase can be later than the start date of the project. If you want 
to change the phase start date, click on the Date Picker.

Phase Name You can assign a name to a phase for easy identification on the phase tabs. To name a 
phase, type directly into the Phase Name edit box. To force the program to display the name on the 
phase tabs, select Options, then tick the Display Phase Name on tabs menu option.

Phase End Date The end date of the phase is displayed in this read-only field.

Adding a Phase

A new phase can be added at any time by using the Add Phase button on the toolbar. If you use a 
default template for your projects, it is possible to create the new phase with the settings in the 
template, otherwise a blank phase will be added.

To add a blank phase
• First, ensure that the New Project Template is set to default by using the File | 

Administration | System Configuration menu option to open the System Configuration dialog 
and selecting the default item in the New Project Template drop-down list. Click OK to exit 
this dialog.

• In the Timescale and Phasing window, click on the Add Phase button. A new blank phase is 
created and added to the end of the phase list.

 To add a phase with default values
• Use the File | Administration | System Configuration menu option to open the System 

Configuration dialog, and choose a saved template from the New Project Template drop-down 
list. Click OK to exit this dialog.

• In the Timescale and Phasing window, click on the Add Phase button. A new phase is created 
and added to the end of the phase list. It will contain any default area records, costs and fees in 
the selected template.
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Deleting a Phase

To delete a phase
• Select the tab of the phase you wish to delete and click on the Delete Phase button.

• When the phase is deleted, all area records, costs, fees and so on are deleted. If any phase other 
than the final phase is selected, phases will be renumbered after the existing phase is removed.

• If you delete the final phase, ARGUS Developer will add a default blank phase.

Copying a Phase
When you copy a phase, ARGUS Developer copies all data associated with the phase to either a 
new phase or another nominated phase in a multi-phased project.

All data including timescale, area definitions for Capitalized Rent and Sales, residual targets, costs 
and receipts will be copied into the new phase.

To copy the current phase
• Select the tab of the phase you wish to copy.

• Click on the Copy Phase button.

• Select the phase that you want to copy into:

Grouping/Linking Phases
You can break a scheme down into individual phases and then join them together to form a single 
comprehensive project. This method assumes that each phase holds all its own costs, receipts and 
land value, forming an independent project until it is linked with one or more other phases.

Within the All Phases mode, an extra tab is created, named Merged Phases. You must click on the 
Merged tab to see the addition of Results from each linked Phase.

To Do this

To add the copied data as a new phase. Check the Copy current phase data to new 
phase check box

To copy the data into an existing phase Check the Copy current phase data to phase 
then select the phase from drop-down menu. 
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To merge phases
• Click the Group Phases button on the toolbar.

• Select All Phases or add a new group.

• Choose phases that you wish to merge together by ticking the Include in Group? box.

• To extend the length of each single phase in the group to overall project length in the cash flow 
check this option.

To merge all phases within the group

Click on the Include All Phases button.

To de-select all phases

Click on the Exclude All Phases button.

To create new grouping of phases

Click on the Add New Group button.

To delete groupings of phases

Click on the Delete Group button.

Inter-relating phases and stages
Anchoring phases
It is possible to anchor a phase’s timing with another phase, or with a specific stage within another 
phase. This will lock the phases together, so that any changes that you make to the timing of one 
will be reflected in the timing of the other. The start of the phase will be locked to the phase and 
stage you have selected.
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Before you begin, click on the Extra Detail Columns button on the toolbar to show detailed stage 
information. This shows the Anchored To, Align and Offset columns (outlined in green here for 
illustrative purposes):

Select the phase that you wish to work on by clicking on the appropriate phase tab at the bottom of 
the Timescale and Phasing window.

Click on the Phase Start Date control. In previous versions, this would open a date picker (as with 
the Project Start Date control), but now a dialog like the following will open:

To select another phase to which this current phase will be anchored, use the Phase drop-down:

Selecting an option here will anchor the current phase to the specific stage you have selected.

Next, you can (optionally) use the Stage drop-down to select a specific stage within the phase you 
have selected:
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Selecting an option here will anchor the current phase to the specific stage you have selected.

If it becomes active, you may also use the first drop-down next to Stage to specify whether to 
anchor against the start or the end of the stage you have selected.

If required, you may wish to use the Offset by field to “fine-tune” the timing.

When you click OK, you will note that the dates in the Start Date and End Date will change to 
adjust to the new anchored timing.

In addition, the phase display will change to show the new start timing for the phase:

Anchoring stages
You can also anchor specific stages to stages in other phases.

Before you begin, click on the Extra Detail Columns button on the toolbar to show detailed stage 
information. This shows the Anchored To, Align and Offset columns (outlined in green here for 
illustrative purposes):
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Select the phase that you wish to work on by clicking on the appropriate phase tab at the bottom of 
the Timescale and Phasing window.

Look at the Anchored To, Align and Offset columns and decide which stage you would like to 
anchor to a stage in another phase.

Click on the Anchored To control for the stage you have chosen. A dialog like the following will 
open:

To select another phase to which this current stage will be anchored, use the Phase drop-down:

Selecting an option here will anchor the current stage to the specific phase you have selected.

Next, you can use the Stage drop-down to select a specific stage within the phase you have 
selected:
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Selecting an option here will anchor the current stage to the specific stage you have selected.

If it becomes active, you may also use the first drop-down next to Stage to specify whether to 
anchor against the start or the end of the stage you have selected. Alternatively, you can specify the 
start or end by selecting from the drop-down in the Align column in the Timescale and Phasing 
window:

If required, you may wish to use the Offset by field to “fine-tune” the timing. Alternatively, you 
can specify the offset amount by using the stage’s Offset field in the Timescale and Phasing 
window.

When you click OK, you will note that the dates in the Start Date and End Date will change to 
adjust to the new anchored timing.

Timescale Validation
Whenever the timescale is changed in any way, ARGUS Developer will automatically reorganize 
all time-based information in the Area Schedules and Cash flow. In some cases, the timing of some 
costs or receipts will be manually overridden and fall outside the normal rules of reorganization. To 
ensure that items with manually overridden timings fall within their parent phases, a validation 
check will be undertaken.

Changes that cause the project to be reorganized are:

• New project start date;

• New phase start date;

• Shortening the duration of a stage;

• Moving a stage;

• Unlinking a phase;

• Copying or deleting a phase.



Chapter 3:  Timescale & Phasing 31

ARGUS Developer version 4.05 Reference Manual

After reorganization, manually timed items may be left hanging outside the parent phase’s 
timescale. In such cases, a warning is given and corrective action taken.

Causes of invalid timing are:

• Item starts before the project start date;

• Item starts before the phase start date;

• Item starts after the phase end date;

• Item starts within the phase, but ends after the phase;

• An offset is greater than the length of its parent stage.

Once a timing issue is detected by ARGUS Developer, a tab called Validations appears (outlined 
here in green for illustrative purposes):

On this tab you will see either a hint or a warning and a list of suggestions on how to resolve the 
problem.

The status bar below the phase tabs will also summarize the number of warnings and hints.

If you have a warning message, you may be provided with a clickable link (in blue text) that will 
help you to solve the problem. Click on this link to open the Timing Issues Detected dialog:
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This dialog will give you guidance and options you can select in order to fix the timing issues.

Important note
There may be times when you find that the Sale stage is “locked” and you can not adjust its length.

This may be because the Options | Automatically Adjust Timescale option in either the Single 
Unit Sales or Multi Unit Sales area form has been checked.

If you need to adjust the length of time for the Sale stage, you should first go to the Definition tab, 
open the Single Unit Sales and Multi Unit Sales area forms and uncheck the Options | 
Automatically Adjust Timescale menu option.
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CHAPTER 4
Capitalized Rent and Unit Sales

To enter a schedule of tenants and capitalized rent, click on the Capitalized Rent expansion button 
on the Definition page.

When the Area, Construction and Lease schedule appears, enter the information required relating to 
gross and net floor space, construction, rent rates and cap rate.

The following buttons are available in this window (note that the options you see displayed will 
depend on the functionality options you have chosen in the System Administration window - see 
“Country” on page 257):

Add Area To add a tenant, click on the Add button. A new blank record will be added after the final 
area and displayed on the screen.

Delete Area To delete a tenant from the schedule, click on the Delete button.

Insert Area To insert a tenant, click on the Insert button. A new blank record will be added before 
the current area, and displayed on the screen.

Copy Area Copies area definition.

Define Master Ground Lease Defines Master Ground Lease in terms of length of lease, Sinking Fund 
and tax on Sinking Fund.

Stepped Rents Defines Stepped Rent Profiles.

Leasing Commission Profiles Creates four different types of commission for you to choose from.

Lease Events Shows lease events during rental flow stage including rent reviews, renewals and 
escalation.
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Spot Residuals Allows Spot Residuals to be calculated on various fields within the schedule and 
detail views.

Interest/PR Sets  Displays Interest/Preferred Returns sets as shown on Assumptions menu.

Inflation/Escalation Displays Inflation/Escalation sets as shown on Assumptions menu.

Valuation Options Options for rental flow period and Inflation/Escalation.

To toggle between the Detail view and Quick Entry Schedule, use the two buttons shown here:

Line Detail View Clicking on the drill button shows the Line Detail view. The following is an 
example of the Line Detail view:

Line Detail view

Schedule View  Clicking on this button shows the Quick Entry Schedule. The following is an 
example of the Schedule view:
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Schedule view

Fill Down Allows you to populate an entire column with the value you have currently selected in 
the grid. This opens a dialog that allows you to specify how many rows you would like to populate:

Fill Down dialog

Copy Down Allows you to populate an entire column by copying the value you have currently 
selected in the grid. This opens a dialog that allows you to specify how many rows you would like 
to populate:
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Copy Down dialog

Show Tenant Cash Flow Statement Previews Tenant Cash Flow Statement for current tenant or 
all tenants.

Saving and exiting To save all costs and receipts to the cash flow and exit the schedule, click on the 
OK button.

Note: You are not required to enter a value into every field. For those that are not applicable, 
leave them at zero (0).

General Area Information

Heading You can label each area with a heading of up to 60 characters in length.

Unit Number Reference number.

Use Type Select a category for the current area definition. You can fully customize this field, 
adding, deleting or changing any of the pre-defined entries. Modifications to this list are the 
responsibility of your systems administrator.

Number of Units Enter the number of identical units for the current area definition. For example, 
10 factory units or 20 apartments.

Parking Stalls This is the number of parking space to include in the area record. This field is used 
to calculate the Parking Stalls Cost which forms part of the Gross Cost. This field allows a single 
decimal in the input so that non-standard sizes of parking space can be modelled.

Additional Unit Area This is the additional unfinished area per unit.

Additional Area This is the total additional unfinished area. The additional unfinished area is not 
included in the gross or net unit area and merely functions as a way to calculate the Gross Cost.

Floor Areas
These fields provide the facility to enter gross and net floor areas for a building. You can enter 
either the floor area per unit, or the total area for construction costs and rental value or sales 
income.

When you enter a value into the Unit Area fields, the Total fields are calculated automatically, and 
vice versa.

h
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The ratio of the disposal (net) area to construction (gross) area is shown in the Gross:Net Ratio 
field. This field can be locked at a fixed value so that all floor areas will be calculated with 
reference to it.

Alternate Area This area can be used for calculating costs based on areas.

Construction Costs
You can enter the basic construction cost for each unit in one of three ways:

The Rate/ft² or Rate/M², the Cost/Unit rate, or the Gross Cost. Whichever of these values you enter, 
the others will be calculated automatically if you have entered appropriate figures in the Floor Area 
section.

Construction Costs will be distributed over the duration of the Construction Stage defined in the 
Timescale and Phasing screen.

Parking Spaces Cost This read-only field displays the total cost spent on parking spaces by 
showing the value of Parking Spaces multiplied by Cost /Parking Space.

Rate Additional This field is the cost multiplier for the Additional Area.

Cost / Unit The gross cost is calculated differently from previous Developer versions because it 
now takes into account the additional area. The Cost / Unit is now calculated as follows:

Cost Unit = Gross Unit Area x Rate + Additional Unit Area x Additional Rate

Gross Cost The gross cost is calculated differently from previous Developer versions because it 
now takes into account the additional area and parking space calculations. The Gross Cost is now 
calculated as follows:

Gross Cost = Gross Area x Rate + Additional Area x Additional Rate + Parking 

Spaces x Cost / Parking Space

Timing of Construction Costs
You can manually alter the distribution of the construction costs by clicking into the Construction 
Start Timing option on the Stage row (note that if you have loaded a file containing data that is 
distributed, you will see a dialog like the following; if you are entering data for the first time, you 
may see a simpler dialog without distribution - see “Other timing dialogs” on page 103):
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The default will start the construction costs at the start of the construction stage as previously 
defined.

Construction Cost Breakdown
If you click on the Click to View Construction Cost Breakdown link (the text shown in blue on 
the Construction Costs tab), the Construction Breakdown Editor will be opened:

To Do this

Make the construction costs start at the 
beginning of another stage.

Use the drop-down menu to select another 
stage.

Make the construction costs start at a specific 
date.

Select Date then use the up/down arrows in 
the Date option to select the date.

Make the construction costs start at a specific 
period.

Select Period then use the up/down arrows in 
the Period option to select the date.

Redistribute the Construction costs. Click on Data Distribution Editor.
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For further details of this editor, see “Construction Cost Breakdown” on page 63.

Construction Costs - Financial
You can apply inflation to the construction cost, specify Interest and GST rates on the Financial 
page.

Cost Inflation
A set called Inflation Set 1 is created for each new project and more can be added when necessary. 
By default, inflation is not applied to any cost. A set can hold up to 10 different inflation rates, each 
of which becomes active on a specified date. Inflation sets can be defined on the 
Inflation/Escalation tab within Assumptions. Please see “Inflation and Escalation Tab” on 
page 16.

If you have different rates within the set, this will be indicated by showing var. when selected.

Construction Interest
To enable interest to be calculated for the construction cost in the current area, select a Set number 
from the Interest Set drop-down list. To ignore interest, check the option Ignore Interest.

Construction Loan is attached automatically when each new area is created in basic finance mode. 
If Structured Debt and Equity is chosen in Assumptions the interest options are disabled.

GST
To calculate GST on the Net Cost, enter a rate into the GST Rate field. If any portion of the GST 
can be reclaimed, enter the amount as a % into the Recovery Rate field.

GST is recovered in accordance with the rules selected on the GST Schedule available from the 
Project Menu.

Exclude Gross Area
For purposes of Professional Fee calculations, you can elect to exclude the gross area from the 
totals. Use the Exclude Gross Area selector to do this. Any calculations that rely on the total Gross 
Area (Rate per Square Foot or Rate per Square Meter) will not include these values.

Annual Rent
You can enter the annual rent for each unit in one of four ways:
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The Rate/ft² or Rate/M², the Rent/Unit rate, or the Annual Gross Rent.
Whichever of these values you enter, the others will be calculated automatically if you have entered 
values into the Floor Area section.

Rent Escalation
You can use the Rent Escalation drop-down to select an escalation set - this applies an escalation 
rate to the MRV.

Step Rent Profile
For use if you have income flow during the development. You can define a stepped rent profile and 
select this profile from this form. For more information see “Stepped Rents” on page 46.

%Vacancy/Fixed Non-rec Cost 
You can enter deductions from the Annual Rent by filling in % Vac. & Non-rec. Cost and Fixed 
Non-recov. Cost. You may want to allow for a Service Charge that is taken off the tenant’s rent 
before capitalization.

Total Non-recov. Cost
This is the total of both the % Vac. & Non-rec. Cost and Fixed Non-recov. Cost amounts.

Annual Rent
Annual Rent is the rent that will be used to calculate the Capital Value.

Annual Rent is derived from the Gross Rent, less any deductions and including any escalation. 
When the tenant’s rent is flowing, the Annual Rent takes into account any rent reviews.

Rent Free Period (mths)
A rent free period can be granted to a tenant by filling in the Rent Free Period field. The loss of 
income can be represented in several ways. For more information see “Rent Free Cost Methods” on 
page 11.

It is the Net capitalized rent that is fed into the cash flow, and it is used to calculate the project’s 
total revenue.

Lease Comm. Profile
Commissions are paid to an agent for services in letting the property.

You can use the Lease Comm. Profile drop-down to select a leasing commission profile - this 
applies a leasing commission rate to the MRV.
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For more information about setting up leasing commission profiles, see “Leasing Commission 
Profiles” on page 47.

Rent Additions/Costs
This schedule is accessed by clicking on the link. You are able to add unlimited rows of data for 
either costs or revenues. The value, depending on whether it is a cost or a revenue, will be deducted 
or added to the investment valuation.

To Do this

Add/Delete new rows. Use the Add and Delete buttons.
Change Revenue/Cost. Click in box and select from drop-down.
Change Type. Click in the field and choose from one of 

various options:

1. Fixed Amount/Unit/Year.

2. Fixed Amount/Area/Year.

3. Amt/ft2/yr x Net Area (or Amt/m2/yr x Net 
Area).

4. Amt/ft2/yr x Gross Area (or Amt/m2/yr x 
Gross Area).

5. Amt/ft2/yr x Alternate Area (or Amt/m2/yr 
x Alternate Area).

Apply to different area/units from the area 
schedule.

Click into Selection and apply to a tenant.

Apply escalation to rows. Click into Escalation field and select from 
menu of escalation sets (previously defined).

Apply private or tenant capitalization rate. Click into Capitalization field and choose 
either Use Private Rate or Use Tenant Rate. 
If choosing Use Private Rate, enter rate to the 
right of box.
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% Rent
The % Rent tab can be used to enter information about sales from retail units. The method of 
calculating the % Rent is also specified here.

Sales Volume pa
Turnover is linked to the Sales Volume which can be inflated in line with the % Rent Escalation Set 
if required. Enter the Volume figure, and the equivalent rate per unit area is calculated.

Sales Volume pa per unit area
Turnover is linked to the Sales Volume which can be inflated in line with the % Rent Escalation Set 
if required. Enter the Sales Volume p.a. per unit area figure and the equivalent Sales volume p.a. is 
calculated.

% Rate
The multiplier is applied to the Sales Volume to produce the Turnover or % Rent.

Breakpoint Type
There are three breakpoint types:

• Zero Breakpoint
The % of Turnover multiplier is applied to the entire Sales Volume p.a.
Example: 1,000,000 Sales Volume pa * 7% of Turnover = 70,000 pa.

• Natural Breakpoint
This is sometimes used where the total rent comprises a core, or base, income and an additional 
Turnover Rent. The lease may guarantee the landlord a certain percentage of the total income 
subject to a minimum core rent that can move over time. This core rent is calculated as an 
equivalent value in terms of Sales Volume. This equivalent value forms the Natural Breakpoint.
The Natural Breakpoint will move as core rents increase and decrease.
Example: 1,000,000 Sales Volume pa, 8% of Turnover and a 10,000 standard rent.
Given the landlord is entitled to 8% of Sales Volume, the 10,000 standard rent would be worth 
125,000 to him/her, if it were expressed as Sales Volume. This 125,000 is the Natural 
Breakpoint.
10,000 core rent / 8% of Turnover = 125,000 Natural Breakpoint.
Only Sales Volume in excess of the Breakpoint is valued as turnover rent.
(1,000,000 Sales Volume - 125,000 Natural Breakpoint) * 8% = 70,000 Turnover Rent
The total rent payable is the 10,000 core rent plus 70,000 Turnover Rent.
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• Arbitrary Breakpoint
Only Sales Volume in excess of the Arbitrary Breakpoint is used to calculate the Turnover Rent. 
Arbitrary Breakpoints are entered as amounts per month, per unit area.
Example: 1,000,000 Sales Volume, 8% of Turnover and 200,000 Arbitrary Breakpoint.
(1,000,000 Sales Volume - 200,000 Arbitrary Breakpoint) * 8% of Turnover = 64,000.

Arbitrary Break amt and Arbitrary Break pf2/pm2
This field displays a zero when the Zero Breakpoint option or the Natural option is chosen. Select 
Arbitrary Breakpoint, and they become both  input and output/display fields.

Turnover Escalation
You can define if the Sales Volume remains static throughout the cash flow, grows during the 
income period or grows over the whole cash flow period. Select the Ignore option to retain the 
Sales Volume throughout or choose a pre-defined Escalation Set from the drop-down. Escalation 
Sets are created and amended on the Interest/Inflation, Rent Escalation screen and run from either 
the cash flow start or Leasing Date, depending on the setting on the Assumptions/Defaults, 
Valuation screen.

Lease Options
Where a development is retained as an investment or where Pre-Lets are achieved, the information 
on the Lease tab will generate a flow of rental income in the cash flow. To enable the flow of rent 
from the lease details, select Valuation from the main menu then tick Tenant’s Income Stream.

Lease Start Date The period from which rent will start to flow in the cash flow. If a rent-free 
period has been granted, the number of months will be added to the lease start date to determine the 
date on which the rent will start to flow.

Note: To adjust the lease start date, click on the  button.

To Do this

Make the lease start date commence at the 
beginning of another stage.

Use the Stage and Phase settings in the timing 
dialog to select another stage.

Make the lease start date commence on a 
specific period.

Use the Period option to select the date in the 
timing dialog.
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Term This is the length of lease in years and months.

Payment Cycle Frequency for rent payments - either monthly, quarterly, semi-annual or annual in 
advance.

Review Cycle Rent Review cycle in years.

Align to Sale Date To synchronize the end of the income flow with the sale of the property, should 
the lease expire before the sale date.

Vacancy Cost Rate pf2 pa (or Vacancy Cost Rate pm2 pa) Cost incurred during initial leasing 
period, as measured from the Start Date of the 5th Stage of the current Phase until the lease comes 
into effect; and during periods of vacancy between terms if a Leasing Period (entered in whole 
months) has been defined.

Renew this lease You can renew the lease by checking this option.

Renewal Term (Years) You can specify the renewal term of the lease here (years). The default here 
is set to 5 years.

Renewal Term (Months) You can specify the renewal term of the lease here (months).

Leasing Period If you choose to renew the lease you can enter a leasing void period in months.

Rent Free Period (mths) If you choose to renew the lease you can enter a rent free period in 
months.

TI Rate pm2/pf2 (Renewal) Tenant Improvement Rate on Renewal. Cost is based on net area and 
is triggered on renewal.

Lease Events

Use the Lease Events button to view a schedule of rents and MRVs including escalation:

The Rent and MRVs are usually the same at the Leasing and Review dates (though this may not be 
the case if, for example, a stepped rent profile has been applied). The Exit event shows the MRV 
plus any escalation on the Rent from the last Rent Review.

Make the lease start date commence on a 
specific date.

In the timing dialog, select Date then use the 
date picker to select the date.

To Do this
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Monthly Rent Rates
Rents are normally entered as annual payments. For some European countries, rents are specified 
as monthly payments. Both the Rent rate and the MRV can be specified as monthly rates.

To specify monthly rates
1. Tick the Monthly Rent Rate option on the Options menu.

2. Confirm the change.

• All rental areas will be recalculated with the current rent rate interpreted as a monthly rate.

• The Monthly Rent Rate option will now be ticked on the Options menu.

To specify annual rates
1. Untick the Monthly Rent Rate option on the Options menu.

2. Confirm the change.

• All rental areas will be recalculated with the current rent rate interpreted as an annual rate.

• The Monthly Rent Rate option will now be unticked on the Options menu.

Note: This is a global switch and affects all rents across all phases.

Rent - Financial
You can specify Interest and GST rates on the Financial page:

Interest Set
To calculate interest on the rent for the current area, select a Set name from the Interest Set drop-
down list. To ignore interest on the rent, select Yes from the Ignore Interest drop-down list.

Interest Set number 1 is attached automatically when each new area is created.

GST
To calculate GST on both the Net Rent and Capitalized Rent, enter a rate into the GST Rate field. 
If any portion of the GST can be reclaimed, enter the amount as a percentage into the Recovery 
Rate field.

GST is recovered in accordance with the rules selected on the GST Schedule available from the 
Project menu.
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Stepped Rents
At the grant of a new lease, terms agreed between landlord and tenant may include provision for 
stepped rents - fixed uplifts in rent at specified intervals. On the next event (expiry/renewal) 
following the defined stepped rents it is assumed that market rent will resume.

Stepped rents only apply during the first lease (in other words - not to a renewal lease) and when 
tenant’s income flow is activated during the development. Stepped rents cannot be set for dates 
after the project end date.

Stepped rents are not subject to escalation.

Stepped rent profiles are created in the Capitalized Rent screen and applied to a tenant using the 
Stepped rent profile selector. To apply a profile to a tenant, click onto the stepped rent profile 
selector on the Rent tab and select the required profile from the drop-down list.

To create a stepped rent profile, click on the Stepped Rent Profiles button to open the definition 
screen.

For each stepped rent profile, the following fields must be defined:

• Name of the stepped rent profile.

• Base Date (when the first step starts).

• Stepped rent profile comprising a date, duration, step type and rate.
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Stepped Rent Profile definition form

The table below sets out the five types of rent step:

A net floor area must be entered for the tenant for Rate pf2 (or pm2) and Rate pf2 (or pm2) 
adjustment step types.

Add
To add a new stepped rent profile, click on the Add button. The cursor will be moved to the new 
line.

Delete
To delete a stepped rent profile, click on the Delete button. You will be asked to confirm your 
choice.

Leasing Commission Profiles
To set up leasing commission profiles, click on the Leasing Commission Profiles button:

Step Type Stepped Rent Basis
Rate pf2 (or pm2). Net floor area x Rate.
Rate pf2 (or pm2) adjustment. Net floor area x (previous rate +/- rate adjustment).
$ Rent pa/unit. $ Rent per annum.
$ Rent  pa/unit adjustment. Previous rent +/- rent adjustment.
Resume Market Rent. Market rent. This step type effectively terminates the 

stepped rents and reverts to the annual rent defined in the 
Rent form.
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This opens the Leasing Commissions window:

You can set up multiple profiles with different leasing commissions by clicking on  to add a 
new profile.

Profile Name
Use this field to type in a name for the leasing commission profile.

Commission Basis
You can use this drop-down to select any one of the following types of Leasing Commission:

1. Fixed Amount on completion of the letting, a fixed amount is paid by the Developer/Landlord.

2. Rate pm2 (or Rate pf2) on completion of the letting, a rate per square meter or foot is paid. 
There is also the option of entering a different rate (based on Net Area) if the lease renews.

3. % of Base Rent on completion of the letting, you are able to define several steps with different 
rates if necessary. You can also enter a renewal rate for the entire term.
This uses the total base rent over:
(a) First term of lease.
(b) Subsequent renewal terms.
Base Rent includes turnover but excludes Rent Additions/Costs.

4. % of Gross Rent on completion of the letting, you are able to define several steps with 
different rates if necessary. You can also enter a renewal rate for the entire term.
This uses Total Rent over:
(a) First term of lease.
(b) Subsequent renewal terms.
Gross Rent includes turnover and Rent Additions/Costs.

Depending on which option you select here, you will see different controls that will allow you to 
specify amounts or rates.

If you select the Fixed Amount option, you will be able to specify an amount (rather than a rate) in 
the Fixed Amount field.
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If you select the Rate pm2 (or Rate pf2) option, you will see the following controls:

The First Term Rate allows you to specify a rate for the first term, while the Renewal Rate field 
allows you to specify a different rate (based on Net Area) if the lease renews. If you wish, you can 
make this renewal rate apply to just the first renewal by checking the Apply to First Renewal only 
check box.

If you select the % of Base Rent or % of Gross Rent option, you will see the following controls:

Here, you can define a stepped series of rates.

To add further steps, just click on the Add Step button: 
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In the Months column, type in the number of months for which the rate in each step will be 
applied.

In the Rate % column, type in the rate that will apply in each step.

If you wish to do so, you can specify a renewal rate in the Renewal Rate (entire term) field. In 
addition to this, you can make this renewal rate apply to just the first renewal by checking the 
Apply to First Renewal only check box.

Hotel Valuations
Typically, hotel valuation is based on room and occupancy rates rather than floor area. Occupancy 
rates may vary throughout the year. The valuation should reflect this.

To establish the rental value of a hotel, therefore, occupancy profiles must be defined for different 
rooms within the hotel, to specify the occupancy rate (as a percentage) for each month of the year. 
These occupancy rates are then multiplied by the room rate to calculate the total annual rental 
value.

In the hotel valuation module, an extra Use Type is available for hotels in the Capitalized Rent 
schedule. When Hotel use type is selected, an extra tab labelled Hotel becomes available in the 
Rent form in the detailed screen view, and the Rent tab is hidden (see below).

A new area definition should be created for each type of room in the hotel for which a separate 
occupancy profile is to be defined. For each, the following fields are available on the Hotel tab:

Vacancy Allowance There are two fields available to allow the definition of a vacancy allowance 
as a percentage of the total gross rent and/or as a fixed amount. These are totalled to calculate the 
Total Deduction from the Gross Rent.
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Occupancy Profile To define an Occupancy Profile, click on the Click to View Hotel Occupancy 
Profile hypertext link on the Hotel tab. This opens the definition screen:

Any number of profiles can be created.  For each profile created, you should enter a name and 
occupancy rate for each month of the year. The monthly rate offers a more flexible approach to 
occupancy rates, modelling realistic income profiles. If a yearly occupancy rate only is required 
this can be achieved by entering the same rate for each month.  A single daily room rate, defined in 
the Hotel tab, is applied throughout the year.

Adding a line To add a new occupancy profile, click on the Add button. The cursor will be moved 
to the new line.

Deleting a line To delete a line from the schedule, click on the Delete button. You will be asked to 
confirm your choice.

To apply an occupancy profile, use the occupancy profile selector in the Hotel tab of the Rent form.

For hotel valuations, lease terms and renewal assumptions are available in the Lease tab. The usual 
options for interest and GST apply to hotel valuations and may be accessed from the Financial tab.
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Rent Capitalization
You can capitalize rental income by entering the Cap Rate%  into the Rent Capitalization table.

Cap Rate%
You can enter the Cap Rate percentage to capitalize rental income.

Manual Capital Value
Where a capital value has been agreed for a unit, you can enter it directly into the Manual Cap. 
Value field. Any value entered into this field will override the calculated value and will be used in 
the valuation of the project.

Timing of Sale
You can change the period in which the property is sold by clicking on the Stage button.

This opens a Capitalization Timing dialog, which you can use to define the stage’s timing (note that 
if you have loaded a file containing data that is distributed, you will see a dialog like the following; 
if you are entering data for the first time, you may see a simpler dialog without distribution - see 
“Other timing dialogs” on page 103):
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The default will sell the property at the start of the Sale stage.

Unit Sales
To enter a schedule of non-capitalized units to be sold, click on the Unit Sales button on the 
Definition page.

To enter a schedule of single unit sales, click on the Single Unit Sales button. See “Single Unit 
Sales” on page 69.

To enter a schedule of multi-unit sales, click on the Multi Unit Sales button. See “Multi Unit 
Sales” on page 72.

Floor area details and construction costs may be entered in the same way as for capitalized units. 
See “Construction Costs” on page 37 for further details.

You can enter the sale value for each unit in either of three ways: 

• The Rate/ft² or Rate/M²;

• The Sales Value/Unit rate;

• The Gross Sales.

Whichever of these values you enter, the others will be calculated automatically if you have entered 
a net floor area into the Unit Area section.

Sales receipts will be placed at the end of the Sale Stage defined in the timescale.

To Do this

Make the sale date start at the beginning of 
another stage.

Use the drop-down menu to select another 
stage.

Make the sale date start at a period. Select Period then use the up/down arrows in 
the Period option to select the date.

Make the sale date start at a date. Select Date then use the up/down arrows in 
the Date option to select the date.

Redistribute the Sale Date. Click on Data Distribution Editor.
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Timing of Net Sale Value
The Sale Stage is assumed for Sales Values. You can override the default start and duration of the 

Sale stage independently for each area. At the foot of the Sales column, there are fields that 

determine the timing and distribution of the Net Sale Value.

Stage This field by default shows the label Sale. This indicates that the Net Sale Value is linked to 

the Sale Stage defined in the Timescale and Phasing screen. The Net Sale Value is placed in the 

period after the end of the Sale Stage.

The advantage of linking sales values to a Stage is that if you change the stage in the Timescale and 

Phasing screen, then all sales values linked to it will be automatically updated.

Starts In This field shows the date upon which the Net Sale Value is placed in the cash flow. You 

can adjust the start date by using the following options:

Distribution Months This field will display the length of the sales period in the cash flow.

Distribution Type This indicates the type of distribution.

Distribution Weighting If “Weighted” is chosen for distribution type you are able to type in a 

percentage in this field.

Sales Distribution This links straight to Data Distribution Editor where you can dispose of 

whole units manually.

When you make adjustments to the timings of the sales, the changes will be reflected in the Stage, 

Starts In, Distribution Mths and Distribution type fields.

Sales Additions/Costs
This schedule is accessed by clicking on the link. You are able to add unlimited rows of data for 

either costs or revenues. The value, depending on whether a cost or a revenue, will be deducted or 

added to the sales valuation.

To Do this

Make the sale date begin at the start of another 
stage.

Use the drop-down menu to select another 
stage.

Make the sale date fall on a period. Select Period then use the up/down arrows in 
the Period option to select the date.

Make the sale date fall on a date. Select Date then use the up/down arrows in 
the Date option to select the date.

Distribute the sales over a specific period. Check the box Allow Custom Distribution 
and use Data Distribution Editor to alter 
distribution type.

Dispose of Sales Unit by Unit. Check the box Allow Custom Distribution 
and use Data Distribution Editor. Once in 
Data Distribution Editor, check Dispose of 
whole units box.

To Do this
Add/Delete new rows. Use the Plus and Minus buttons.
Change Revenue/Cost. Click in box and select from drop-down.
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Deposits/Pre-Sales
Residential developers will typically take a deposit for an apartment or house up front, with the 
remainder paid on completion of the building’s construction.

The value of the units will be distributed in two sections: a period over which deposits will be 
received, and a single amount for the remainder.

Deposit % Deposit as a percentage of sale price to be paid up front.

Total Months The number of months before the first sale when the deposit is paid.

Distribution Months The period over which the deposits can be spread prior to the first sale from 
the Initial Deposit Term.

Deposit Curve The deposits can be distributed using any of the standard methods available in 
ARGUS Developer.

Change Type. Click in field and choose from one of various 
options:

1. Fixed Amount/Unit/Year.

2. Amt x Net Area.

3. Amt x Gross Area.

4. Amt x Alternate Area.
Apply to different area/units from the area 
schedule.

Click into Selection and apply to unit(s).

Apply inflation to rows. Click into Inflation field and select from 
menu of inflation sets (previously defined).

To Do this
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Distribution Weighting If you use the weighted distribution type, this field becomes active.

Offset (-Months) After the first sale, all deposits are aligned to the sale date if the value is 0. If you 
choose -1 the deposits will be placed in the month before the sale date.

Use Manual Distribution Selecting Yes allows you to manually distribute the deposits.

Distribution Detail Opens up the data distribution function for editing.

Example1:
20 Units are to be sold @ $250,000 each, over a 5 month period on an even curve basis. Therefore, 
4 units will be sold each month. A 10% deposit is to be taken for each unit and the initial deposits 
(on the first month’s sales) are to be taken 4 months before the first 4 units are sold, and spread 
over a two month period on an even basis. The remaining deposits are to be paid 2 months before 
the units are sold - this is the Absorption period. The graphics above and below reflect this 
scenario.

Example 2 (With Escalation):
Five (5) units are to be sold @ $250,000 each over a 5 month period. Therefore, 1 unit is sold per 
month. A 10% deposit is to be taken for each unit and the initial deposit is to be taken 4 months 
before the first unit is to be sold. The other deposits are to be taken the month before the sale in the 
Absorption period. The sales line has escalation applied at 2% per annum from the project start 
date. In the example below, we see an initial deposit of $25,500 in August 2006 and the first sales 
figure of $229,500 in month 17.

For the first sale in December 2006, the program escalates the sales figure up to the month in which 
the deposit is taken (August 2006). Assuming the project starts in August 2005, the calculation is:

$250,000 * 1.021 = $255,000

Deposit of 10% = $25,500

Remainder is $229,500 in December 2006.

For the remaining 4 sales, the program escalates the sales figure up to the month in which the 
deposit is taken, and the remainder appears a month later.
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Sales Fees
The Sales Fees tab is displayed in the Unit Sales, Single Unit Sales and Multi Unit Sales forms. It 
allows you to specify commission settings for sales.

This has the following fields:

Commission at Sale % This is commission being paid upon the signing of a sales contract to a 
third party. You can use this to model sales agent fees on a per-area basis.

The amount being paid is a percentage of the grown unit price, therefore escalation/inflation on the 
line itself is ignored. The distribution on the line follows the distribution on the Sales Starts line for 
the area.

Commission at Completion % This is commission being paid upon sales completion to a third 
party. Again, you can use this to model sales agent fees on a per-area basis.

The amount being paid is a percentage of the grown unit price, therefore escalation/inflation on the 
line itself is ignored.

The distribution on the line follows the distribution on the Actual Completions line for the area, 
taking the escalation factor information from the Sales Starts line for the area.

Unsold Unit Fee / Month This is a fee that is payable on units for which construction has 
completed, but that so far remain unsold. You can use this to model condominium fees for multi-
unit developments, site security for single unit developments and so on.

The amount is multiplied on a per-period basis with the number of units for each period as found on 
the Units Available line for the area.

Quick Entry Area Schedule
You can save time when entering floor space details by using the Quick Entry Schedule. This 
method of entry allows you to define your areas using a spreadsheet-style table that displays only 
the minimum number of fields.

To open the Quick Entry schedule, click on the Schedule View button:

The Quick Entry schedule is comprised of three main sections:

• The toolbar that allows you to change the number of fields displayed and to copy fields and 
rows;

• The Area data entry grid;

• The Construction Cost Breakdown grid (displayed when you use the View | Show Cost 
Breakdown menu option);

• The summary of areas, costs and revenues.
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Quick Entry schedule showing optional Construction Cost Breakdown grid

Quick Entry Toolbar
When in Schedule View, the following additional buttons will appear:

Fill Down Copy a single value down through a column by clicking on the Fill Down button. Move 
to the value you want to copy, click on the button and enter the number of times the value is to be 
copied. The value is copied down the column, replacing existing entries. This differs from Copy 
Down because the Fill Down dialog has options that allow you to specify a sequence of values. See 
“Fill Down” on page 61.

Copy Down Copy a single value down through a column by clicking on the Copy Down button. 
Move to the value you want to copy, click on the button and enter the number of times the value is 
to be copied. The value is copied down the column, replacing existing entries. See “Copy Down” 
on page 62.

Quick Entry Table
The quick entry table is a grid of rows and columns. Each row represents a definition for a single 
area, and each column represents a field within the area. A selected cell appears highlighted on the 
screen. The active cell is the cell into which data is entered when you start typing. Only one cell is 
active at a time.

Some cells will remain fixed – you may not enter a value into them. These fields are calculated 
automatically and include: Total rent deductions, Net rent p.a. (or Valuation Rent), Net capitalized 
rent and Rent free amount.

The table contains a subset of the available fields for area definition. You can see more detail for 
the current area by clicking on the Line Detail button. Use the detail view for entering inflation, 
escalation, interest sets and for specifying the timing of construction costs and receipts.
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Summary section
The summary section (shown below) shows the running totals for Gross area, Gross cost, Net area, 
MRV and Capitalized Rent:

Housekeeping functions in the schedule view
In the schedule view, you have access to copy, paste and move functions that allow you to copy and 
paste and move area records between schedules. This allows you to duplicate records, in order to 
speed up data input.

Copying area schedules
To copy records in the schedule, use the Edit | Copy Area Schedule... menu option to open the 
Area Schedule Copy Options dialog:

Select either the Copy Current Area Record option to copy just the record you currently have 
selected in the schedule, or select the Copy All Area Records in Schedule option to copy all the 
area records.

Click OK. You can now use the Paste function to create new copies of the area records.

Pasting area schedules
To paste records into a schedule, use the Edit | Paste into Area Schedule... menu option to open 
the Area Schedule Paste Options dialog:

To paste the record(s) at the top of the schedule list, select the Paste at the Start of Schedule 
option.

To paste the record(s) at the currently selected point in the list, select the Paste from the Current 
Area Record option.

To paste the record(s) after the last record in the schedule list, select the Paste after the Last Area 
Record option.
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Moving an area record to another schedule
If you wish to move the currently selected area record to another schedule list, use the Edit | Move 
Area Record to Another Schedule... menu option.

This opens the following dialog:

Here, you can select a schedule from the options listed. Select the schedule and click OK.

Note that if you move the record to a schedule of a completely different type, you may lose some 
data - because the record has been converted.

Moving an area record to another phase
If you wish to move the currently selected area record to another phase, use the Edit | Move Area 
Record to Another Phase... menu option.

This opens the following dialog:

Here, you can select a phase from the options listed. Select the phase and click OK.

Your area record will be copied to the phase you have chosen.

Copying values in the schedule
There are two methods that you can use for copying values within the schedule:

• Fill Down;

• Copy Down.
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Fill Down

Fill Down allows you to populate an entire column with the value you have currently selected in 
the grid.

To use this method, select a cell containing a value and click on the Fill Down button to open the 
dialog. The dialog allows you to specify how many rows you would like to populate:

Use the following options to specify the number of rows that you wish to copy to, and click OK.

Note: Some options are grayed out - this state depends on the type of cell you have currently 
selected.

Fill Down
This option allows you to type in the number of rows that you wish to fill down.

Type
This option allows you to choose the type of step value that you are going to use. The following 
option buttons are available:

• Linear This allows you to specify a numeric value that is used to increment or decrement the 
fill values.

• Percentage This is a percentage of the original value (in the cell from which you are copying).

Date Unit
This option allows you to choose the type of date units when performing a fill down on date fields 
(this only becomes active if you select a cell containing date information). The following option 
buttons are available:

• Month If this option is specified, increments are in months.

• Year If this option is specified, increments are in multiples of 12 months.

Append (text field only)
This option allows you to append a numeric value at the end of the original value, in text fields. 
You can use this in conjunction with specifying a step value; this can be used (for example) in the 
Heading column to copy and increment names. The number that is appended is separated from the 
original text by a space.

Step Value
This option allows you to specify a step in the value that will be incremented or decremented for 
each successive row. A decrement can be specified by entering a negative number. If no value 
exists in the current row’s column, the increment/decrement begins on the next row.
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Every
This option allows you to specify the frequency of the increment/decrement that you defined in the 
Step Value field.
For example, if you enter a “Step Value” of 1 month with “Every” set to 5, the first 5 rows 
including the current row would have no change, with the next 5 rows being incremented by 1 from 
the value in the current cell - overwriting the contents of the cells being filled. The next 5 rows 
would be further incremented relative to the contents of the current row, this time by 2 months - 
again overwriting the contents of the cells being filled.

Copy Down

Copy Down allows you to populate an entire column by simply copying the value you have 
currently selected in the grid. This opens a dialog that allows you to specify how many rows you 
would like to populate:

Copy Down dialog

To use this method, select a cell containing a value and click on the Copy Down button to open the 
dialog.

Enter the number of rows that you wish to copy to, and click OK.
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Construction Cost Breakdown
This entry table is a grid, like the quick entry table (this area is outlined in green in the picture 

below).

Entering costs
When you enter new items in this list, they will initially use the default heading of “Construction 

Breakdown”. You can rename these entries to something more appropriate if you require.

You can use it to enter a detailed list of items that make up the total cost for the unit. When a cost 

breakdown has been entered, the Constr. Rate pf2 (or Constr. Rate pm2) and Gross Cost fields in 

the main form are updated with costs from the schedule. They are then disabled to prevent any 

changes.

You can add individual items to this list with the Add New Cost button: 

You can specify the type of cost with the Type drop-down:

If you choose the Related % option, you will be able to select specific costs from a list, for 

inclusion in the Construction Cost Breakdown calculation. If you click on the Selection control for 

the entry for which you have chosen the Related % option, the Construction Breakdown Selection 

schedule will be displayed:
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Here, you can check specific items to include them in the calculation.

If you wish to calculate the related value based on an uninflated source amount, check the check 
box at the bottom of the schedule.

Click OK to exit from the schedule.

Adding a cost breakdown from defaults
When you click on the Add Full Breakdown From Defaults button  for the first time in 
your working session, you will be prompted to create default settings if none currently exist:

If you select Yes, the Construction Breakdown Defaults schedule will be displayed:

You can use this schedule to create a list of default costs only. You can use the up and down arrows 
to change the order of entry.

Once you have created a breakdown schedule, you can attach it to any area record by clicking the  
Add Full Breakdown From Defaults button:
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If you have a standard list of costs that are used many times in an appraisal, you can simplify the 
entry process by creating a template which can be used when required in any area record. The 
template can contain a list of cost names with a cost type for each - (fixed, related percentages and 
so on) each of which can be overridden when attached to an area record.

If you need to edit these default costs, click on the Edit Breakdown Defaults button:

Clicking on this button will open the Construction Breakdown Defaults schedule.

Area Options
Lock Gross: Net Ratio
Any or all of the areas defined can have their Gross to Net ratio locked so that the gross and net 
areas maintain a fixed ratio. Depending on your settings, when you change the net area, the gross 
area will be recalculated, or when you change the gross area, the net area will be recalculated.

To lock the Gross to Net ratio
1. Choose Lock Gross:Net Ratio from the Area menu

2. Check the Lock Gross:Net Ratio check box.

3. Enter the fixed ratio into the Gross:Net Ratio % field.

4. Click on the OK button.

The following courses of action will be presented to you:

Gross to Net Ratio
You can specify how Gross and Net areas are calculated when the ratio is changed by using the 
Ratio option on the Options menu.

To change the Net area
• Tick the Ratio - Change Net Area option from the Options menu.

To change the Gross area
• Tick the Ratio - Change Gross Area option from the Options menu.

To Do this

Apply the locked ratio to any new area 
definitions.

Select the To NEW areas only radio button 
and click on OK.

Apply the locked ratio to every existing area 
definition and to all new definitions.

Select the To ALL area definitions option 
button and click on OK.

Cancel the locked ratio setting. Click on the Cancel button.
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Valuation Tables
The valuation tables determine the factors used in the valuation of rents.

To choose a valuation table method
1. Select Tables from the Valuation menu.

2. Choose one of the table types.

The capital values will be re-calculated automatically when the table type changes.

Rent Free Methods
You can change the method used to value rent free periods from the Valuation menu.

Note: The Rent Free methods are not available for selection when the Tenant Rent Flow 
option is active. When this option is active, the method used is always “Defer start of rent 
flow”.

To change the rent free cost method
1. Select Rent Free Methods from the Valuation menu.

2. Choose one of the rent free methods.

The rent free costs will be re-calculated automatically when the method changes.

Tenant’s Income Stream
You can enable or disable the flow of rent from tenant’s leases from the Valuation menu.

To enable the flow of rent
1. Tick the Tenant’s True Income Stream option on the Valuation menu, to show a rental income 

stream between lease start and sale dates in the cash flow.

2. The rents will be re-calculated when this option is changed.

To disable the flow of rent
1. Untick the Tenant’s True Income Stream option on the Valuation menu.

2. The rents will be re-calculated when this option is changed.

Imperial and Metric Units
You can convert between Imperial and Metric units by using the conversion option on the Options 
menu.

To convert area-based units
Choose the Convert to Metric or Convert to Imperial option from the Options menu.

• When this option is changed, all area-based definitions are re-calculated to the new standard. 
Floor space, Rent, Sales and Construction rates are converted. Any costs that have been defined 
on a rate/pf2 or rate/m2 basis will also have their rates converted.

• Note that switching between the two standards can create small discrepancies due to metric area 
measurements and monetary values being held to two decimal places.

Save Zero Value Items
 

This is for setting up templates. If you want a template that has fees related to items in the area 
schedule, you first need to create the items in the area schedule and then populate the cash flow 
with them. You will most likely not be entering any costs or rents/sales into the schedules at this 
stage - only zeros. ARGUS Developer will not save zero items in the schedule into the cash flow, 
so you check Save Zero Items in the area schedule to get ARGUS Developer to show zero area-
based cash flow lines.
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Show Names on Area Tabs
You can name individual areas such as (for example) Unit 1, Unit 2. This option allows you to 

choose whether these headings appear on the area tabs for reference.

Stepped Base Rent Rate = MRV Rate
If this is activated, the first step of the selected Stepped Rent Profile on the base date is used as the 

Market Rent Rate.

Allow Negative Rents
In most projects, you will be working with Positive Rents. In some circumstances, it may be 

necessary to enter negative rents in order to capitalize a cost.

Use this option to allow entry of negative amounts.

Menu Options for Displaying and Selecting Columns
To select the types of columns that you wish to see displayed in the Areas, Construction, Rent and 

Capitalization or Areas, Construction and Unit Sales schedules, you can use the following menu 

options:

Selecting all columns
Use the Columns | All menu option to display all columns.

Construction Costs columns
Use the Columns | Construction and Columns | Construction Financial menu options to display 

the construction cost columns.

Rent columns
In the Areas, Construction, Rent and Capitalization form, use the menu options to display all rent 

columns (options available are Rent, Rent Financial, Turnover Rent and Rent Capitalization).

Hotel columns
In the Areas, Construction, Rent and Capitalization form, use the Columns | Hotel menu option to 

display all hotel-related columns.

Operated Asset columns
In the Areas, Construction, Rent and Capitalization form, use the Columns | Operated Asset menu 

option to display all operated asset-related columns.

Lease Details columns
In the Areas, Construction, Rent and Capitalization form, use the menu options to display all lease 

details columns (options available are Lease and Ground Lease).

Sales columns
In the Areas, Construction and Unit Sales form, use the menu options to display the sales columns. 

You can select Sales, Sales Deposits, Sales Fees and Sales Financial columns.

Custom columns
Use the Columns | Custom menu option to display the custom columns (if any have been defined).
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To choose the specific custom columns that will be displayed in the schedule, use the Columns | 

Column Selector menu option to open the Custom Column Selector window:

Check all the custom columns that you wish to include in the Areas, Construction, Rent and 

Capitalization or Areas, Construction and Unit Sales schedule.

If you wish to check all options, use the Columns | All On menu option.

If you wish to uncheck all options, use the Columns | All Off menu option.

To accept your settings and exit from the window, you can either click OK, or use the Columns | 

Save Changes & Exit menu option.

Residential Sales
In addition to the Unit Sales form, single unit sales and multi unit sales forms are available. These 

are intended primarily for use in residential developments.

To enable these buttons on the Definition screen, use the Tools | Options... menu option to open the 

Options window:
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Check the Show Single/Multi Sales Buttons check box to display these options. They will be 
displayed in the Definition screen as follows:

Single Unit Sales
To enter single unit sales, click on the Single Unit Sales detail button. This opens the Single Unit 
Areas, Construction and Sales form:

Data entry in the Single Unit Sales form is similar to the methods used in the Capitalized Rent 
form, but there are a few differences:

Construction Cost distribution – Single Unit Sales
The Single Unit Sales setup allows you to define construction starts progressively, typically in 
groups of units.

Doing the construction in batches of units flattens the construction curve, and because sales 
revenues and not just deposits start coming through during the area construction, finance 
requirements and interest payments for a project can be reduced.



70 Chapter 4: Capitalized Rent and Unit Sales

ARGUS Developer version 4.05 Reference Manual

The following is a summary of the Single Unit Sales-specific controls on this tab (outlined in green 
above):

Stage / Starts in This defines the start timing for the first batch of units to be constructed.

Starts per Here you can choose the cycle in which constructions start. This can be monthly, two-
monthly or quarterly. The first cycle starts at the construction start period.

Starts / Cycle This defines the number of units that begin construction each cycle. Until a non-zero 
value has been entered here, all units start construction in the first construction period.

Construction Duration The construction duration defines the number of months each unit to be 
constructed takes to complete.

Sale Distribution – Single Unit Sales
The sales distribution for single unit developments is controlled through some fields unique to 
single unit developments and others that are shared with multi unit sales.

The timing for the sales is controlled through a standard timing popup in the Sales column of the 
single unit sales form.
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The following is a summary of the controls on this tab:

Initial Sales – Units This is the number of units that is expected to be sold when the sale for the 
area is first launched. Normally more sales contracts are expected to be signed during that month 
than during the regular sales period. If this field is non-zero, the number of units in the first sales 
period is taken from this field. If the field is left zero, the number of units sold in the first sales 
period is controlled through the regular sales fields.

Initial Sales – Sales % This field is a “virtual” field. The actual value stored on the area record is 
the number of units sold on day one. However, the Initial Sales can be entered as a percentage.

Balance of Sales – Sales per This field determines the sales cycle to be used. It can be monthly, 
two-monthly or quarterly.

Balance of Sales – Sales /Month/2 Months/Quarter This field determines the number of units 
sold during a sales cycle. If this field is zero, the total number of units minus in the first month 
sales period, or an adjusted number of units in the second month of the sales period if day one sales 
have been modelled for the area.

Regular Sales – Months to Complete This field determines the minimum number of months 
between the signing of a sales contract and the completion of the sale. What determines the actual 
difference in months is whether enough units have been constructed to cater for the demand.

Regular Sales – Deposit % This is the deposit percentage. The deposit for a sale is payable on the 
signing of a sales contract and so the distribution on a deposit line for a single unit sales area is 
directly determined through the fields controlling the sales distribution.
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Multi Unit Sales
To enter multi unit sales, click on the Multi Unit Sales detail button. This opens the Multi Unit 
Areas, Construction and Sales form:

Data entry in the Multi Unit Sales form is similar to the methods used in the Capitalized Rent form, 
but there are a few differences:

Sales Distribution – Multi Unit Sales
The most complicated automatic sales distribution can be modelled through the multi unit sales 
schedule.

Multi unit sales contain up to four sales periods. Depending on when the sales start, controlled 
through a normal timing popup in the sales column, is timed, there may be initial (day one) sales, 
sales prior to construction, sales during construction and absorption sales, where absorption sales 
are sales that happen after construction for the area has been completed.
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Initial Sales – Units This is the number of units that is expected to be sold when the sale for the 
area is first launched. Normally more sales contracts are expected to be signed during that month 
than during the regular sales period. If this field is non-zero the number of units in the first sales 
period is taken from this field. If the field is left zero, the number of units sold in the first sales 
period is controlled through the regular sales fields.

Initial Sales – Sales % This field is a “virtual” field. The actual value stored on the area record is 
the number of units sold on day one. However, the Initial Sales can be entered as a percentage.

Sales Prior to Construction – Sales / Month This is the number of units that is expected to be 
sold each month prior to the start of the area construction.

Sales Prior to Construction – Sales % This field is a “virtual” field. The actual value stored on 
the area record is the number of units sold each month prior to construction. However the number 
of units sold prior to construction can be entered as a percentage, which will then be automatically 
converted to a number of units per month.

Sales During Construction – Sales / Month This is the number of units that is expected to be sold 
each month during the area construction.

Sales During Construction – Sales % This field is a “virtual” field. The actual value stored on the 
area record is the number of units sold each month during construction. However, the number of 
units sold during construction can be entered as a percentage, which will then be automatically 
converted to a number of units per month.

Absorption Sales – Absorptions / Month This is the number of units that is expected to be sold 
each month after the area construction completes.

Absorption Sales – Absorptions Months This field determines the minimum number of months 
between the signing of a sales contract and the completion of the sale. What determines the actual 
difference in months is how long a client has to wait until he can take possession of the unit, which 
is controlled through Monthly Move In field.

Move In – Monthly Move In The monthly move in determines for how many units the sale can be 
completed each month. For example, the number of people moving into a condo development is 
restricted by the number of elevators and allowing more units to be occupied would be counter-
productive. In such cases you can use the monthly move in field to delay sales completions.
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Sales Contract – Multi Unit Sales
Multi unit sales areas do not have a deposit % field, and sales revenue instead is spread using sales 
contracts. Each area record can use two different contract types, one for sales that occur prior to 
construction completion (the Presales Contract) and one for sales that occur after construction of 
the area has completed (the Absorption Contract).

When no contracts are used, the full unit price is collected when the sale completes.

The following picture shows the contract selection fields (outlined in green):

Sales Contract Editor

You can open the Sales Contracts Editor by using the Edit | Sales Contracts… menu item or the 
Sales Contracts  button on the toolbar, when in the Multi Unit Sales schedule.

The sales contract editor works in a similar manner to other Developer schedule editors. A minimal 
contract defines an opening and a closing stage and would typically collect a deposit percentage at 
the opening stage and collect the remainder at the closing stage.

Each contract definition requires an opening and a closing stage and collects 100% (or optionally 
more) of the unit sale price.
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Allow more than 100% distribution In some cases, absorption units sold after area construction 
completes are valued higher than units sold prior to construction completions. The Allow more 
than 100% distribution check box can then be used to provide an uplift in this sale’s price.

Value This column allows you to define a percentage for each stage.

Timing This column allows you to define when a stage occurs. This control opens a timing dialog 
that you can use to specify the stage or start date (see “Other timing dialogs” on page 103).

Offset This column allows you to enter an amount that offsets the stage from the Construction 
month. This permits you to fine-tune the timing of the stage.

Opening Stage The opening stage of a sale is defined as the stage in the sale of a single unit is the 
sales start or when the client signs the contract to buy the unit. For opening stages, the timing is 
controlled through the sales starts unit information line and thus a number of months offset from 
the construction start cannot be entered.

Closing Stage The closing stage of a sale of a single unit is the sales completion or when the client 
takes possession of the unit. For closing stages, the timing is controlled through the actual 
completions unit information line and thus a number of months offset from the construction start 
cannot be entered.

Copying a contract To make a copy of a contract, select the contract to be copied and click on the 
Copy Contract button.

Graph view in the Sales schedules
You can view sales activity graphs in all of the sales schedules (Unit Sales, Single Unit Sales and 
Multi Unit Sales).

To view these graphs, just click on the Graph View button  on the toolbar in any of these 
sales schedules.

The view will change to display a graph of the sales data you have input:
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The Graph Type drop-down above the graph allows you to choose between a chart of activities or 
a chart of cumulative activities.

If you wish to change the view back to a data input mode, click on the Line Detail View or 
Schedule View buttons.

Timing and Distribution summaries
In the Capitalized Rent, Unit Sales, Single Unit Sales and Multi Unit Sales forms, wherever you 
find a timing control (usually marked “Stage” or with a  button), you will be able to view pop-
up summaries of the currently set timing and distribution.

To view the pop-up summary, hold your mouse pointer over the timing control in the form:
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Operated Assets
The Operated Assets feature is one of the optional Developer modules. You may need to purchase a 
license for this module before you can start working with Operated Assets.

The Operated Assets module allows you to specifically focus on managing rent and occupancy 
rates for business premises, including Hotels, Golf Courses, Marinas, Serviced Apartments, Self 
Storage and so on.

Note: Once you have set up any operated assets, you may wish to create a report of the data 
you have entered. An Operated Assets report is available in the Enhanced Reports section of 
the reporting module - see “Report Content: Enhanced Reports” on page 210.

Using Operated Assets - Brief Overview
To enter and value operated assets, use the following procedure:

Open the Areas, Construction, Rent and Capitalization screen, and choose a Use Type of 
Amusement Park, Golf Course, Marina or New Hotel. These are defined as custom Use Types in 
the Use Types window - see  “Use Type Classes” on page 255.

This displays an Operated Asset tab in place of the Rent tab:

The Rent Capitalization tab will also change:
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Use the Click to View Operated Asset Profiles link to open the Operated Assets Editor, where 
you can enter an occupancy profile and any operating revenues and expenses:

To start, you will need to create some pages and specify data on the Occupancy and Rates tab. See 
“Occupancy and Rates tab” on page 79 for further information.

On the Operating Revenues/Expenses tab, enter the revenues and operating expenses. See 
“Operating Revenues/Expenses tab” on page 82 for further information.

Note: For some calculation types, it is necessary that pages on the Occupancy and Rates tab 
have been created beforehand.

When you have finished creating the profile, click OK to close down the window and return to the 
area form.
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You can now use the revenue and expense profile in the area form using the Occupancy/Rates 
Profile drop-down:

Occupancy and Rates tab
The Occupancy and Rates tab allows you to enter the types of variables required to calculate the 
base income and operating revenues and expenses for a business operation. The types of variable 
are predefined and are listed in the table below. This tab holds an unlimited number of different 
pages of data, each page representing a single variable type. For example, in a hotel, you would 
have occupancy rates and the number of rooms.

Each page holds rates that change month by month and year by year. For simple operations, this 
may be % occupancy rates and average daily room rates. For more complex operations such as a 
marina, where many different variables are used, there could be dock length, monthly rate/ft and % 
occupancy.

The start date of Operated Asset Pages is (by default) the month of the commencement of the 
Holding Period (Stage 6 in the current Phase), therefore if you change the timing of this Stage, the 
Page timeframe will change also. You can also force the start date of the Pages to begin in January 
of the calendar year in which the Holding Period begins - but this is not as flexible as the default 
method. To select the method you wish to use, check or uncheck the Begin Occupancy and Rates 
at start of Holding Period option in the Profiles menu.

The profile requires you to enter each variable type required as a page in a notebook. When adding 
a page, you will be asked to specify what type of variable it will be used for, the Page Name and the 
number of decimal places required for the data. The variable types are:

Variable Type Description
Occupancy Rates This is used to specify the monthly occupancy of the operated unit as 

a percentage.
Available Units This is used to specify the number of units available per month.
Average Daily Rates The daily rate charged for occupancy of the unit. To calculate the 

monthly charge, the program multiplies the daily rate by the number 
of days in each month. From month to month, the number of days 
changes and this is reflected in the calculation.

Average Weekly Rates The weekly rate charged for occupancy of the unit. To calculate the 
monthly charge, the program multiplies the weekly rate by the 
number of weeks in the month. This is done by dividing the number 
of days in each month by 7. From month to month, the number of 
days changes and this is reflected in the calculation.

Monthly Rates The monthly rate charged for occupancy of the unit.
Daily Activities Used where calculations are based on the number of times per day an 

activity takes place. To calculate the monthly charge, the program 
multiplies the Daily Activities by the number of days in the month.

Weekly Activities Used where calculations are based on the number of times per week 
an activity takes place. To calculate the monthly charge, the program 
multiplies the Weekly Activities by the number of days in the month 
divided by 7.
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Click on the Add Profile button to add a profile to the Profile Browser.

On the Occupancy and Rates tab, click on the Add Page button to enter a profile of occupancy 
percentage and average daily rates. This opens the following dialog:

Here, you must define the basic properties of the asset page, such as a name, a data type (see table 
above) and a number of decimal places for any data that will be displayed.

Click OK to close down the dialog. Using the page properties you just defined, this creates a new 
page in the editor:

You can create as many profile pages as you require, each representing an asset or a data type.

For each of these asset profile pages, you can create a year-based schedule containing whatever 
type of data you have specified in the page properties. You can add a year’s set of rates by clicking 
the Add Year button.

Note: Adding a year to one page will add a year to all other pages in the profile. The Year 
label will automatically increment to show the year (for example, if the current year is 2008, 
the first entry would read 1 - 2008, the next entry 2 - 2009 and so on).

Monthly Activities Used where calculations are based on the number of times per month 
an activity takes place.

Measurement - Linear Used where calculations are based on the length of the occupied unit. 
For example, in a marina, charges may be made based on the length 
of the dock in which a boat is kept.

Measurement - Square Used where calculations are based on the area of a unit.

Variable Type Description
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In the example shown here, this contains an occupancy profile (this shows the occupancy 
percentage for each month).

Note: You can change the data type for a page at any time by right-clicking on the page and 
selecting Page Properties from the right-click menu.

The Occupancy and Rates page has the following options for creating a profile:

Add Page Allows you to add a new data page to the profile.

Delete Page Allows you to delete a page from the profile.

Move Left and Move Right These buttons allow you to shuffle the order of the data pages.

Add Year Allows you to add a new year line to the schedule.

Delete Year Allows you to remove a year line from the schedule.

Fill Row Allows you to populate the currently selected row with the value currently selected.

Fill Right Allows you to fill all the cells to the right of the current cell, using the value in the 
selected cell.

Fill Down Allows you to fill all the cells underneath the current cell, using the value in the selected 
cell.
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Operating Revenues/Expenses tab

This tab is used to generate the base income, additional revenue and operating expenses for the 
operation.

An operated asset usually has several sections of cost categories, each of which can be based on 
other sections or calculated from the page variables defined on the Occupancy and Rates tab.

Developer allows an unlimited number of sections and, within each section, an unlimited number 
of revenues or operating expenses.
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Revenue and Operating Expense Sections
Each of the sections can hold either revenues or operating expenses.

The following columns are displayed in this section of the Operating Revenues/Expenses tab:

Heading – this is used to identify the section in the cashflow and reports. It will also be used when 
the section is used as the basis for other calculations such as section summaries, section differences 
or percentage of section total.

Type – used to identify what the section contains: Revenue, Expense, Section Summary or Section 
Difference.

When a revenue item or an expense item is added to the Operating Revenue and Expense Detail 
part of this tab, the Type will be used to automatically set the new item’s Cost Type. Note that, if 
you change the Type from Revenue to Expense and vice versa, the program will change the “Cost 
Type” entries in the section below, after confirming that you want this to happen.

Summary and Difference sections can also be used as the basis for other calculations. You might 
want to base some operating expenses on a Departmental Profit section, which is itself based on 
one or more other sections.

• Section Summary - This type of section is used to add together each of the revenues or 
operating expenses in other sections. The calculation produces a new section, containing a copy 
of the revenues and operating expenses from each of the selected sections. When these are 
written to the cashflow, they will be grouped on the Category Code assigned to each revenue 
and operating expense item.

• Section Difference - This type of section is used to subtract one or more sections from each 
other. The calculation produces a new section, grouped on the Category Code assigned to each 
revenue and operating expense item.

Selection - for Section Summary or Section Difference, this is used to identify which other sections 
will be added or subtracted to calculate the new section.

Detail – use this check box to specify whether the Section Summary or Section Difference will 
contain a full detailed list of each of the items summarized or subtracted (if checked), or whether a 
single total line will be calculated (if left unchecked).
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Visible – use this check box to specify whether the Section Summary or Section Difference will 
appear in the cashflow. It may be that these types of section are included only for calculation of 
other operating expenses, in which case they would not be shown in the cashflow.

Operating Revenue and Expense Detail
Each section can hold an unlimited number of either revenues or operating expenses:

Heading – used to identify the item in the cashflow and on reports. It is also used when the item 
forms the basis for another calculation such as the percentage of another item.

Department Category – used mainly in the calculation of Section Summaries and Section 
Differences as outlined above. See also “Department Categories” on page 86.

Calculation Type – used to specify the method used to calculate monthly revenues or expenses in 
the cashflow. Depending on the method chosen, you may be required to enter a Rate or make a 
Selection of sections or categories from a popup dialog.

See the table “Calculation of Monthly Amounts” on page 87 for a list of calculation types and a 
description of each.

Rate Type – For most calculation types, the Rate Type will be either Single or Variable.

If Single is chosen, the Rate field allows you to enter a single rate for the entire projection period. 
If Variable is chosen, the Rate field expands to allow you to enter a table of rates that change 
month by month over any number of years.

There are two calculation types that have different options for the Rate Type: Amount / Occupied 
Asset and Amount / Available Asset. For these calculation types, Developer needs to know whether 
the Rate Type is Daily, Weekly or Monthly.

If a Daily, Weekly or Monthly rate type is chosen, the Rate field allows you to enter a single rate 
for the entire projection period.

If a Daily Variable, Weekly Variable or Monthly Variable rate type is chosen, the Rate field 
expands to allow you to enter a table of rates that change month by month over any number of 
years (example shown here is for Daily Variable Rates):
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Use this window to specify the pattern of rates throughout the year. Depending on the options you 
selected from the Calculation Type and Rate Type drop-downs, you will be able to enter either an 
amount or a percentage.

Selection – this field is enabled for the following Calculation Types:

• Base Income;

• Other Income;

• Straight % of Section Total;

• % of Other Category;

• Amount/Occupied Asset;

• Amount/Available Asset;

• Amount per Unit;

• Amount per Activity;

• Netted Down % of Section Total;

• Rate per Linear measure;

• Rate per Square measure.

Use the popup selection editor to choose which sections, categories or pages of rates will be used 
for the calculation:
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Cost Type – Allows you to select a cost type (either a Revenue or a Cost).

Inflation/Growth Set – this is used for growing revenues and inflating expenses.

Cap Method – the Cap Method is used to select which items will be included in the capitalization 
of Net Operating Income. The default method “Tenant Rate” is automatically selected when a new 
line item is created.

See the discussion in “Capitalization method” on page 88 for the approach used in capitalization 
calculations.

Capitalization Rate – the private rate used to capitalize this operating revenue or expense.

Notes – here, you can enter any notes for the line item.

Department Categories
The department categories you can create here are simply labels that you can use for categorizing 
each item you enter in the Operating Revenue and Expense Detail section.

Once you have created all categories, you can select them from the Department Category drop-
down in the Operating Revenue and Expense Detail section (see “Operating Revenue and Expense 
Detail” on page 84).

Where Section Summary/Differences are defined, the department category can be used to 
summarize individual line items into a single line. There is an option in the cashflow that controls 
whether individual or summarized lines are displayed.

For example, if you have multiple detail lines in a summary or difference section with a category of 
“Telephone”, you can combine the detail lines into a single line with the heading “Telephone”.

Use the Operating Rev/Exp | Department Categories menu option to open the Department 
Category Editor:

Type Description
None No capitalization of the operating revenue or expense.
Tenant Rate Capitalizes the operating revenue or expense using the Cap Rate on the area 

record.
Private Rate Capitalizes the operating revenue or expense using a rate entered for this item.
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To add a category, click on the Add Category button.

In the list, enter some descriptive text that can be used as a categorization label.

To insert a category, click on the Insert Category button.

If you need to delete a category, click on the Delete Category button.

Click OK to save your list of categories.

Calculation of Monthly Amounts
As explained in the previous section, the Calculation Type drop-down is used to tell Developer 
how to perform the calculation for the category.

Calculation Type Description
Base Income This is used to calculate the basic revenue generated from occupancy or 

use of an asset. For hotels, this is the revenue from letting the room to a 
guest on a daily basis.

The program uses the pages of rates setup on the Occupancy and Rate 
tab to calculate the base income. Using the Selection dialog, choose 
which pages of Occupancy %, Available Units and Daily/Weekly/
Monthly rates will be multiplied together to calculate the base income.

% of Base Income For operating revenues or expenses that are calculated as a % of the 
Base Income. It will not include any items that are defined as Other 
Income. Expenses based on occupancy of hotel rooms would use this 
type of calculation.

Other Income This is used to calculate basic revenue in exactly the same way as Base 
Income. Other Income differs from Base Income in that it will not be 
included in the % of Base Income calculations, described above.

Straight % of Section 
Total

For operating expenses that are calculated as a % of the total amount in 
another section. In a hotel, you may find that some expenses are based 
on the total gross revenue.

% of Other Category For operating expenses that are calculated as a percentage of another 
category defined in the current section or another section. In a hotel, 
you may find that the expense of the Telephones is based on the total 
revenue generated from use of telephones in guests’ rooms.

Amount/Occupied 
Asset

For operating expenses that are calculated as a rate per occupied unit. 
Use the Selection dialog to choose the Occupancy % and Available 
Units pages. These will be multiplied together to calculate the 
occupancy and multiplied by the rate entered.

For example, if a hotel has 100 rooms at 50% occupancy, there would 
be 50 occupied units which would be multiplied by the rate entered.
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Capitalization method
The Net Operating Income Capitalization Approach will be used to value the asset.

Net operating income can be capitalized using the “Cap Method” option in the Revenue and 
Expense profiles. Choose either “Tenant Rate” or “Private Rate” to capitalize the item.

“Tenant Rate” will pick up the Capitalization Rate from the area record to which the profile is 
attached. “Private Rate” will enable you to enter a manual Capitalization Rate for the item.

When capitalizing, Argus Developer projects for one year beyond the sale date to establish stable 
revenues and expenses. It will then use this projected years’ worth of figures to capitalize the net 
operating income.

You must choose a Capitalization Rate for each item of revenue and expense to ensure that the 
correct Net Operating Income is capitalized.

This is the same approach as that used in Additional Rent/Sales where each item can be included or 
excluded from capitalization. This may or may not be necessary for the valuation of the operated 
assets so may change in the future to have a single capitalization option for the entire profile.

Amount/Available 
Asset

For operating expenses that are calculated as a rate per available unit. 
Availability in this sense refers to maximum availability, not accounting 
for any occupancy. Use the Selection dialog to choose the Occupancy 
% and Available Units pages. These will be multiplied together to 
calculate the occupancy and multiplied by the rate entered.

For example, if a hotel has 100 rooms, there would be 100 available 
units which would be multiplied by the rate entered.

Amount/Unit Where “Unit” is used to describe rooms, rounds of golf, berths in a 
marina and so on. The number of units, which could change over time, 
will be taken from the Available Units page under the “Occupancy and 
Rates” tab and multiplied by the Units field on the area record. This 
will be multiplied by the number of days in the month and the rate.

Amount/Month Enters a fixed amount per month into the cashflow. This is not 
dependent on occupancy or any other section.

Amount/Week Multiplies the weekly rate by the number of weeks in the month and 
enters this into the cashflow. This is not dependent on occupancy or any 
other section.

Amount/Activity For operating revenues and expenses that are calculated as a rate 
multiplied by a page of activity rates entered on the “Occupancy and 
Rates” tab. When performing the calculation, Developer will use the 
Daily, Weekly or Monthly activity setting on the page of activity rates 
to arrive at the correct amount.

For example, in a hotel, you may calculate Food & Beverage as a rate 
multiplied by the number of covers for breakfast.

Netted Down % of 
Section Total

For operating expenses that are calculated as a percentage of the total 
amount in the same section, including itself. This would be similar to 
the way in which we calculate purchaser’s costs when they are 
calculated on the net development value.

Rate per foot/meter For operating expenses that are calculated as a rate multiplied by a 
linear measure as defined on an “Occupancy and Rates” profile.

Expenses in a marina may be calculated on the length of the berth.
Rate per square foot/
meter

For operating expenses that are calculated as a rate multiplied by a 
square measure as defined on an “Occupancy and Rates” profile.

Calculation Type Description
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Copying an Operated Asset profile
After creating an Operated Asset profile, you may wish to make a copy for use as a quick start in 
creating a new one that is slightly different.

To copy a profile, first select the one you want to copy from the Profile Browser:

Click on the Copy Profile button:

You will be prompted to confirm the action. Click Yes to proceed.

This creates a copy of the profile, adding it to the list:

You can proceed to rename the profile and configure it as with other profiles.
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CHAPTER 5
Entering Costs/Receipts and editing 
data

When you have set the options for Assumptions and Timescale, you are ready to start entering the 
project’s cost and receipt information.

Definition
Click on the Definition tab. When the Definition page appears, you will see that there is a single 
comprehensive screen for entering costs and revenues.

Each field shows values for the current phase only. If the Merged Phases tab is selected, each field 
shows the total values for all linked phases.

The data fields are generally displayed in three columns, as shown below, however this can be 
changed to one or two columns by selecting Definition Options from the View menu.

Navigation
You can move between fields by pressing the TAB key to go forwards or SHIFT + TAB to go 
backwards. Alternatively, click into each field with the mouse button - the field’s contents will then 
be highlighted and you can overtype any existing value.

Field Expansion
Each of the fields can be expanded to reveal extra detail. Some fields such as Town Planning 
expand to reveal only a single item. Others such as Capitalized Rent or Additional Costs expand 
into a full schedule comprising many items.
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Double-click inside any field or click on the Detail View button to view or edit any field in detail.

Results Bar
The Results Bar usually sits below the Definition page and is updated in real time as new values are 
entered. It is a live snapshot of your project and shows the key performance indicators such as 
Profit, Revenue, Cost and Interest amounts, as well as IRR and ratios.

You can choose to hide or display the Results Bar using the View menu, Show/Hide Results option, 
or by clicking onto the Show/Hide Results Bar button in the bottom right hand corner of the 
screen.

The panel can also be repositioned by left-clicking onto the Results Bar and dragging it to your 
preferred position on screen.

This panel can be customized to include only the results you are interested in. Right-click on the 
Results Bar and select Configure Results Bar.

Saved Styles
Customized Results Bar layout styles can be created, edited and saved.

• To edit an existing Results Bar layout style, select the style and click Edit.

• To create a new blank style, click New Blank. When prompted, enter a name for this new style 
and click OK.

• To make a copy of an existing style, click Duplicate and enter a name when prompted.

• To rename a saved style, click Rename and enter the new name.
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• To reset a style to the default style, click Reset.

• To delete a saved style, click Remove.

Components
Select a Results Bar layout style and click on the Components tab to customize the performance 
indicators shown on the Results Bar.

Viewing cost breakdown by group
If you scroll down to the bottom of the list on the Components page, you will see that the totals for 
major cost groups are included among the components you can use in the Results Bar:

To Do This

Fill a space on the Results Bar from point of 
insertion to bottom of Results panel.

Click and hold mouse on Filler and drag and 
drop at insertion point.

Create a space on the Results Bar between two 
components.

Click and hold mouse on Spacer and drag and 
drop between components.

Drag additional components onto the Results 
Bar.

Click and hold the mouse on a component and 
drag and drop it onto Results Bar.

Drag components from the Results Bar back 
to the Results Bar Configuration form.

Click and hold the mouse on a component and 
drag and drop it onto Components form.

Re-position Results Panel when the Results 
Bar Configuration form is showing.

Click onto the Results Bar, hold and drop on 
chosen position.



94 Chapter 5: Entering Costs/Receipts and editing data

ARGUS Developer version 4.05 Reference Manual

Settings
The vertical and horizontal gaps between result fields and labels, and the width of these fields on 
the Results Bar can be adjusted using the options on the Settings tab. 

This tab also provides option to customize the fonts and colors used.

You are also able to adjust the number of components in each row and column by using the options 
in the Order of Results Fields section.

Editing Data
As you work on a project, you will want to edit values, percentage fees, options, copy data and so 
on. This section describes how to make changes to your data.

Data can be entered into the detailed editor window in several ways:

• Fixed amount;

• Related/percentage data (note that you can enter percentages up to 10,000%);

• Gross/Net/Alternate rate per square meter or square foot;
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• Rate per unit;

• Rate per gross land area;

• Multiply rate by units.

In addition to this, there are also the following context-specific options:

• Related to RR Dates (Rent Review);

• Land Transfer Tax.

Double-click into any field in the Definition page, or right-click on a row in the Cash Flow and 
select Edit Source from the drop-down menu, to open the detailed editor dialog box for an item.

Common controls found in the detail editors
In the detail editors that you can open from the Definition page or Cash Flow, there are common 
controls, such as buttons and drop-downs, which perform the same tasks wherever you are.

The following list describes these controls:

Type drop-down
Select the required data type from the drop-down menu, and the editor form will change to display 
fields for that data type.

Each of these data entry types are dealt with in turn in “Fixed Amount items” on page 98, “Related/
Percentage Data” on page 99, “Rate Per Square Foot/Meter” on page 103, “Amount per unit items” 
on page 104, “Rate on Leasing” on page 106, “Multiply Rate by Units” on page 107, “Rate/Gross 
Land Area” on page 107, “Land Transfer Tax” on page 108 and “Related to RR Dates (Rent 
Review)” on page 109.

Amount
Use this entry field to type in an amount consistent with the type of data you selected in the Type 
drop-down. You can enter a fixed monetary amount, a percentage,or a number of units.

Selection
This control will only become active if you select a data type that allows you to specify a 
percentage or a number of units. When you click on the Selection control, a dialog will appear, 
allowing you to select a number of items or units. The type of selection dialog you see here will 
depend on the data type you selected in the Type drop-down.

Total
This read-only field shows the total amount of money for this cost.

Repeat Cycle
This drop-down allows you to specify a periodic cost type, so that the cost specified here can be 
repeated at regular intervals.
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The following choices are available here:

• (None) - This is a one-off cost that does not repeat;

• Monthly - This allows you to specify that the cost will repeat on monthly intervals;

• Quarterly - This allows you to specify that the cost will repeat on quarterly (3-monthly) 
intervals;

• Semi-Annually - This allows you to specify that the cost will repeat on semi-annual (6-
monthly) intervals;

• Annual - This allows you to specify that the cost will repeat on yearly intervals;

• Custom - This allows you to define a custom number of months as the repeat period. The 
Repeat Frequency field becomes active so you can type in an amount.

If you define a repeat cycle, this will have an effect on the timing and distribution of the amount 
(the example below shows a quarterly repeat cycle). Click on the Timing control to see this effect 
on the distribution:

The Change Labels button can be used to customize the label or heading for an item which 
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appears in the Definition and Cash Flow screens, and/or in Reports and the Project Pro Forma 
screen. See “Customizing Labels” on page 116.

Adding an Item
To add a new item, click on the Add button. The new item is added to the end of the cost/receipt 
table.

Deleting an Item
To delete an item, click onto its heading then click on the Delete button.

Delete all feesTo delete all fees from the schedule, click on the Delete All button. The fees will be 
removed from the schedule.

Timing and Distribution
To view a graph of the way in which the cost is distributed, click on the Data Distribution button. 
You can change the timing and distribution using the options described in“Data Distribution” on 
page 111.

View Financial Data
You can view extra columns (such as for setting the Cost/Revenue type) by clicking on the View 
Financial Data button.

Use the Cost Type control to specify how the total value is treated in the calculations (in other 
words, the cost type). In this drop-down, you have the following choices:

• Cost The amount will be added to the project’s total costs.

• Cost (Reducing Revenue) The total amount for this item will be used to offset/reduce the 
project’s total revenue.

• Revenue (Reducing Cost) The amount will be offset against the project’s total costs, reducing 
the total cost balance.

Also, you can use the controls to apply Interest and/or Inflation sets, and to enter GST and GST 
recovery rates:

• Interest Set Enter the appropriate set name into the Interest Set field. By selecting a set name, 
interest rates are attached to the item. To switch off interest, check the Ignore Interest check 
box.

• Inflation/Escalation Set Select either Ignore or a set name from the drop-down list. By 
selecting a set name, Inflation/Escalation rates are attached to the item.

• GST Rate Enter the rate of GST applicable to the item.

• Recovery Rate Enter the rate of GST recovery that can be achieved for the item.

Move Up
You can choose a fee from within a list and move it up the row order.
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Move Down
You can choose a fee from within a list and move it down the row order.

Fixed Amount items
To change any fixed amount field, click into it in the Definition page and type in the new value. As 
you click into the field, ARGUS Developer selects the entire field and positions the cursor over the 
click point.

To view more detail, click onto the Detailed Definition button to open the Fixed Amount detailed 
editor dialog box.

Alternatively, in the Cash Flow, right-click on a row and select Edit Source from the drop-down 
menu to open the detailed editor dialog box.

The new amount entered will replace any previously entered value in the Definition and Cash Flow 
sections. The amount will be distributed across the cash flow row in proportion to the current 
distribution.

If Structured Financing is used, the Interest Set is disabled.

You can exclude the cost item from the interest calculations by selecting the Ignore Interest check 
box.

The Timing dialog (called by clicking on the Timing control in the editor window) allows you to 
enter the starting date for the item’s payment:

You can attach an item to one of the development stages in the Stage drop-down list. Items attached 
to development stages are automatically re-timed whenever changes are made to the project 
timescale.
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The timing of an item can be offset from the start of the development stage by using the Offset by 
field to specify a number of months from the start of the stage that the item is to be delayed.

Alternatively, to fix the item at a specific date or period in the cash flow, select Date or Period 
from the Start Date list. You can then use the spinner arrows to select a date or a period. Now, 
when changes are made to the project timescale, the item will remain fixed in the chosen date or 
period.

Tick the Allow Custom Distribution box to spread the total payment over any number of periods. 
The use of the Data Distribution Editor is covered in “Data Distribution” on page 111.

Related/Percentage Data
To change any related/percentage data item, click into it in the Definition page and type the new 
value. As you click into the field, ARGUS Developer selects the entire field and positions the 
cursor over the click point.

To view more detail, click onto the View Detail button to open the detailed editor dialog box. 
Alternatively, in the Cash Flow, right-click on a row and select Edit Source from the drop-down 
menu to open the detailed editor dialog box.

In the detail editor, you can choose the Related % option from the Type drop-down to switch the 
editor into Related/Percentage mode.

The Amount field allows you to change the related %, to specify which other costs/receipts this 
item will be related to and both the basis and type of relation.

Note: You can enter a percentage of up to 10,000% here. Most of the time, you would only 
need to enter percentages up to 100%, but Developer allows larger amounts to be entered in 
certain situations.

To select the items to which the fee is related, click on the Selection control and use the browser 
table in the Related Items Selection window:
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You can use either the mouse or the keyboard for selection.

Using the mouse
To relate to an item using the mouse, click into the check box in the Include? column once with the 
left mouse button.

Using the keyboard
To relate to an item using the keyboard, move to the item’s row in the browser table using the up/
down arrow keys, and press the space bar to check the Include? check box.

Click the Select All button to select all items in the browser table simultaneously.

Click the Deselect All button to remove the selection from all items.
Calculate related value based on Uninflated Source Amount Where fees are related to items that 
may be inflated, you have the option of calculating the fee on the uninflated amount by ticking this 
box.

Override the default relation for this fee All related items are related automatically to their 
source rows in the cash flow. If you wish to change which items you are relating to, make your 
selection in the browser. The program will ask for confirmation that you wish to override the 
default relation settings and, when confirmed, check the Override the default relation for this fee 
check box. To reset the fee relation to the default relation settings, uncheck the Override the 
default relation for this fee check box.

Basis The basis for the relation is normally Straight – in other words, the fee is an exact percentage 
of the source items. Other options are Netted Down or Grossed Up fees (see below).

In some circumstances, you may wish to set up Netted Down or Grossed Up fees. The table below 
illustrates the effect of using the different relation basis types.

Relation Basis



Chapter 5:  Entering Costs/Receipts and editing data 101

ARGUS Developer version 4.05 Reference Manual

Type The relation type is used to specify how the related amounts will be placed period by period in 
the cash flow. For example, if you wanted Contingency to follow the Construction payments 
exactly, a Period by Period type of relation type would be used.

The Type drop-down is updated automatically when you make selections in the browser table. The 
table below illustrates the use of different relation types.

Relation Type

The Financial and Advanced pages for Related/Percentage data are similar to those for Fixed 
Amount items. See “Fixed Amount items” on page 98.

Timing
By default, related items follow the distribution of the items to which they are attached. However, 
the distribution of related items can be customized in the Timing dialog.

The Timing dialog is called by clicking on the Timing control in the editor window:

Basis Amount Related % Total
Straight 10,000 x 10% 1,000
Grossed Up 10,000 x 110% x 10% 1,100
Netted Down 10,000 / 110% x 10%   909

Type Description
Period by Period to 1 
row

Values in the related line follow the distribution of a single source line 
exactly, period by period.

Period by Period to 
many rows

Values in the related line follow the distribution of a block of source 
lines exactly, period by period.

Period to 1 row A single period is related to the total value of a single source line.
Period to many rows A single period is related to the total value of a block of source lines.
Period to Period A single period is related to a single period on just one other line.
Custom Distribution 
to 1 row

The total value in the related line is locked to the total value of the 
single source line. Values in the related line can, however, be 
distributed in any way you like. 

Custom Distribution 
to many rows

The total value in the related line is locked to the total value of a block 
of source lines. Values in the related line can, however, be distributed 
in any way you like.



102 Chapter 5: Entering Costs/Receipts and editing data

ARGUS Developer version 4.05 Reference Manual

The start date for distribution of the item can be attached to one of the development stages in the 
Stage drop-down list. The timing of an item can also be offset from the start of the development 
stage by using the Offset by field to specify a number of months from the start of the stage by 
which the item is to be delayed. Items attached to development stages are automatically re-timed 
whenever changes are made to the project timescale. In addition, you have the choice of aligning 
the timing with the start or end of a stage, using the “Start of” and “End of” options in the small 
drop-down next to the Stage drop-down list.

Alternatively, to fix the item at a specific date or period in the cash flow, select  Date or Period. 
You can then use the spinner arrows to select a period. Now, when changes are made to the project 
timescale, the item will remain fixed in the chosen date or period.

To fine-tune the Start Date or End Date, you can use the Offset by control to specify a negative or 
positive number that will alter the start date or end date that you have set so far.

Check the Allow Custom Distribution box to spread the total payment over any number of 
periods. If you wish to open the Distribution Editor, click on the Data Distribution Editor link 
(the blue text at the top of the dialog).

The use of the Data Distribution Editor is covered in “Data Distribution” on page 111.

Check the Use Extended Timing box if you wish to see further options allowing you select phases 
in the Start Date, Distribution and End Date groups (using the Phase drop-downs). These options 
allow you to reference any phase besides the current (default) phase. If you do so, the timings will 
be anchored to the specified stage in the phase you have selected.

When dealing with the timing of sales items, the Dispose of whole units check box becomes 
active. This is checked by default, but you can leave it unchecked if you wish to sell units in 
smaller increments. This check box is not enabled for non-sales items.

In the Distribution group, the To End Date option button allows you to enable the End Date group, 
which allows for selection of an End Date for the distribution that can reference any other phase or 
stage.
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Other timing dialogs

Throughout ARGUS Developer, you may see another type of timing dialog (different to the one 
described above):

This type works in much the same way as the timing dialog described earlier, with the exception 
that it has no chart and does not allow distribution.

Rate Per Square Foot/Meter
To switch the detail editor into this mode, select any of the Rate/pf2 or Rate/pm2 options 
(depending upon whether you have Imperial or Metric measurements selected) from the Type drop-
down list.

You can choose whether the rate is to be applied to Gross, Net or Alternate floor areas of the 
selected area items.

This does not apply if the rate per sq ft/per sq m is to be applied to the site area.

Amount To change the rate per sq ft/per sq m, simply type into the Amount box.

To select areas that will be included in this calculation, click on the Selection control to open the 
following window:



104 Chapter 5: Entering Costs/Receipts and editing data

ARGUS Developer version 4.05 Reference Manual

Scope Define the area to which the rate applies in the Area field. Options available are as follows:

• Apply to all areas The cost will be applied to the total floor area of the phase.

• Apply to selected areas When this option is selected, a browser table is displayed (as 
illustrated above) listing all defined area items for the phase, from both the Capitalized Rent and 
Unit Sales forms. To select the areas to which the rate is applied, use the browser table. The 
total selected floor area is displayed at the bottom of the dialog box. You can use either the 
mouse or the keyboard for selection. 

Using the mouse
To select an item using the mouse, click into the check box in the Include? column once with the 
left mouse button.

Using the keyboard
To select an item using the keyboard, move to the item’s row in the browser table using the up/
down arrow keys, and press the space bar to check the Include? check box.

Click the Select All button to select all area items simultaneously.

Click the Deselect All button to remove the selection from all items.

Amount per unit items
Cost/receipt data may also be entered as an amount per unit in the Definition screen.

To change any item entered as an amount per unit, click onto it in the Definition page and enter the 
new value. As you click onto an item in the browser list, ARGUS Developer selects the entire field 
for editing.

To view more detail, click onto the Detail View button to open the detailed editor window.
Alternatively, in the Cash Flow right-click on a row and select Edit Source from the drop-down 
menu to open the detailed editor window.
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To switch the detail editor into this mode, select the Rate/Unit option from the Type drop-down 
list.

To change the amount per unit to be applied, simply type into the Amount field.

To select units that will be included in this calculation, click on the Selection control to open the 
following window:

A browser table lists all defined area items, and the associated number of units, for the phase from 
both the Capitalized Rent and Unit Sales forms. To select the units to which the rate is applied, use 
the browser table. The total number of units selected is displayed at the bottom of the dialog box. 
You can use either the mouse or the keyboard for selection.

If you wish to display all the area items from other phases, check the Include Other Phases box. 
You can use this option to include units from the other phases - this is a time-saving feature.

Using the mouse
To select an item using the mouse, click into the check box in the Include? column once with the 
left mouse button.

Using the keyboard
To select an item using the keyboard, move to the item’s row in the browser table using the up/
down arrow keys, and press the space bar to check the Include? check box.

Click the Select All button to select all area items simultaneously.
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Click the Deselect All button to remove the selection from all items.

Rate on Leasing
Leasing agent/legal fees may also be entered as a rate on leasing in the Definition screen. See also 
“Leasing Costs” on page 127.

To change any item entered as a rate on leasing (for example, Leasing Agent Fee or Leasing Legal 
Fee), click onto it in the Definition page and enter the new value. As you click onto an item in the 
browser list, ARGUS Developer selects the entire field for editing.

To view more detail, click onto the Detailed Definition button to open the detailed editor window.
Alternatively, in the Cash Flow right-click on a row and select Edit Source from the drop-down 
menu to open the detailed editor window.

To change the amount per unit to be applied, simply type into the Amount field.

A browser table lists all defined leasing items, and the associated rents, for the phase from the 
Capitalized Rent form. To select the tenants to which the rate is applied, use the browser table.

You can use either the mouse or the keyboard for selection.

Using the mouse
To select an item using the mouse, click into the check box in the Include? column once with the 
left mouse button.
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Using the keyboard
To select an item using the keyboard, move to the item’s row in the browser table using the up/
down arrow keys, and press the space bar to check the Include? check box.

Click the Select All button to select all area items simultaneously.

Click the Deselect All button to remove the selection from all items.

Multiply Rate by Units
Fees may be entered as a rate multiplied by units in the Definition screen.

To change any item, click onto it in the Definition page and enter the new value. As you click onto 
an item in the browser list, ARGUS Developer selects the entire field for editing.

To view more detail, click onto the Detailed Definition button to open the detailed editor window.
Alternatively, in the Cash Flow right-click on a row and select Edit Source from the drop-down 
menu to open the detailed editor window.

In the Type drop-down, select Multiply Rate by Units.

To change the rate to be applied, simply type into the Amount field.

To specify a number of units by which you wish to multiply the rate, click on the Selection control.

This opens the following dialog box:

You can use this dialog box to enter a number of units and a brief description of the units involved.

Rate/Gross Land Area
Fees may be entered as a rate multiplied by gross land area in the Definition screen.

To change any item, click onto it in the Definition page and enter the new value. As you click onto 
an item in the browser list, ARGUS Developer selects the entire field for editing.
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To view more detail, click onto the Detailed Definition button to open the detailed editor window.
Alternatively, in the Cash Flow right-click on a row and select Edit Source from the drop-down 
menu to open the detailed editor window.

In the Type drop-down, select Rate/Gross Land Area.

To change the rate to be applied, simply type into the Amount field.

Land Transfer Tax
Fees may be entered for Land Transfer Tax in the Definition screen. See also “Land Transfer Tax” 
on page 120.

To change any item, click onto it in the Definition page and enter the new value. As you click onto 
an item in the browser list, ARGUS Developer selects the entire field for editing.

To view more detail, click onto the Detailed Definition button to open the detailed editor window.
Alternatively, in the Cash Flow right-click on a row and select Edit Source from the drop-down 
menu to open the detailed editor window. This will open the Land Transfer Tax editor:

In the Type drop-down, select Land Transfer Tax.

To change the land transfer tax amount/rate to be applied, you will need to click on the Selection 
button and select items from the Land Transfer Tax Selection window:
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In this window, a browser table lists all defined land items for the phase. To select the items to 
which the land transfer tax will be applied, use the browser table. To select the land transfer tax 
scheme that you wish to apply to the items you have selected, select the appropriate scheme from 
the Land Transfer Tax Scheme drop-down list.

If you currently have no land transfer tax schemes defined, click on the Edit Land Transfer Tax 
Schemes button (see below).

You can use either the mouse or the keyboard for selection.

Using the mouse
To select an item using the mouse, click into the check box in the Include? column once with the 
left mouse button.

Using the keyboard
To select an item using the keyboard, move to the item’s row in the browser table using the up/
down arrow keys, and press the space bar to check the Include? check box.

Click the Select All button to select all area items simultaneously.

Click the Deselect All button to remove the selection from all items.

Click the Edit Land Transfer Tax Schemes button if you wish to edit the profile of the land 
transfer tax scheme you are using, or to create new land transfer tax schemes. This will take you to 
the Land Transfer Tax Schemes window (see “Land Transfer Tax” on page 120 for further details 
of this window).

Related to RR Dates (Rent Review)
You may enter Rent Review Fees as a “Related to RR Dates” value in the Definition screen. See 
also “Rent Review Fees” on page 130.

To change any item, click onto it in the Definition page and enter the new value. As you click onto 
an item in the browser list, ARGUS Developer selects the entire field for editing.

To view more detail, click onto the Detailed Definition button to open the detailed editor window.
This will open the Rent Review Fee editor:

In the Type drop-down, select Related to RR Dates.
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To change the rate and amount to be applied, you can type a rate in the Amount box and click on 
the Selection button to select tenants from the Rent Review Fee Tenant Selection window:

In this window, a browser table lists all defined tenants for the phase. To select the tenants that you 
wish to include, use the browser table.

You can use either the mouse or the keyboard for selection.

Using the mouse
To select an item using the mouse, click into the check box in the Include column once with the 
left mouse button.

Using the keyboard
To select an item using the keyboard, move to the item’s row in the browser table using the up/
down arrow keys, and press the space bar to check the Include check box.

Click the Select All button to select all area items simultaneously.

Click the Deselect All button to remove the selection from all items.
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Adding notes
In any editor window, you can add notes to each record in the editor by clicking on the Notes 
button. This opens a window similar to the following:

Type in or paste any informative text that you wish to record here, and click on OK to proceed.

Data Distribution
Graph
This screen provides a graphical view showing how values are distributed over the timescale of the 
project. In addition, it enables you to re-time and redistribute values using the standard 
construction-type curves.

The screen can be opened from the Cash Flow by right-clicking on a value and selecting the Data 
Distribution option.

Alternatively, to customize the distribution of a specific item in the Cash Flow, right-click on the 
selected row and select Data Distribution from the drop-down menu.

In Data Distribution, you can redistribute an item by selecting it from the Heading field.

By default, related items follow the distribution of the items to which they are related. To customize 
the distribution of a related item, you must check the Allow Custom Distribution check box 
before the timing can be modified.
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Heading The Heading drop-down box allows you to scroll through all defined values for the 
project. As the heading changes, both the Options and Graph change to reflect current values.

Total Shows the total amount entered for the item.

Start Date You can attach an item to one of the development stages in the Stage drop-down list. 
Items attached to development stages are automatically re-timed whenever changes are made to the 
project timescale.

The timing of an item can be offset from the start of the development stage by using the Offset by 
field to specify a number of months from the start of the stage by which the item is to be delayed.

Alternatively, to fix the item at a specific date or period in the cash flow, select Date or Period 
from the Start Date list. You can then use the spinner arrows to select a date or a period. Now, 
when changes are made to the project timescale, the item will remain fixed in the chosen date or 
period.

Distribution CurveType Contains pre-defined curve types for distributing the total amount across 
the cash flow row.

Over Stage You can attach an item to one of the development stages in the drop-down list. 

Duration Holds the total duration period for the final distributed amount.

Alternative graph options You may display the graph in different ways, using the options in the 
Graph menu (Bar, Line and Pie).

Editor
You can precisely specify the way values are distributed in the cash flow by using the Editor. To 
open the editor, check the Allow Custom Distribution check box on the Graph tab, then click on 
the Editor tab. If you do not select the Allow Custom Distribution check box on the Graph tab 
before clicking the Editor tab, a prompt will appear, to confirm that you wish to set custom 
distributions:

Click Yes to proceed. The Editor tab will be displayed:



Chapter 5:  Entering Costs/Receipts and editing data 113

ARGUS Developer version 4.05 Reference Manual

The Editor shows data from a single line in the cash flow. It expands the cash flow line into two 
separate rows, one showing the % of total value in each period and the other the actual value in 
each period. A third row shows the inflated cost if Inflation/Escalation has been applied to the item.

To edit the distribution, if the relation type is fixed, use the Editor schedule to enter the percentage 
of Total value into each period or to enter fixed amounts. These items can then be locked (see 
below).

Automatically maintain 100% distribution After typing a new percentage figure or actual value 
into a cell, the Editor can adjust all other % figures or period fixed amounts to absorb the difference 
between the new and previous value to give a total of 100%, if Automatically maintain 100% 
distribution cell is ticked. If you do not wish ARGUS Developer to automatically adjust other cell 
values to maintain a total value of 100%, then untick this option.

Locking a cell’s value Any cell can be locked so that its value does not change when other cells 
are edited. You can lock either the percentage value or the amount, but not both in the same period. 
To lock a cell, select the cell and click on the Lock Cell button. Locked items are shown in italics.

Selecting cells You can select any number of cells at a time by clicking on a cell, and “painting” a 
range. This will select multiple cells. Alternatively, you can select or “paint” a range of periods 
shown in the chart, by clicking and dragging:
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Alternative graph options You may display the graph in different ways, using the options in the 
Graph menu (Bar, Line and Pie).

Enable Partial Distribution To adjust part of the item’s distribution, tick Enable Partial 
Distribution and define the distribution required. This opens a new section (outlined in green here 
for illustrative purposes):

• Select the curve Type to distribute part of the value/cost across the cash flow from the list of 
pre-defined curve types. 

• Select the period over which part of the item is to be redistributed using the From Period and 
To Period fields.

• Specify the amount or percentage of the value/cost to be distributed over the selected period in 
the Amount /% for Redistribution field. Then click Apply to apply the defined partial 
distribution. To see the distribution before you apply it, click on the Preview button.

Preview
Click on Preview to view the curve distribution before you apply it. This opens the Split Curve 
Preview window:
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This window shows what the distribution would look like if you use the settings you have made. If 
you are happy with this distribution, click on the Apply button.

Print Graph
Opens a preview screen of the distribution graph for the item, from which the graph can be printed.

Reset to Default Timing
Overrides any changes made and resets the distribution of the item to the default timing.

Undo All Changes
Cancels all changes made and resets the distribution of the item.

Lock Current Cell
Locks the currently selected cell.

Unlock Current Cell
Unlocks the currently selected cell.

Copying a Phase

You can make a copy of a phase in the Timescale and Phasing window by clicking the Copy Phase 
button.

This opens the Copy Phase form.

All data including timescale, area definitions for Capitalized Rent and Unit Sales, residual targets, 
costs and receipts will be copied into either an existing phase or a new phase which is added to the 
end of the phase list.

In multi-phased projects, you have the option of copying the data into an existing phase. If you 
select this option, all data in the existing phase will be erased before the copy takes place.

If you have only one phase defined, a new phase will be created before the copy takes place.

Copying an Area
To copy an area definition, you must have the Capitalized Rent or Unit Sales form open. To open 
the form, click on the expansion button in the Definition page.
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Click onto the Copy Area button, or from the Area menu choose Copy Area to open the Copy 
Area dialog:

Enter the number of copies required and click on OK. The current area will now be copied and 

added as a new area definition.

Customizing Labels
You can customize the labels for many of the fields you see on the Definition screen. When you 
customize a label, the change is immediately realized in the Cash Flow, Project Pro Forma and 

Reports.

The Change Label button in the detail editor dialog box can be used to customize the label or 
heading for an item which appears in the Definition and Cash Flow screens, and/or in Reports and 

the Project Pro Forma screen.

To change a label
1. Double-click on the required label in Definition, or click onto the Change Labels button in the 

detail editor dialog box.

2. If you are editing the label for the Land Cost, type a new description into the Definitions & 

Cash Flow field and/or Reports field.

If you are editing the label for any of the other detail editors, type a new description into the 
Current Label field.
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3. Click on the OK button to accept your settings.

To reset a label to its original value
It is possible to reset a specific field label back to its original factory setting.

1. Double-click on the required label in Definition, or click onto the Change Labels button in the 
detail editor dialog.

2. Select the Reset Label Value option, then select the first option button (for example, 
“Architect” only).

3. Click on the OK button to accept your settings.

To reset all labels to their original values
It is possible to reset field labels back to their original factory settings.

1. Double-click on any label in Definition, or click onto the Change Labels button in the detail 
editor dialog.
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2. In the Change Label dialog, select the All label values in this project option.

Warning: Be aware that this option can reset all the field labels shown in the Definition tab.

3. If you wish to reset all labels that have been customized within the detail editor, check the 
Override any custom label changes check box.

Warning: Be aware that if this check box is used in conjunction with the “All label values in 
this project” option, this can reset all the field labels in both the Definition tab and within 
each detail editor, including any you have customized.
If this check box is used on its own (with no other option selected), it will just remove any 
customizations you have made to the labels of records within the currently selected detail 
editor.

4. Click on the OK button to accept your settings.

Changing Cash Flow row headings
Row headings can be changed directly in the cash flow. Click onto the row heading:

Type the required label into the Row Heading form:

Click on the OK button to accept the new heading.
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CHAPTER 6
Acquisition Costs

This section describes the entry of all costs associated with the site acquisition.

Acquisition Price
You can enter the Acquisition Price in one of three ways:

1. Set a Residual Target and let the system calculate the acquisition price.

2. Enter the acquisition price directly into the field on the Definitions screen.

3. Click on the expansion button and enter a schedule of known land acquisition prices. This 

method is useful where parcels of land are acquired separately, but where you still need a 

residual site value to complete the development. In this case, you will also need to set a 

Residual Target.

Methods 1 and 2 assume that the acquisition cost will occur in the first period of the Purchase Stage 

defined in the Timescale and Phasing screen. As with all costs and receipts, however, you can 

reschedule the Purchase to take place in any period of the cash flow.

If you have set a Residual Target, the Acquisition Price is calculated automatically and cannot be 

modified. A flag indicating “Residualized Price” will be shown next to the value.

If the Acquisition Price is known, you may enter the value in the Land Cost field. 

If you have entered a schedule of fixed acquisition prices, the Land Cost field shows the total of all 

fixed purchases.

Fixed Acquisition Price
ARGUS Developer allows a mixture of residual and fixed land costs within each phase. You could 

set up the fixed acquisitions independently of any residual land cost. The Fixed Acquisition Price 

schedule is intended for those types of development where parcels of land must be acquired 

separately in order to complete acquisition of the entire site.

Any Land Transfer Tax and Acquisition fees will be extended to include fixed land costs.

To enter the fixed land costs, click on the Land Cost detail button.

The Fixed Acquisition Price editor is displayed, into which you can enter the periodic amounts for 

each plot purchase.



120 Chapter 6: Acquisition Costs

ARGUS Developer version 4.05 Reference Manual

Please see “Editing Data” on page 94 for further details of the common controls in this editor.

Land Transfer Tax
This can be entered in various different ways:

• Using customized bandings (see below for further explanation).

• As a percentage of Acquisition Price;

• As a fixed amount;

• As a rate per square foot or meter;

4. As an amount per unit.

Please see “Editing Data” on page 94 for further details of the common controls in this editor.

ARGUS Developer allows you to enter unlimited bandings where the basis of tax is a set of 
percentages based on stepped thresholds.

To set up bandings, click File | Administration | Edit Land Transfer Tax Schemes...
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Adding a Scheme
To add a scheme to the schedule, click on the Add Scheme button. The cursor will be moved to the 
new row.

Deleting a Scheme
To remove a scheme from the schedule, click on the Delete Current Scheme button. When asked 
to confirm the deletion, click on the Yes button.

You are now able to rename the scheme to suit your requirements and now have the ability to 
define the bandings for your land transfer tax scheme.

Lower Limit
This is the lowest figure in the individual band.

Upper Limit
This is the highest figure in the individual band.

Percentage
The percentage that applies to the particular band.

Cumulative
In some countries, the tax is a continual accumulation from one band to the next as opposed to a 
single percentage applied to the total value. By checking the Cumulative box ARGUS Developer 
carries forward the amount from the last banding to the next (Example: lower limit $0, upper limit 
$55,000, Percentage 0.5%  [$55,000-$0] * 0.005 = $275 fixed amount carried through to next 
banding).

Fixed Amount
This figure is calculated from the previous banding and carried through to be added to next banding 
(see Cumulative explanation above).

Rounding
The Rounding Amount affects what land value is passed to the land transfer tax calculation. The 
Land Value is rounded up to the nearest Rounding Amount to calculate the land transfer tax.

Manual Cumulative Amounts
You can enter manual amounts when this box is ticked.
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Flag All Bands as Cumulative
Turns all bands into cumulative mode.

Reset the Cumulative Flag on all bands
This button will turn off cumulative mode for all bands.

Town Planning, Survey, Agent Fee and Legal Fee costs can all be entered in this section of 
Definition. Please see “Editing Data” on page 94 for further details of the common controls in this 
editor.

Note: If you open a .wcf file containing land transfer tax schemes that are not currently saved 
in your master Land Transfer Tax file, the Unknown Land Transfer Tax Schemes window 
will be displayed. To update your master Land Transfer Tax file, check the schemes listed in 
this window and click OK. This will update the list of land transfer tax schemes shown in the 
Land Transfer Tax Schemes window. See also “Unknown Land Transfer Tax Schemes” on 
page 228.

Other Acquisition Costs
A schedule is available for defining any other costs associated with the site acquisition. These can 
be defined as percentage related amounts or fixed amounts. Where a percentage related amount is 
entered, the value is related to the Land Cost.

Each cost will be placed at the beginning of the Purchase stage defined in the timescale.

Please see “Editing Data” on page 94 for further details of the common controls in this editor.

Site Area
Enter the Site Area in this field. You can change the units of measurement for Site Area by 
choosing Options from the Tools menu. On the General tab, change the units by selecting from the 
Land Measured in list.

It is possible to base other costs on the Site Area. The Site Area will be converted when changing 
Imperial and Metric units.
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CHAPTER 7
Construction Costs

This section describes the entry of all costs associated with construction.

Construction Cost
The Gross Construction cost is shown in this field. It is the addition of all construction costs in the 
Capitalized Rent and Sales schedules. You cannot edit this field.

The Construction cost is distributed over the Construction stage defined in the timescale using the 
prevailing Construction curve type (as specified in the Assumptions for Calculation window, 
Distribution tab - see “Distribution Tab” on page 19).

Below this, there are several different construction cost fields available, into which you can enter 
an unlimited number of items. The construction costs are:

• Contingency;

• Demolition;

• Road/Site Works;

• Statutory/Municipal;

• Developers Contingency;

• Other Construction;

• Municipal Costs.

Click onto the detail button to open up the Detail Editor on each cost.

Please see “Editing Data” on page 94 for further details of the common controls in this editor.

The following costs will be placed as a single amount in the first period of the construction stage 
defined in the timescale:

• Demolition;

• Road/Site Works;

• Statutory/Municipal.

These costs will be distributed and the duration of the construction stage defined in the timescale 
using the prevailing construction curve type:

• Contingency;
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• Developer’s Contingency;

• Other Construction;

• Municipal Costs.

Other Construction Costs

Click on the Other Construction detail button to open the schedule.

You can enter any other construction-related costs into the Other Construction Cost schedule.

Each cost can be specified in one of several ways:

• as a fixed amount;

• as a Rate pm2 Gross (or Rate pf2 Gross) multiplied by the total gross build area of selected 
tenants or properties;

• as a Rate pm2 Net (or Rate pf2 Net) multiplied by the net build area of selected tenants or 
properties;

• as a Rate pm2 Alternate (or Rate pf2 Alternate) multiplied by the alternate area of selected 
tenants or properties;

• as an amount per unit multiplied by the total number of units for selected tenants or properties.

Please see “Editing Data” on page 94 for further details of the common controls in this editor.

When a cost type is entered the other options are disabled, for example if you enter a fixed amount, 
the Rate/ pf2 (or Rate/ pm2), Area, Rate/Unit and Units cells are all disabled (see graphic above).

When a new item is created, it will automatically have professional fees attached to it. If you do not 
want professional fees to be calculated for the item, uncheck the Allow Prof. Fee check box.

Municipal Costs

Click on the Municipal Costs detail button to open the Municipal Costs schedule.

Please see “Editing Data” on page 94 for further details of the common controls in this editor.

The same options apply in this schedule to the other construction costs as detailed above.
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CHAPTER 8
Professional Fees

Professional fees are, by default, calculated as a percentage of construction costs defined in the 
Capitalized Rent and Sales forms. You can choose to include Contingency and/or Demolition and 
Road/Site Works in the calculations. To do this, check the relevant check boxes on the 
Expenditure tab of the Assumptions for Calculation window (see “Expenditure Tab” on page 8).

The fee amount will be distributed and the Construction stage defined in the timescale using the 
prevailing construction curve type.

Professional Fees
This section describes the entry of all professional fees.

There are six standard Professional Fee fields available, plus Other Professionals into which you 
can enter an unlimited number of items.

The six standard fees are: Architect, Quantity Surveyor, Structural Engineer, Mechanical/Electrical 
Engineer, Project Manager and Construction Design Manager.

Click onto the magnify button to open up the Detail Editor on each fee. Please see “Editing Data” 
on page 94 for further details of the common controls in this editor.

Other Professionals
This schedule is used for entering any other Construction-related fees and fixed costs.

Click on the Other Professionals expansion button to view the schedule.

Please see “Editing Data” on page 94 for further details of the common controls in this editor.
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CHAPTER 9
Marketing, Leasing & Disposal Costs

This section describes the entry of marketing, leasing and disposal costs.

Click  onto the Detail View button to open up the Detail Editor for Marketing, Leasing Agent Fees, 
Leasing Legal Fees, Sales Agent Fee and Sales Legal Fee.

Note: Please see “Editing Data” on page 94 for further details of the common controls in this 
editor.

Marketing
The Marketing cost can be placed as a single amount at the beginning of the leasing stage defined 
in the timescale.

Please see “Editing Data” on page 94 for further details of the common controls in this editor.

Leasing Costs
Enter the Leasing Cost and Legal Fees as a Rate on Leasing (% of Rent), fixed amount, rate per 
square foot/meter or as an amount per unit. Also, please see “Leasing Commission Profiles” on 
page 47 for more specific treatment of leasing costs on a tenant basis.

The Leasing Cost and Legal fees will normally be placed as single amounts at the start of the Sale 
stage defined in the timescale. If the Fees are entered as percentage values, their timing will follow 
that of the rental items to which they relate.

The Leasing Fees are, by default, always related to all rental items defined in the Area Schedule. 
When you save the Area Schedule,  ARGUS Developer checks the number of rental area 
definitions and updates the Leasing Fees relation. You can select which rental items the fees apply 
to by clicking on the Selection control and checking the appropriate boxes in the Include column.

Please see “Editing Data” on page 94 for further details of the common controls in this editor.
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Purchaser’s Costs
Purchaser’s Costs, when entered as a related percentage, are normally related to Capitalized Rent. 
You can choose to include Non-Capitalized Sales in the calculation. To do this, click on the 
Assumptions button on the main toolbar and check the box Apply to Unit Sales under the 
Expenditure Tab.

Purchaser’s Costs will normally be placed as a single amount at the start of the Sale stage defined 
in the timescale. If the cost is entered as a percentage value, its timing will follow that of the items 
to which it is related.

Purchaser’s Costs defined as a related percentage are, by default, related to all items defined in the 
Capitalized Rent form. When you save and exit from the Capitalized Rent form, ARGUS 
Developer checks the number of rental area definitions and updates the Purchaser’s Costs relation.

Sales Fees
Enter the Sales Agent and Legal fees as a percentage of total Capitalized Rent, fixed amount, rate 
per square foot/meter or as an amount per unit.

If the Fees are entered as percentage values (the default), their timing will follow that of the items 
to which they are related. The other choices available for calculating Sales Agent and Legal Fees 
will by default be placed as a single amount at the start of the Sale stage defined in the timescale.

The Sales Fees are related by default to the following items:

• Unit Sales from the Sales Schedule;

• Capitalized Rents from the Rent Schedule;

• Purchaser’s Costs, if required to be calculated on the Net Development Value;

• Capitalized Rent Additions and Costs.

When you save either of the Rent Area Schedule, Sales Area Schedule or Additional Rent/Costs 
Schedule, ARGUS Developer automatically checks for any new additions or deleted records and 
updates the Sales Fees relation. 

Note: If you have selected the Override Default Relations check box, the Sales Fee relation 
will not be updated.
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CHAPTER 10
Additional Data

This section describes the entry of any additional Revenues, Costs and Fees that are not included on 
the Definition screen. They can occur at any time during the project and are not tied to any stage of 
development.

Additional Fees
The additional fee is normally entered as a fixed amount. This will be placed as a single amount at 
the beginning of the purchase stage defined in the timescale.

Additional fees can also be entered as related percentage fees, rate per floor area/unit, and so on.

Click onto the Detail View button to open up the Detail Editor for Additional Fees:

Please see “Editing Data” on page 94 for further details of the common controls in this editor.

Dev. Management Fee
This fee is typically entered as a percentage related fee. You must decide upon which costs the fee 
will be calculated.

To do this, click on the Detail View button to open up the Detail Editor for Dev. Management Fee:

Click on the Selection control. If the Dev. Management Fee is entered as a percentage value, its 
timing will follow that of the items to which it is related.

The Dev. Management Fee can also be defined on other bases including as a fixed amount, rate per 
floor area/unit and so on.

Please see “Editing Data” on page 94 for further details of the common controls in this editor.
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Rent Review Fees
Rent Review fees can be entered as a percentage when the Tenant’s Rental Income Stream mode is 

active. If (during the Income Flow stage) the property is subject to reviews, the program will 

calculate fees based on the net rent achieved (inclusive of rental growth). As a related cost, its 

timing will follow that of the items to which it is related.

Rent review fees can also be entered as a fixed amount, rate per square foot or meter, an amount per 

unit, or other options - and will normally be placed as a single amount at the start of the Income 

Flow stage defined in the timescale. To change the timing, double-click in the Cost field to open up 

the detailed definition screen and select the Timing control.

Please see “Editing Data” on page 94 for further details of the common controls in this editor.

Additional Revenue
Any miscellaneous income streams can be entered into the Additional Revenue Schedule.

Click on the Additional Revenue button to view the schedule.

Enter a heading for the item and press the Enter key. Move to each of the periods where the income 

is receivable, enter the amount and press the Enter key.

Please see “Editing Data” on page 94 for further details of the common controls in this editor.
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In addition to these common controls, you will see the following control:

Period display
You can define how the data columns are displayed by choosing the appropriate setting from the 
drop-down in the toolbar.

Additional Costs
Any miscellaneous costs may be entered using the Additional Costs schedule. The use of this 
schedule is as described in the Additional Revenue section above.

The Additional Costs schedule differs from the Additional Revenue schedule in one respect. Where 
costs are required to offset some of the revenue and are to be shown in the Realization section of 
the Project Pro Forma, you will need to change the item’s sign.

To change the sign of an item, click on the Show All Columns button to reveal the extra fields for 
GST Rate, GST Recovery Rate and Cost Type.  Click on the Cost Type drop-down list and select 
“Cost Reducing Revenue”. To confirm the change, click on the OK button.

Additional Related
Any miscellaneous related items may be entered using this schedule. It is possible to define second 
sets of Sales Fees, Grants and Geared Ground Leases on this schedule.

Please see “Editing Data” on page 94 for further details of the common controls in this editor.

To create a new related cost or receipt:

Type the name into the heading cell. The heading will appear in the Cash Flow and Project Pro 
Forma and on reports.

Select a category. The Category determines where the cost/receipt will appear on the Project Pro 
Forma.

Enter the percentage relation.

Select the type of Cost or Receipt. This field will be updated automatically after the Category has 
been chosen, but you may amend it at any time.

Choose whether you wish to relate the percentage to grown or ungrown amounts by checking/
unchecking the box.

Next, move to the Relation Browser and select the items to which the cost/receipt will be related. 
You can use either the mouse or the keyboard for selection.
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Rent Additions/Costs
You can add unlimited rows of data for either costs or revenues. The value, depending on whether a 
cost or a revenue, will be deducted or added to the investment valuation.

To Do this
Use the mouse To relate to a single item, click its heading 

once with the left button.
Use the keyboard To relate to a single item, move onto its 

heading using the up/down arrow keys and 
press the space bar.

To Do this

Add/Delete new rows. Use the Plus and Minus buttons.
Change Cost or Revenue. Click in box and select from drop-down.
Change Type. Click drop-down and choose from one of 

several options:

1. Fixed Amount/Unit/Year;

2. Fixed Amount/Area/Year;

3. Amt/m2/yr x Net Area (or, if Imperial, 
Amt/ft2/yr x Net Area);

4. Amt/m2/yr x Gross Area (or, if Imperial, 
Amt/ft2/yr x Gross Area);

5. Amt/m2/yr x Alternate Area (or, if 
Imperial, Amt/ft2/yr x Alternate Area);

6. % of Base Rent;

7. % of Gross Rent (this includes Base Rent, 
plus all other Rent Addition items related 
to this area record, except for other % of 
Gross Rent items).

Enter Amount. Type in the amount for the cost or revenue into 
the Amount field.

Apply to different area/units from the area 
schedule.

Click into Selection and apply to a tenant.

Apply escalation to rows. Click into Escalation field and select from 
menu of escalation sets (previously defined).

Apply private or tenant capitalization rate. Click into Capitalization field and choose 
either Private Rate or Tenant Rate. If 
choosing Private, enter rate to the right of 
box.

If you do not wish to capitalize the rent 
addition/cost, select No Capitalization.
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Please see “Editing Data” on page 94 for further details of the common controls in this editor.

Sales Additions/Costs
You can add unlimited rows of data for either costs or revenues. The value, depending on whether it 
is a cost or a revenue, will be deducted or added to the sales valuation.

The use of this schedule is as described in the Rent Additions/Costs section above.

Please see “Editing Data” on page 94 for further details of the common controls in this editor.

Developer’s Profit
You can include an allowance for Developer’s Profit, as a cost to the project.

To Do this

Add/Delete new rows. Use the Plus and Minus buttons.
Change Cost or Revenue. Click in box and select from drop-down.
Change Type. Click in field and choose from one of 4 

options:

1. Fixed Amount/Unit;

2. Amt x Net Area;

3. Amt x Gross Area;

4. Amt x Alternate Area.
Enter Amount. Type in the amount for the cost or revenue into 

the Amount field.
Apply to different area/units from the area 
schedule.

Click into Selection and apply to a tenant.

Apply inflation/escalation to rows. Click into Inflation or Escalation field and 
select from menu of escalation sets 
(previously defined).
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Select Developer’s Profit from the Definition menu. This opens the Developer’s Profit dialog:

Enter the Developer’s Profit as a percentage of the Net Development Value, then click OK.

An additional row will be added to the cash flow displaying this item.
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CHAPTER 11
Structured Finance

ARGUS Developer’s Structured Finance Module allows you to quickly model the finance 
component of real estate projects or portions of projects you have created in ARGUS Developer. 
An unlimited number of project participants and loans can be set up in the Structured Finance 
Module.

The Structured Finance Module takes the project cash flow and creates a Finance cash flow based 
on the ordered contributions, repayments and profit distribution of the funding sources.

The Structured Finance Module offers the following capabilities:

1. Creation of multiple Sources of Funds from:

• Individual Lender(s);

• Individual Equity Participant(s).

2. Mortgage takeout financing:

• Selection of income stabilization date;

• Calculates maximum mortgage available based on project income;

• Calculates debt service ratio.

3. Powerful profit distribution capabilities:

• Percentage distributions;

• Waterfall distributions;

• Fixed amount distributions;

• Performance measures;

• Preferred return calculations, IRR lookback and Promote interests.

4. Creation of a Finance cash flow for the project that shows contributions, repayments and profit 
participation for each Finance Source, based upon the project cash flow and the finance 
structuring assumptions made in the Finance Module.

5. Fine-tuning the cash requirements (“Contributions”) and receipts (“Repayments”) for each 
individual Source of funds through the “Timed Contributions” and “Timed Repayment” features 
in the Finance cash flow. This feature allows you to time project contributions and repayments, 
in addition to the “Auto” generated Contributions and Repayments that are generated by 
ARGUS Developer, based on the project’s costs and revenues.

6. The Finance cash flow has a Balancing Account that acts as an overdraft account if you specify 
contribution limits for equity or debt - this shows the amount of finance shortfall in the project.

7. Balances between equity partners and loans can be transferred which allows inter-partner and 
inter-loan payments and repayments - for example, a construction loan can take over the 
balance of pre-development costs from an equity partner. Formerly called Timed Finance 
Events Transactions, these are now referred to as Inter-Source Transactions and are structured 
for easier setup and maintenance. See “Assumptions Setup: Inter-Source Transactions Tab” on 
page 148.
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ARGUS Developer's Structured Finance Module offers the following 
features:
1. It is an integral part of the software, so that changes to Project cash flows and results are instantly 

reflected in all elements of the Finance calculations.

2. It provides an extremely fast way to model deal structures that include multiple Equity Sources, 
multiple Loans during construction, and long-term (takeout) amortizing Mortgages.

3. Each Participant (whether an Equity Source of Funds or a Loan) in a Project has the following 
Contribution elements that can be set by the user:

• Order of Contribution;

• Contribution as a percentage of Total Cost;

• Fixed Contribution Amount;

• Maximum Contribution Amount;

• Timed Contribution amounts at specific dates.

4. Each Participant (whether an Equity Source of Funds or a Loan) in a Project has the following 
Repayment elements that can be set by the user:

• Order of repayment;

• Timed repayment amounts at specific dates;

• For both Equity and Debt Sources, timed repayments of Profit at specific dates - this provides 
accurate simulation of Preferred returns;

• Control over the first date at which Repayments of any kind (of original Contributions or Profit 
that is automatically calculated) are paid for any Source.

5. A conventional amortizing Mortgage loan can be set up for the project. A mortgage can be 
defined with a variety of parameters for calculation of amount, interest compounding frequency, 
or amortization period. For more information see “Assumptions Setup: Mortgage Tab” on 
page 153.

Structured Finance Module: Assumptions Setup

If the Structured Finance Module has not been enabled for a project data file, click on the 
Assumptions button on the main ARGUS Developer toolbar.

Then select the Finance tab on the dialog as shown below and select Structured Financing. The 
Basic (Interest Sets) option is the traditional single-source financing module.

Note that, once you select the Finance option, the options related to Basic Finance are grayed out 
(disabled) on the Assumptions, Finance screen as shown below.



Chapter 11:  Structured Finance 137

ARGUS Developer version 4.05 Reference Manual

To enter the Setup area for the Finance module:

Once you have selected Structured Financing, the Finance Detail button becomes active.

Click the Finance Detail button and the main Setup area for defining Finance will appear.

Note that once the Structured Finance mode is activated, a shortcut button on the main toolbar also 
becomes active, as shown below. This also opens the Finance Setup form:

Assumptions Setup: Sources Tab
When you access the Finance Setup area, the Sources window appears.

On this page, you can create any number of Sources to participate in a Finance definition. Within 
the context of ARGUS Developer, “Sources” include:

Equity Sources - provide funds to the project and typically participate in profit distribution. Equity 
Sources often have various preferred return profit distribution options.

Debt Sources - provide funds to the project in the form of interest bearing loans. Typically are 
repaid with the return of loan principal and accrued interest but also can participate in Profits.

Balancing Account - this is a default Source which is always part of a Finance definition. The 
Balancing Account is used to provide money to a project when all the money from other Sources is 
spent.
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The Balancing Account is also the holder of any undistributed Profit during the Project.

When you enter Sources of Funds you only need to set up each Source once even if the source has 
multiple contributions or levels of profit participation.

The controls on the toolbar are:

Click this button to preview or print a copy of the Funding Source Cash Flow report. This report 
contains a summary of all the funding sources.

Click to add a new Source which can then be named. For each Source, select the type (either Equity 
or Debt) with the drop-down selector. This type selection is used to separate interest paid to equity 
and debt on the Project Pro Forma.

Click to delete the currently highlighted Source. You are requested to confirm this action before 
proceeding.

Click the up and down arrows to re-order Sources in the list.

Assumptions Setup: Financing Tab
The individual columns in the screen below are grouped into several main categories, left to right:

• Sources;

• Contributions;

• Finance Costs.
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Sources Category:

Heading Type Description
Source of Funds Text: drop-down 

selector
Available choices are from the Sources 
tab, as explained above.

This identifies the Source on screens & 
reports. Note that the Balancing Account is 
always entered for you and cannot be 
removed - it is a necessary part of the 
analysis and always appears on the last 
line.

Each Source listed in the Sources tab can 
be referred to more than once in the 
Financing and Profit Distribution tabs, 
depending upon the Contribution, 
Repayment and Profit allocations of your 
current Project. Each line in this column 
must have a Source attached.

Source Type Text This is the Source Type - either Debt or 
Equity as defined in the Sources tab.
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Contributions Category:

Heading Type Description
Order Integer The order in which each Source 

contributes to the project. A Contribution 
Order can be shared between any number 
of Finance Sources. Individual Finance 
Sources can be referenced repeatedly in 
this list, each with a different Contribution 
Order, as required. This allows multiple 
Sources to be in the same order - for 
example, the first 20% of project costs can 
be funded by two equity sources, and the 
remaining 80% by a construction loan. 
Another term for Contribution Order is 
“Tranche”.

The Balancing Account is always the 
highest (largest) number - always the last 
Source to contribute. It will only contribute 
when the project is under-financed - in 
other words, there are more costs in the 
Project Cash Flow than Financing Sources 
contributions defined. This is an error 
condition that you must correct.

The actual timing of Contributions is 
triggered by the Project’s need for funds, 
the Contribution order of the current 
Finance Source line, and is further subject 
to any Timed Contributions entries that can 
be entered in the main Finance Cash Flow 
view that appears for each Finance Source.

Contribution % of Cost Direct entry as 
percentage

The amount to be contributed expressed as 
a percentage of total development costs, 
including Land. If other Finance Source(s) 
has/have the same Contribution Order, the 
actual amount contributed in any month 
will be split evenly between sources unless 
the Proportionate switch is checked on, in 
which case the Proportion is relative to the 
% each source is contributing within the 
current Contribution Order. You cannot 
exceed 100% in a Contribution Order.

Contribution Cap Amount If entered, this is the maximum that a 
Source will contribute when Contribution 
% of Cost is entered. 

Fixed Contribution Amount The amount the Source will contribute in 
monetary terms. If entered, cancels any % 
Contribution and Contribution Cap 
amounts.
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Earliest Contribution Date

If you select the Earliest Contribution Date control, the following timing dialog will be opened:

Contribution Shortfall 
%

Direct entry as 
percentage

This field provides a way to identify which 
Source(s) will fund Shortfall(s) in 
Contribution as the project proceeds.

See “Contribution Shortfall %” on page 
142 for further explanation of this field.

Contribution includes 
interest

Check on or off If not checked, this option adds the interest 
to the Contributions without testing to see 
if the total amount being Contributed 
exceeds the user-specified amount or 
percentage of cost. This is the default 
setting.

If checked On, includes the interest 
payable on the loan in the total amount 
contributed by the current row’s Finance 
Source. It has the effect of reducing the 
current Finance Source’s total amount 
contributed to the project by the amount of 
interest payable on the loan.

Proportionate Check on or off If On, determines the contributions for all 
Finance Sources in the current Order to be 
in proportion to one another, based upon 
the Contribution % of Cost item above. 

If Off, the amount contributed in any 
month for Finance Sources in this order 
will be split evenly between the Sources, 
irrespective of their % contributions. 
Another term for proportionate 
contributions is “Pari Passu”.

Earliest Contribution 
Date

Selection with timing 
dialog

This control opens a timing dialog (see 
“Earliest Contribution Date” on page 141), 
allowing you to specify the earliest date of 
contribution to be made by the Source.

Note: If you delay the start of Contribution 
by a Source, and other Sources have 
already fully contributed, the Balancing 
Account will have to pick up the shortfall.

If you delay the start of Contribution by a 
Source that is not the highest-ordered 
Source for Contributions, the program will 
look to the other higher-ordered Sources 
for the Contribution.

Heading Type Description
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This dialog allows you to select the timing of the earliest contribution. In addition, if a finance 
source is available for selection within the period you have specified, you may (optionally) choose 
to select it.

Contribution Shortfall %

The fields in the “Contribution Shortfall %” column provide a way to identify which Source(s) will 
fund Shortfall(s) in Contribution as the project proceeds.

A Contribution Shortfall will be funded in whole or in part by Sources that are identified as being 
contributors to a Shortfall, which could occur at any point in a Project. Shortfalls will be funded in 
the percentage amount for each Source identified as being a contributor, irrespective of their Order 
of Contribution - in other words, a Source could commence funding prior to the time it would have 
otherwise, had it not been a Shortfall Contributor.

It is not necessary to enter a total of 100% (or any % for that matter) in the “Contribution Shortfall 
%” column - thus, if a Shortfall is not 100% funded, the balance will fall to the Balancing Account.

Note: You are not permitted to provide in excess of 100% Shortfall Funding - note that the 
“Contribution Shortfall %” column cannot exceed 100%.

Shortfalls are added, with interest if specified for the Source, to the Balance of the Source and will 
be repaid in the Order of Repayment along with Auto and Manual Contributions, without 
discriminating amongst the type of Contributions.

Where there are Contribution Caps or Fixed Contributions entered, a shortfall may result.

An example of the use of this functionality is to provide for adequate funding of a Project where 
Source(s) with the highest Order(s) of Contributions have the “Contribution Inc. Interest” switch 
on. Unless other settings are made to provide for full funding (for example, the “Add Interest to 
Project” and/or “Add Fees to Project” switches), this can and typically does result in a Balancing 
Account contribution that may or may not be fully repaid prior to the end of the Project.
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Finance Costs Category:

Heading Type Description
Interest/PR Sets Text: drop-down 

selector with content 
from the Interest/PR 
Sets tab

Selects a user defined rate structure 
(defined in the Interest/PR Sets tab in this 
area) that includes the interest rate(s), and 
compounding frequency.

Note: If interest is applied to a Source, the 
interest amount is a cost to the project, 
reducing the project’s profitability. 
Preferred Returns (PR) are a distribution of 
profit that are calculated in the same 
manner as interest but are taken from the 
available profit.

Finance Fees Text: drop-down 
selector with content 
from the Finance Fees 
tab

Selects a user defined Finance Fee 
definition (defined in the Finance Fees tab) 
that includes fees and points for each loan.

Add Interest to Project Check on or off If checked On, the interest for the current 
Source will be added to the Project Cost 
exclusive of financing charges, for the 
purpose of calculating funding 
requirements.

Add Fees to Project Check on or off If checked On, the Fees for the current 
Source will be added to the Project Cost 
for the purpose of calculating funding 
requirements. This control works in a 
similar manner to “Add Interest to 
Project”.

Fees based on 
Contribution only

Check on or off Only enabled if a Finance Fee has been 
selected.

Forced to On if Add Interest to Project is 
on, otherwise selectable.

If On, the fee is based on the Source’s 
Contribution Amount which can include 
Interest and Fees if the Add Interest/Add 
Fees switches are turned on. If Off, the Fee 
is based on the Source’s Contribution 
including interest.
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Assumptions Setup: Repayments Tab
The individual columns in the screen below are grouped into several main categories, left to right:

• Sources;

• Repayments;

• Interest Repayments.

This component of the Structured Finance Module allows you to define any number of repayment 
regimes that can be applied individually to sources.

The items included for definition are as follows:

Sources Category:

Repayments Category:
Note: Repayments for each Source line must have either a) % of Funds allocated or
b) Proportionate Repayment box checked.

Heading Type Description
Source of Funds Text This identifies the Source on screens and 

reports. Note that the Balancing Account is 
always entered for you and cannot be 
removed - it is a necessary part of the 
analysis and always appears on the last 
line. Each Source listed in the Sources tab 
can be referred to more than once in the 
Financing and Profit Distribution tabs, 
depending upon the Contribution, 
Repayment and Profit allocations of your 
current Project. Each line in this column 
must have a Source attached.

Source Type Text This is the Source Type - either Debt or 
Equity as defined in the Sources tab.

Contribution Order This read-only field shows the contribution 
order that has been set on the Financing 
tab.

Heading Type Description
Order Integer: does not have 

to be unique
Repayment within the context of the 
Finance module refers to repayment of 
Contributions and Interest. It does not 
include Profit or Preferred Returns, which 
are dealt with separately in the Profit 
Distribution tab (see “Assumptions Setup: 
Profit Distribution Tab” on page 155).
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Manually Time 
Repayments

Check on or off If On, allows you to enter Timed 
Repayments for this row’s Source 
Contribution in the Finance Cash Flow 
grid.
Note: When this is on, no Auto 
Repayments are made for the current 
Source row - all Repayments must be done 
manually. 

Repayment Source Text: drop-down 
selector

This identifies the source of cash for 
repayments of capital and interest. If 
Available Cash is selected, the program 
will use all available receipts in the project 
to repay the loan. If either of Rate/Sale 
Unit or % of Sale Value is selected, the 
program will use a proportion of receipts 
for Unit Sales to repay the loan.

Note: The Rate/Sale Unit or % of Sale 
Value selections have their parameters set 
in the next entry.

Unit Sales Selection A field that displays the current number of 
Unit Sales items selected for repayment, 
based on up to three tiers of Rate and 
Units, and in the case of Rate per Unit, an 
Escalation Set. A zero entry for Upto 
(Units) means that the Rate selected will 
be applied until the Source is fully repaid. 
The Upto (Units) entry is cumulative, not 
additive.

Selecting certain options in the 
“Repayment Source” drop-down will 
make this control become active. When it 
is active, you can open a Unit Sales 
Selection window (see “Unit Sales 
Selection” on page 147).

Unlimited Repayment Check on or off This option is available when either of 
Rate/Sale Unit or % of Sale Value are 
selected. When On, the proportion of 
receipts from Unit Sales will continue to 
be paid, as profit, to the source after the 
loan has been repaid. If Off, the 
repayments will end when the loan has 
been fully repaid.

Note: Checking this box On should be 
used with caution, as it can potentially 
repay a lender (in the form of Profit) much 
more than just Capital, Interest and Fees.

Heading Type Description
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Interest Repayments Category:

Proportionate Check on or off If On, the Repayment (Contributions and 
Interest only) for all Finance Sources in 
the current Order to be in proportion to the 
Contrib. % of Cost item in the 
Contributions category. If Off, the actual 
amount of Repayment in any month for 
Finance Sources in this same order will be 
paid out evenly between sources, 
irrespective of their % Contributions.

% of Funds Available % value Enter the % of positive cash flows (if any) 
available each month to repay this 
Source’s Contributions and Interest.

Heading Type Description
Repay Interest Only Check on or off If On, the source’s interest charges are 

automatically paid by the repayment 
source as they occur. If Off, the source’s 
interest charges are repaid according to its 
Repayments Category terms.

Include Fees Check on or off If On, any fees associated with the Source 
that was being repaid will be included with 
the Interest. If Off, the fees will not be 
included.

Repayment Source Text: drop-down 
selector

The selected source in this field pays the 
Source of Funds interest if the Repay 
Interest Only check box  is On.

Repayment % % value Defines what percentage of the interest is 
repaid when the Repay Interest Only 
check box  is On.

Repayment End 
Timing

Select from a drop-
down list

This controls when the Repayment Source 
stops paying the Source of Funds interest 
when the Repay Interest Only check box  
is On. When active, this control opens a 
timing dialog (see “Other timing dialogs” 
on page 103).

Heading Type Description
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Unit Sales Selection
If you select “Rate/Sale Unit” from the Repayment Source drop-down on the Repayments tab, the 
following window will open if you select the Unit Sales Selection control:

This window allows you to define up to three tiers of Rate and Units and an Escalation Set for the 
current number of Unit Sales items selected for repayment.

A zero entry for Upto (Units) means that the Rate selected will be applied until the Source is fully 
repaid. Note that the Upto (Units) entry is cumulative, not additive.

Use the Scope drop-down to make settings for all units (“Apply to all sales areas”), or to specific 
sales areas (“Apply to selected sales areas”).

If you select “% of Sale Value” from the Repayment Source drop-down on the Repayments tab, the 
following window will open if you select the Unit Sales Selection control:

This window allows you to define up to three tiers of Rate and Units for the current number of Unit 
Sales items selected for repayment.

A zero entry for Upto (Value) means that the Rate selected will be applied until the Source is fully 
repaid.

Use the Scope drop-down to make settings for all units (“Apply to all sales areas”), or to specific 
sales areas (“Apply to selected sales areas”).
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Assumptions Setup: Inter-Source Transactions Tab

This component of the Finance Module allows you to set up a table that indicates which Source is 
repaying another Source, specifying the date and the amount (as a monetary value or percentage).

This allows you to link Sources in order to transfer amounts of money between them.

The timing of the payments is controlled by selection of stages of development, and the use of 
other timing triggers such as loan start dates, in addition to fixed dates or periods.

Assumptions Setup: Interest/PR Sets Tab

This component of the Finance Module allows you to define any number of Interest rate or 
Preferred Return regimes that can be applied individually to Sources - whether Debt or Equity.

The items included for definition are as follows:

Heading Type Description
Contributing Source Select from a drop-

down list
This allows you to identify the Source 
from which funds will be transferred.

Receiving Source Select from a drop-
down list

This allows you to identify the Source that 
will receive the transferred funds from the 
Contributing Source.

Transaction Type Select from a drop-
down list

This allows you to specify whether the 
amount to be transferred will be a fixed 
monetary amount, or calculated from a 
percentage.

Amount % value or monetary 
amount

This field allows you to type in a fixed 
monetary amount or a percentage, defining 
the amount of the transaction.

Transaction Date Selection from a timing 
dialog

This timing control allows you to specify 
when the transaction takes place. This 
opens a timing dialog (see “Other timing 
dialogs” on page 103).
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Interest/PR Sets Definition

To open the screen to set up interest rates, click on the Interest/PR Sets button in the Interest/PR 
Sets tab.

This screen is also part of the main Assumptions for Calculation dialog that is accessible in the 
main work area of ARGUS Developer. You can make entries from either point of access. See 
“Interest/PR Sets Tab” on page 15 for further details.

You can define any number of rate regimes that can vary over time by using the Add icon and re-
labelling the Interest Set Name for each definition item. You can vary interest rates over time by 
specifying the rate and the number of months that each rate applies.

Click Remove Finance Rate to remove an interest rates set.

Heading Type Description
Description Text The label that refers to the definition - 

examples: Citibank Loan, or Lead Investor 
Preferred Return.

Finance Set Text: drop-down 
selector with content 
from Interest/PR Sets 
form.

Selects the Interest rate(s) (can change 
over time) that this item will apply. See 
below for an explanation of the Interest 
Rates/PR Sets setup screen.

In Advance Check on or off. If On, charges interest in the month it is 
funded. If Off, first charges interest in the 
month following the funding.

Compounding Period Select from a drop-
down list.

Choices include Monthly, Quarterly, Semi-
Annually, Annually or None (no 
compounding period, i.e. simple interest).
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Assumptions Setup: Finance Fees tab

This component of the Structured Finance Module allows you to define any number of Financing 
Fees that can be applied to Source contributions on the Financing tab of the module. The items 
included for definition for each Fee Set Name are as follows:

Standard Fees Category

Heading Type Description
Fee Set Name Text - direct input by 

user
The label that refers to the definition - 
examples: National Bank Loan Fee, or 
Lead Investor Fees

Heading Text as shown above; 
not editable

Each item defined in the Fee Set Name 
field above is set up by default to be a 
choice of two Fixed Amount Fees and two 
Related Fees. However, the fee type for 
each line can be changed if, for example, 
three related fees were required.

Fee Type Select from a drop-
down list

Allows the selection of a categorization 
type for the fee (can be an entered amount, 
or related to the loan amount). Choices are 
Fixed and Related.

Fee Basis Select from a drop-
down list

Only applies to Related Fee items.
Choices are:

1) Drawn Amount (the actual calculated 
amount of the loan plus interest), or 
2) Fixed Loan Amount (manually entered 
in the next column to the right).
3) Undrawn Amount (where the loan 
amount is not used - calculates an amount 
even when there are no draws on a loan). 
This option is only available if you have 
the “Show Undrawn Loan Fees” option 
checked in the System Administration 
settings - see “Country” on page 257.

Fixed Amount Amount Only applies to Fixed Amount items.
% Amount Percent input Only applies to Related Fee items.
Fixed Loan Amount Amount Only applies if Fee Type selection is set to 

Related Fee. A manually entered amount 
on which the fee may be calculated.

Charging Period Select from a drop-
down list

The default is “Single”. Other options are 
Monthly, Quarterly, Semi-Annually, or  
Annually.
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Undrawn Fees Category

These options only become visible if you check the Show Undrawn Loan Fees option in the 
System Configuration window (see “Country” on page 257).

Assumptions Setup: General Tab
The General tab allows you to specify a variety of parameters as shown below:

Project Cash Reserve The Project Cash Reserve is an amount held back from receipts for payment 
of any substantial costs that occur after income from leases starts to flow or sales come on line. The 
Project Cash Reserve is funded from Project Receipts, after debt and equity sources have been 
repaid.

Reserve account rules The reserve account serves the following purposes:

Start Date Specify with a timing 
dialog

Allows you to specify a start date for the 
finance fee. This opens a timing dialog 
similar to the one described in “Other 
timing dialogs” on page 103.

End Date Specify with a timing 
dialog

Allows you to specify an end date for the 
finance fee. This opens a timing dialog 
similar to the one described in “Other 
timing dialogs” on page 103.

Heading Type Description
In Advance Check box Allows you to specify whether any 

undrawn fees will be charged in arrears (if 
the box is not checked) or in advance (if 
the box is checked). Whether any charge 
will be made is determined by the setting 
you make in the Charge if Undrawn 
check box.

Becomes available if the “Undrawn 
Amount” option is selected from the Fee 
Basis drop-down.

Charge if Undrawn Check box Allows you to specify whether or not there 
is a charge if the loan is undrawn.

Becomes available if the “Undrawn 
Amount” option is selected from the Fee 
Basis drop-down.

Heading Type Description
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1. A reserve for cash in the early stages of the project where equity contributions are manually 
timed at the start of a project rather than automatically drawn when the cash is required.  The 
reserve account works in conjunction with the “earliest capital / profit” distribution switch on the 
general tab which prevents capital and profit from being distributed in the early stages of the 
project where there is excess cash.
If equity contributions, manually timed at the start of the project, are greater than the cash 
required in the month in which they are contributed and there are no debt sources to repay, the 
funds will flow into the reserve account without limit. The reserve will then be drawn down to 
fund project costs as required in advance of equity or debt sources.

2. An overdraft account to cover costs after all financing sources have reached their limit. The 
reserve account will be drawn prior to the balancing account to cover financing shortfalls. The 
reserve amount will be built up to the amount entered on the General Tab after all debt and 
equity partners have been repaid.

3. An operating or warranty fund to be consumed when necessary and released at the end of the 
project. The reserve will be drawn upon as necessary and rebuilt when funds are available after 
all debt and equity partners have been repaid.

In all cases, the reserve account will be released at the end of the project cash flow to repay any 
outstanding equity or debt, or as profit.

It is possible that the Project Cash Reserve can exceed the stated limit due to:

• Over-funding of a project due to Timed (user-defined as of a date) Contributions from either 
Debt or Equity Sources; or

• The Earliest Capital/Profit Distribution Month is set to hold back positive cash flow from the 
Project for a period of months.

At the end of the Project, any balance in the Project Cash Reserve is distributed to the Sources as 
profit distribution.

After Debt and Equity Sources have been repaid, any further receipts will be used to build up the 
cash Reserve if a Reserve amount has been set up. When the amount in the cash Reserve reaches 
the amount entered into the Project Cash Reserve field, any surplus receipts are then available as 
profits for distribution.

Stabilized Income Month for Ratio Analysis This is used to establish a point in time (a month) 
for calculating the Initial Yield in projects that do not take out a Mortgage. This date is used for the 
Development Yield ratio calculation. Note that this date can be set on, or relative to, a Phase Stage 
date using the standard controls for date selection that appear throughout the program.

Earliest Capital/Profit Distribution Month Number of months from the Project Start Date before 
any Repayment of original Contributions and Interest (if any) and /or Profit will be distributed to 
Equity Sources, or Loan Sources if they are flagged as “Participating” in the Finance Source tab.

Note: This setting is ignored by Timed Profit Payments as described in the Finance Cash 
Flow section of this chapter (see “Finance Module: Cash Flow View” on page 159).

If the Project generates revenue prior to the Earliest Capital/Profit Distribution Month, the money is 
held by the Balancing Account until such time as the program allows Capital/Profit Distribution. 
Note that this date can be set on or relative to a Phase/Stage date using the standard controls for 
date selection that appear throughout the program.

Repay Outstanding Loans from Balancing Account at end of Project This option is used to 
determine whether any loans that remain outstanding at the end of the cashflow will be repaid from 
the Balancing Account. If On, the Balancing Account will make a contribution to the loan that will 
repay all outstanding capital + interest + loan fees. This will appear as an Auto Contribution in the 
source loan’s cash flow. If Off, any loan that has not been repaid will remain unpaid and the cash 
flow may show a deficit.

Use Net Source Contributions and Repayments in Finance Cash Flow This option, when On, 
will use any receipts from rent, unit sales or other sources to offset project costs before drawing on 
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financing sources for contributions. It is an internal source of financing. When Off, the financing 
sources will contribute to project costs, then the receipts will be used to repay the sources. This 
could have the effect of both drawing on and repaying a loan in the same period.

Inter-Source Transactions calculated before Auto-Contributions This option, when On, permits 
the calculation of inter-source transactions before auto-contributions. When Off, the calculation of 
inter-source transactions occurs after auto-contributions. See also “Assumptions Setup: Inter-
Source Transactions Tab” on page 148.

Display Project-Funded information lines (italicized) in Finance Cash Flow This option, when 
On, will show additional information rows in the Finance Cash Flow for each Source that has its 
interest or fees funded by the project. The data in these rows will be italicized. When checked Off, 
these rows will not be displayed in the Finance Cash Flow.

Assumptions Setup: Mortgage Tab
For developments with income-generating leases that are held for a period after completion of 
construction, a Mortgage can be taken out to repay Sources that have funded the development.

The Mortgage debt servicing (principal and interest) can be funded from the monthly net operating 
income. When the property is sold, the Mortgage is paid off from the proceeds of the sale.

The amount of the mortgage can be based on the Net Operating Income from the property or can be 
set by the user. When the property’s income is deemed to be stable, capitalization of the income is 
calculated at a single capitalization rate to determine the value of the property for mortgage 
financing. This does not affect Project-level cash flows or values. To calculate the maximum 
funding amount, the capitalized amount is multiplied by the Loan to Value % (shown as the 
Mortgage Amount as % of Value entry below).

Mortgage Active for this Scenario This is an on/off button that enables or disables the Mortgage 
(long-term amortizing debt) within the Finance module. If you check this on, the options below it 
are enabled.

Heading Description
Month to place 
mortgage

This date selection field is used for two purposes:

1. To determine the monthly net operating income from the project 
when income is stabilized

2. To place the start of the Mortgage in the financing cash flow
Monthly stabilized 
income

This non-editable, read-only field shows the net operating income 
from the development cash flow in the month chosen in the Month to 
Place Mortgage selector above.
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Annual stabilized 
income

This is the Monthly Stabilized Income multiplied by 12 - the value is 
not editable.

Manual stabilized 
income (annual)

This field can be used to override the Annual Stabilized Income 
amount - this allows users to set the mortgage amount above the 
amount that would be income based. When the value of this field is 
other than zero, the program uses this amount in the Mortgage amount 
calculation. When the value is zero, the program uses the value in the 
Annual Stabilized Income field above for the mortgage amount 
calculation.

Mortgage amount as % 
of value

Also referred to as Loan to Ratio Value. This is the relationship 
between the amount the lender will lend, and the value of the 
property. 

Cap Rate The cap rate is used to capitalize the Annual Stabilized Income or 
Manual Stabilized Income, whichever has been chosen above, to 
determine the property value for the mortgage. It does not affect the 
capitalized value of leases in the main Project analysis area of 
ARGUS Developer.

Project Cap Rate Value This is the capitalized Annual Stabilized Income or Manual Stabilized 
Income, whichever has been chosen above.

Maximum Funding 
Amount

This is the Project Cap Rate Value multiplied by the Mortgage 
Amount as % of Value.

Mortgage Issued You can use this field to override the Maximum Funding Amount, and 
take out a different principal amount Mortgage on the property up to 
the maximum funding amount. When this field is left at zero, the 
program uses the Maximum Funding Amount value.

Amortization Period This is the number of months over which the Mortgage would be fully 
amortized.

Annual Interest Rate This is the stated annual rate of interest charged on the Mortgage by 
the lender.

Compounding 
Frequency

This used in the calculation of the Monthly Interest Factor. Monthly is 
the standard choice for the USA, Semi-Annual in Canada.

Monthly (DS) Principal 
and Interest

This calculated field shows the monthly amount (Principal and 
Interest) repayable to the Mortgage lender.

Annual (DS) Principal 
and Interest

This shows the annual amount repayable to the Mortgage lender.

Debt Service Ratio This shows the ratio of net operating income to annual Mortgage 
repayment. The higher the ratio, the better able the project is able to 
service the debt. 

A ratio of 1.0 would be a break-even situation where the net operating 
income is just enough to cover the Mortgage payments. Most 
mortgage lenders would have a minimum ratio of more than 1.0.

% Finance Fee This is a percentage of the “Maximum funding amount” or “Mortgage 
Issued” values in the Mortgage Value section (Mortgage Issued is an 
override).

Fixed Finance Fee A monetary amount that is in addition to the amount specified in the 
“% Finance Fee” field.

Heading Description
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Assumptions Setup: Profit Distribution Tab
This screen defines the key elements of profit-related distributions to the various Sources of funds 
that have invested in a project.

Profit distributions can range from being very simple to very complex. The simplest distribution 
would be one Source receiving all profits - this requires only one line of profit distribution. Another 
simple structure would be two Sources splitting profits on a percentage basis.

ARGUS Developer allows the set up of unlimited numbers of distributions between Sources. The 
Profit Distribution tab allows profits to be distributed in flexible orders (also called waterfalls) - 
the results of which are easily followed in the Finance Cash flow.

Note: You may need to install the Advanced Finance module in order to obtain this 
“waterfall” feature.

The following table describes the set up of profit distribution:

Add total fees to 
mortgage issued

This is an on/off setting to specify whether to add the total fees to the 
mortgage issued.

If checked (ON), the full amount of the mortgage is funded and 
received by the relevant Source, but the opening balance of the 
Mortgage is increased by the amount of the fees. This will result in 
higher mortgage payments and interest compared with the unchecked 
option.

If this option is left unchecked (OFF), the total fees entered will be 
deducted from the proceeds of the mortgage that is actually received 
by the relevant Sources (usually the primary debt Sources).

Heading Type Description
Source of Funds Text; non-editable 

drop-down list
Select from the list of Sources in the 
Sources tab at left of window. Each line 
must have a Source.

Source Type Text Displays the type (either Debt or Equity) of 
Source for the current line, as defined in 
the Sources tab.

Order Integer Order refers to the priority in which the 
various Sources receive Profit 
distributions. Multiple Sources can be in an 
Order - if there are a number of orders in a 
profit distribution they could be referred to 
as “Waterfalls” or “Tranches” of profit 
distribution.

Heading Description



156 Chapter 11: Structured Finance

ARGUS Developer version 4.05 Reference Manual

Profit Distribution 
Type

Text: non-editable 
drop-down list

Choices are:

1. Preferred Return

If you have the Advanced Finance module, 
you will also have the following options 
available to you:

2. Profit Amount

3. IRR Lookback

4. IRR Lookback at Sale Date

5. Promote

6. Residual Percentage.

Note: You cannot mix Profit Distribution 
Types within the same Profit 
Distribution Order except IRR 
Lookback and Promote.

For important rules about the application of 
the above choices please see “Profit 
Distribution Types” on page 157.

Preferred Return 
included in IRR 
Lookback

Check box This setting only applies if the Preferred 
Return option is selected in the Profit 
Distribution Type drop-down.

If you check this check box, the Preferred 
Return will be included in the IRR 
Lookback. If unchecked, the IRR 
Lookback return is on top of the Preferred 
Return.

Fixed Amount Amount Allows an order with a fixed profit amount 
distribution. This applies if Profit Amount 
is selected in the Profit Distribution Type 
field.

Percentage Split % value Only applies if Residual Percentage is 
selected in the Profit Distribution Type 
field. This is the percentage of profit to be 
distributed to the Source.

IRR Lookback 
percentage

% value This setting only applies if IRR Lookback 
or IRR Lookback at Sale Date is selected 
in the Profit Distribution Type drop-down.

% Allocation of Funds 
in Order

% value Refers to the % of funds this Source will 
receive towards its current row definition 
Profit, within the current Order. Applies to 
all Profit Distribution Types except 
Preferred Return and Residual Percentage.

Interest/PR Sets Text; non-editable 
drop-down list

This setting only applies if the Preferred 
Return option is selected in the Profit 
Distribution Type drop-down. Available 
choices are from the entries made in the 
Interest/PR Sets tab.

Heading Type Description
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Profit Distribution Types
Below is an explanation of the terms used in the Profit Distribution Type field above:

Preferred Return - calculated like interest based on the balance of capital over time, it is treated as 

a distribution of Profit. When funds are available, they are applied to the accrued balance of 

Preferred Returns outstanding first, then to the outstanding capital balance (the return of 

contributed capital is called Repayment). Preferred Return types must be in the lowest numbered 

Profit Order and not mixed with other types.

Preferred Returns cannot be attached to any Source of Funds shown in the Profit Distribution tab 

for which there is an Interest/PR Set defined in the Finance tab.

Profit Amount - a fixed amount of profit to be distributed.

IRR Lookback - pays funds to a financing Source until the target IRR is achieved, evaluated on a 

monthly basis from available cash flow. The target IRR cannot decrease for the same Source of 

Funds as the Profit Order number increases.

IRR Lookback at Sale Date - pays funds to a financing Source at sale date.

Promote - a Promote profit distribution is allocated the last available percentage of funds in a 

Profit Order in conjunction with an IRR Lookback Source. A Promote is paid indefinitely until the 

IRR Lookback is fully paid. This is the only way in which a Promote can be used. Thus, a Promote 

cannot be the only Profit type with a Profit Order - it must be entered in conjunction with an IRR 

Lookback. It is permitted to have more than one Source that has a Promote within an IRR 

Lookback Order.

Residual Percentage - the final waterfall of distribution, this is the remaining profit to be 

distributed in a project. The Residual Percentage type can only be associated with the highest Profit 

Order number. The total percentage payable to all Residual entries within the highest Order should 

not exceed 100%.

Assumptions Setup: Performance Measures Tab
The Performance Measures tab is a display of the returns for each Source in a Project, based on the 

currently active Phase/Group of Phases. The basic screen appears below.

This view is a static, non-editable view of the current status of each Source, including the 

Balancing Account. If the Balancing Source is not showing zero contributions and/or profit, you 

should investigate the status of your other Sources, as positive or negative balances in the 

Balancing Account tends to indicate incomplete Profit distribution or under-funding of the project.

Include Loan Fees Check box This setting only applies if the Preferred 
Return option is selected in the Profit 
Distribution Type drop-down.

If you check this check box, the loan fees 
calculated on a Source’s contributions will 
be included in the cash flow used for 
calculating the Preferred Return.

Heading Type Description



158 Chapter 11: Structured Finance

ARGUS Developer version 4.05 Reference Manual

The values are updated automatically when you change a field on any of the other tabs.

You can print a report showing the screen contents using the Print Preview icon on the left side of 
the screen.

Heading Type Description
Source of Funds Text Based on the status of entries made in the 

Sources and other tabs in this dialog.
Auto contribution Amount The total amount of money contributed to 

the Project by a Source, excluding any 
Timed (manually entered) Contributions.

Timed contribution Amount This is the total amount of money 
contributed to the Project by a Source per 
the Timed Contribution entries in the Cash 
Flow view.

Total contribution Amount This is the total of the Auto and Timed 
Contributions for each Source.

Balance Outstanding at 
Project End

Amount Amount of contributions not repaid by the 
end of the project.

Interest Amount The amount of Interest attributable to the 
Source.

Fees Amount The amount of Fees attributable to the 
Source.

Preferred Return Amount The amount of the preferred return profit 
distributed to the source.

Profit Amount The amount of profit that is distributed to 
this Source during the course of the 
Project. It includes any Cash Reserve that 
is distributed at the end of the Project.
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Finance Module: Cash Flow View
Once you have entered your Finance Assumptions, you can view the results in the Cash Flow area 
of the program. This area shows you the results in a timed cash flow, compared with the snapshot 
view in the Performance Measures area tab in the Finance Setup. Reports of the Cash Flow can be 
previewed and printed from the Reports area of the program (see “Reporting Structured Finance” 
on page 169.)

To access the Finance Cash Flow view, go into the main workspace of ARGUS Developer and 
select the Cash Flow tab, then the Finance Cash Flow button. Note, however, that the “Structured 
Financing” mode must be selected for the Finance Sources cash flow to display. If the “Basic 
(Interest Sets)” mode is active, Structured Finance Cash flow details will not display.

Click Finance Cash Flow on the cash flow page. This will reveal the Project Cash Flow, Debt 
Source(s), Equity Source(s), Mortgage (if applicable), Balancing Account and the Combined 
Sources.

Total Interest, Fees, 
Preferred Return & 
Profit

Amount The total of Interest, Fees, Preferred 
Return and Profit for each Source.

Peak Financing Amount This is the maximum amount drawn on a 
loan, calculated from the Loan Balance 
line.

IRR % Percentage The Internal Rate of Return, calculated on 
a monthly basis. Interest is only included if 
the switch on the Assumptions - Finance 
tab is set to Include Interest in IRR 
Calculations.

ROE % Percentage Return on Equity. This is the Source’s 
Profit divided by their Total Contribution.

Heading Type Description
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The Finance Cash Flow view provides a detailed breakdown of each Finance Source over the life 
of the Project. Options in this area that you can select on the lower toolbar area include the 
following:

Click to expand all cash flows.

Click to collapse all cash flows.

Cash Flow View Cycle - choices of Monthly, Quarterly, Half Yearly and Annually.

Show Timed Finance Rows - check/uncheck this option to display/hide the Timed Finance Rows.

View Order - select from the following:

• Show Detailed Cash Flows in Contribution Order - this view provides a more detailed 
breakdown than the Consolidated view;

• Show Consolidated Profit & Source Cash Flows;

• Show Profit by Distribution Order, then Detail.

Group Lines
The Project level view is always shown as the first group in the Finance Cash Flow.

Each Source then has a grouping line which will display basic assumptions and performance 
measures:

IRR The IRR is based on the “Net Cash Flow (IRR)” line (second from the bottom).
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ROE (Return on Equity) Total Returns divided by total Contributions.

In # Refers to the order of Contribution (1 is first, 2 is next, and so on) and the percentage of Cost 
Contribution.

Out # Refers to the Order of Repayment; noting that the Balancing Account is always repaid first. 
Within both Equity and Debt sources, you can specify them with the same (or different) Order 
number.

Debt Funding Source
This source type (Debt) only appears if you have defined a Debt funding source; one such Group 
view will appear for each defined Debt source of finance.

Timed Contributions These are “spot” figures you enter in a specific period in the Cash Flow 
view (monthly only). When a Timed Contribution is entered, no automatic contribution will be 
calculated in the same period. If the Cash Flow does not require the full amount entered, the excess 
is added to the Reserve Account in the Project Cash Flow as a receipt, and will be distributed back 
to the Sources according to their definitions.

Auto. ContributionsThese are contributions calculated by the program from the cash requirement 
in any period, and are defined in the main Finance Setup area. At the outset of the project time 
frame, the Source may have committed an amount representing its Contribution to the project. The 
program will spend this as and when required, until the balance is reduced to zero.

Total Contributions The total of Timed and Auto Contributions.

Loan Fees Fixed amount, % and Total loan fees. Please see “Assumptions Setup: Finance Fees 
tab” on page 150 for Loan Fee information.

Interest and Fees The total amount of interest accumulated by the Partner’s loan in the period 
displayed, plus any loan fees defined.

Timed Repayments Timed Repayments refer to the date and amount specific Repayment of 
original Contributions and Interest (if any) for this Source. If there is not enough money available, 
the Balancing Account will fund any shortfall.

Auto Repayments Automatically calculated Repayment of original Contributions and Interest (if 
any) for this Source. “Repayments” specifically exclude Profit (if any).

Total Repayments Total of Timed and Auto Repayments.

Closing Balance The current period ending balance of account for this Source.

Timed Profit Participation Includes contributions/repayments/interest/profit.

Auto Profit Participation This is optional, allowing for Debt Sources that earn interest and/or a 
share of Profits; this option is defined in the main Finance Setup covered in the first section of this 
chapter.

Total Profit Participation The total of Timed and Auto Profit Participation.

Net Cash Flow (IRR)  The actual line used for the calculation of IRR.
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Cumulative Net Cash Flow Current period net position for this Source.

Equity Source
Equity sources earn their return from Repayment of their original Contributions, their share of 
available distributions from cash flow, proceeds of Sale and Proceeds of Mortgage (permanent 
financing), and any Reserve amount held by the Balancing Account at the end of the Project.

See previous notes for the Debt Source for an explanation of the line types shown above.

Mortgage

These lines display the monthly cash flows related to the mortgage.

Balancing Account

See previous notes for Debt sources for an explanation of the line types shown above.
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Combined Sources

See previous notes for Debt sources for an explanation of the line types shown above.

General Principles of the Structured Finance 
Module

Treatment of Preferred Returns
Preferred Returns are considered as a distribution of profits of a project, rather than an Interest cost. 
This means that a Preferred Return is not part of the total Project cost, as it is paid to an equity 
source - and thus results in a lower cost base for the Project than if the same amount was paid as an 
Interest cost. Accrued Preferred Returns are repaid prior to the repayment of a Source’s 
Contribution.

Repayment Order
You cannot go to the next Repayment Order # until the repayment of Sources in the current 
Repayment Order # is complete. For example: 

Repayment order 2, available cash distribution:

Partner A 20%
Partner B 10%
Construction Loan 70%

Repayment Order 3: 

Partner C 100%

If Partner A gets fully repaid but Partner B and the Construction Loan have balances outstanding, 
the intent is to finish paying off Partner B and the Construction Loan before moving onto Partner C, 
otherwise Partner C would have been included in Repayment Order 2.

The above principles apply within the context of the month-to-month calculations that ARGUS 
Developer does; therefore it is possible that a Repayment Order 3 could be repaid in the same 
month as a Repayment Order 2 from an overall (project) perspective, as long as the calculations 
were complete for Order 2 within the same month. This is further affected by the potential 
inclusion of Timed Profits.

Setup of Interest Cost and a Preferred Return for the same Source 
You cannot have an Interest cost in the Financing Tab and a Preferred Return in the Profit 
Distribution tab for the same Source of Funds (irrespective of order).
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Profit Distribution Definition
In the Profit Distribution tab, Preferred Return definition(s) must be entered as the lowest order. 
The actual order number can be any number, just as long as it is the lowest number in the order 
column.

Note: There is no connection between the order numbers that appear in the Profit 
Distribution screen and the Financing screen - they work independently.

You cannot mix Profit Distribution Types within the same Profit Distribution Order except IRR 
Lookback and Promote.

Timed Profits
Timed Profits are not permitted when Preferred Returns are selected for a Finance setup.

Repayment Orders
Debt and Equity Sources are repaid before the Project Cash Reserve is funded.

IRR Calculations
ARGUS Developer provides a number of different Internal Rate of Return (IRR) calculations. All 
IRR values are calculated on a monthly basis, with the monthly rate converted to an annual rate 
with the general formula: 1 - (1 + monthly IRR)^12. The IRR is recalculated automatically to reflect 
the currently active Phase or Group of Phases.

The Results Panel can be configured to display the following three IRR measures (right-click in the 
Results Panel to reconfigure), as shown in the following sample screenshot:

In addition to the above IRRs, there are individual IRRs calculated for each Source in a Project – 
for both Debt and Equity Sources.

The various IRRs are explained below:

Pre-Finance IRR
This IRR is the IRR that a Phase or Group of Phases would produce without regard to financing 
costs (interest) and without consideration of how the Project is funded. 

The following screenshot shows the “Net Cash Flow Pre-Finance (IRR)” line from the Finance 
Cash Flow view, which is calculated prior to the consideration of Interest and Profit.
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Combined Sources IRR
Also referred to as “Project IRR” (it is shown as Project IRR in the results bar), this is a composite 
of the monthly cash flows for all Sources (both Debt and Equity) of the following Contributions 
and Repayments over the life of the Project or Phase or Group of Phases that are currently 
activated:

Contributions:

• All Debt Sources;

• All Equity Sources.

Repayments including Interest:

• All Debt Sources;

• All Equity Sources.

All Profit Distributions (Profits include Preferred Returns):

• All Debt Sources;

• All Equity Sources.

The calculation of the Combined Sources IRR is illustrated below in the Finance Cash Flow area:

The “Total Contribution” line is the total of all Contributions from all Debt and Equity Sources. 
The “Net Cash Flow (IRR)” line is the total of all net Cash Flows for all Debt and Equity Sources.
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Equity IRR
This is the overall combined IRR (not an average) of all Equity Sources in a Project based on:

• All Equity Source Contributions;

• All Equity Source Repayments including interest, if any;

• All Equity Source Profits including Preferred Returns, if any.

The Equity IRR will typically be higher than the Combined Sources IRR, since the Equity IRR 
takes advantage of the Debt Financing, whereas the Combined Sources IRR is a composite IRR for 
all sources including the Debt Sources.

To see the individual IRR for each Equity Partner, refer to any one of the following areas:

• Finance Setup – Performance Measures;

• Finance Cash Flow view (as shown in the Combined Sources IRR explanation above);

• Report Menu – Funding Source Cash Flow report.

Timed Contributions
Timed Contributions allow you to re-distribute the timing of a Source’s Contributions to a Project – 
they do not provide for changing the actual amount of Contribution. If you require detailed control 
(instead of the “Auto” Contributions calculated by the program) over the total Contribution made 
by a Source, use either the Contribution Cap or Fixed Contribution fields in the Financing tab of 
the Finance Setup.

To enter Timed Contributions, the View Order in the Finance Cash Flow area must be set to the 
“Show Detailed Cashflows in Contribution Order” option, as shown in the screen below:

For example, the Developer’s Contribution is payable in irregular amounts as required by the 
specific needs of the Project for cash. However, if the Developer has agreed to pay a certain amount 
“up front” in the first month this can be defined as a timed contribution, with the balance of his 
contribution payable as required by the project calculated automatically by ARGUS Developer, as 
shown below.

Note that the automatically calculated “Auto. Contribution” in month one is zero, with the Timed 
Contribution: Project Amount being active. The total amount Contributed by the Developer has not 
changed from that originally calculated by ARGUS Developer.

Timed Contributions can be made for any Debt or Equity Source.
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Timed Repayments
Timed Repayments may be made in the Finance Cash Flow view in the “Show Detailed Cashflows 
in Contribution Order” view in two ways:

1. In a similar manner as for the Timed Contributions described above, where the program will 
automatically re-distribute the timing of a Source’s Repayments from the Project. In this mode, 
the program will not change the actual amount of Repayment relative to it being calculated in 
full “Auto. Repayment” mode. 

This method requires that the Manually Time Repayments check box in the Repayments tab of 
the setup area is clear (off) for the Source, as shown below:

Once this is set, you can enter “Timed Repayments” in the Cash Flow area for the Source under 
discussion.

2. With complete control over the amount and timing of Repayments. To do this, check the 
Manually Time Repayments box “on” for the Source in question in the screen above. When 
this box is checked on, the “Auto. Repayments” for the Source is disabled completely, allowing 
for (only) arbitrary and un-adjusted Repayments.

Timed Profits
Timed Profits may be entered into the Profit Distribution Cash Flow Group in the Finance Cash 
Flow.

To do this, you must first set the Finance Cash Flow view to Show Detailed Cashflows in 
Contribution Order. Then the “Profit Distribution” Group will appear and will be editable, as 
shown for a typical Source in the following screen segment:

Whenever a Timed Profit Participation is entered into a given month, then any Profit previously 
calculated automatically in that month is removed, and the total profit payable to the Source over 
the total Project will be adjusted up or down depending upon the amount entered. In other words, 
the total amount of Profit paid to the current Source will not be maintained at its originally 
calculated value prior to a Timed Profit Participation value being entered.

Timed Finance events
Note: Where Timed Finance Events are active in existing version 4 files that are upgraded to 
version 4.05, the inputs for Timed Finance Events are retained and the Timed Finance Events 
functionality retained - UNTIL you remove (zero out) all such entries.
If you remove all Timed Finance Events, this area of functionality disappears; it is no longer 
available within a file, and is replaced by the Inter-Source Transactions feature (see 
“Assumptions Setup: Inter-Source Transactions Tab” on page 148).

Timed Finance Events are manually entered finance transactions between any two Sources in a 
Project. Each matching Timed Finance Contribution and Timed Finance Repayment must occur in 
the same month.
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Note: Do not confuse Timed Finance events with Timed Contributions, Timed Repayments 

and Timed Profits, which are discussed separately in this chapter.

Transferring balances between Equity Sources and Debt Sources (Timed Finance events) allows 

inter-partner and inter-loan Contributions and Repayments. For example, a construction loan can 

take over the balance of pre-development costs from an equity partner. These transfers were 

formerly called Timed Finance Events, and are now known as Inter-Source Transactions.

To enable this feature, in the Finance Cash Flow check the Show Timed Finance Rows option, as 

shown below.

When this option is checked, two additional rows appear in each source’s cash flow and in the 

combined sources cash flow:

• Timed Contribution: Finance Transaction;

• Timed Repayment: Finance Transaction.

Note: The Show Timed Finance Rows check box is not displayed unless you are using files 

(created in an earlier version of Developer) that have Timed Finance Events set up already. If 

you do not see this check box displayed, you should use the new Inter-Source Transactions 

feature (see “Assumptions Setup: Inter-Source Transactions Tab” on page 148).

To enter Timed Finance events, the View Order must be set to the “Show Detailed Cashflows in 

Contribution Order”. The other two view order settings will display the Timed Finance events as 

entered, but they do not allow the original entry or editing of Timed Finance events.

In the example below, the Construction Loan funds 60% of project costs, in addition to repaying the 

Developer’s Equity in March 2007. The Developer’s contributions are fully complete by the end of 

February 2007, and so in the following month a Timed Repayment is made to repay the developer’s 

equity. This appears as an entry on the Timed Repayment: Finance Transaction row in the 

Developer’s cash flow, and a Timed Contribution: Finance Transaction in the Construction Loan 

cash flow, as shown below.
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The Timed Contribution: Finance Transaction entry in the Construction Loan cash flow increases 
the total contribution from this source and the total interest calculated on this contribution.

In summary, Timed Finance events allow you to simulate financial transactions between Sources 
based on the following guidelines:

• To enable this feature, you need to first check the Show Timed Finance Rows option in the 
Finance Cash Flow;

• To input the data for the Timed Finance events, the View Order setting in the Finance Cash 
Flow area must be set to “Show Detailed Cashflows in Contribution Order”;

• Each Timed Finance event must consist of a matching Contribution and Repayment, in the same 
month. Please note that there is no error checking for this – it is up you to ensure the entries are 
correct, regarding the amount and date.

Reporting Structured Finance

You can print, view and write to PDF/Word/HTML individual cash flow statements for each Source 
in a Finance Setup, from the Reports button in the main ARGUS Developer workspace toolbar.

You can also view and print from the Structured Finance window by clicking on this button.

If you click on the Financing tab and click the All Sources Report button that is immediately 
below the menu (shown below):

 - this will open the Funding Source Cash Flow report:
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Alternatively, if you click on a tab in the Structured Finance window, you will see that a Print 
Preview button is available on the tab:
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Clicking on this button will open a print preview window, allowing you to format and print a copy 
of the data you have entered in the selected page in the Structured Finance window:

Exporting to Excel

To export the finance cash flow to Excel, click the Excel button on the Cash Flow page.
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CHAPTER 12
Sensitivity Analysis

The Sensitivity Analysis module allows you to run “What if?” calculations on your project. You 
can choose to vary many of the variables in the area schedules in addition to Profit, Land Value, 
Interest Rates and Time.

To complete calculations for each variable, the analysis will take two steps down and two steps up 
from the current value. This gives five results for each variable, including the mid-point where the 
value does not change.

Where Time is included as a variable, the analysis will only step up from the current value.

You can select the items to be used in the Sensitivity Analysis by clicking the Sensitivity Analysis  
button on the toolbar.

Starting Sensitivity
The Sensitivity Fields section lists the fields available for analysis. You can select up to three 
standard fields in addition to the Time field. The standard fields are Land Price to Sales Total Value 
in the list above.

To add a field to the Sensitivity Analysis
In the Sensitivity Fields list, click on the check box to the left of the required field(s). The detailed 
definition panel is now shown on the right-hand side.
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In the detailed definition panel, select the preferred Step Type and Amount and specify which 
areas/phases are to be sensitized, as set out in the table below.

The buttons Include All or Exclude All can be used to quickly select or deselect all areas and/or 
phases to be used in the sensitivity analysis.

Additional options
Additional options can be displayed by clicking on the Advanced button: 

Here, you can specify whether or not the Gross: Net ratio should be locked during calculation of 
the sensitivity analysis.

If you click the Advanced button with the “Time” field open, the advanced options will be 
different - here, you will be able to specify phase timescale adjustments.

To return to the standard options in the Sensitivity Analysis window, click on the Return to Areas 
button.

To Sensitize Do this
Land Price Check the Land Price field.

Enter Step Amount and Step Type.
Check each required phase in the phase list.

Profit Check the Profit field.
Enter the Step Amount and Step Type.
If required, choose to override the current profit 
target with a new base rate.
Check each required phase in the phase list.

Interest Rates Check the Interest Rates field.
Enter the Step Amount and Step Type.
Check the Debit and/or Credit rate checkboxes.
If multiple interest sets are defined, choose each 
required set from the list.

Area field Check the Area field.
Enter the Step Amount and Step Type.
Check the required areas in the table by clicking 
the Include check box.

Time Choose the Time field.
Enter the Step Amount and choose the 
Development Stage.
Check each required phase in the phase list.
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Analysis Pre-Check
Before proceeding with the analysis, there are a few points to consider, as these may affect the 
results of the calculations.

1. Where the project is using a Single Interest Set, it will not be possible to choose individual 
interest sets for variation in the analysis.

2. If you have chosen Time as one of the variables, the program may not calculate any variations 
for the following reasons:

• Interest rates have not been entered;

• There are Fixed Dates entered into the Timescale form;

• Costs or receipts have been manually timed in the cash flow.

Running the Analysis

When the fields have been chosen, you can run the Sensitivity Analysis by clicking on the 
Calculate button or selecting the Analysis Results tab.

ARGUS Developer will now run through 5, 25, 125 or 625 separate valuations depending upon the 
number of fields chosen. 

While the analysis is calculating the results, a progress meter is displayed in the centre of the 
screen. You can stop calculation at any time by clicking on the Cancel button. If you do cancel the 
calculations, the program can display a partial set of results.

Note: If you are working in Land Residual mode, the analysis may take a while to complete.

Viewing the Analysis
The Analysis Results Matrix shows the results of the separate valuations. The central cell of the 
matrix shows the project's current Land Value or Profit Amount.

If you are working in Land Residual mode, the Land Value and Profit % are shown.

If you are working in Profit Residual mode, the Profit Amount and Profit % are shown.
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It is possible to view other variables in the matrix.

Click on the View menu option. Several variables are available:

• Land Price;

• Finance Cost;

• Profit Amount;

• Profit %s (Cost and GDV);

• Project IRR%;

• Equity IRR;

• Development Yield%;

• Rent Cover.

Printing the Analysis

You can print a report that contains the analysis results matrix, a list of each of the items included 
and their variable steps by clicking on either the Preview or Print buttons.
The report is available only after the calculation has been run.

Note: If you want to print additional result variables, change the Analysis Results Matrix 
using the View menu option. Then reprint the Sensitivity Analysis.

The analysis results matrix can also be exported into Word by clicking on the Print to 
Wordprocessor button.

You can create an Adobe Acrobat .pdf file of the analysis results matrix by clicking on the Print to 
Adobe Acrobat PDF button.

Alternatively, the analysis results matrix can be saved as an HTML file by clicking onto the Print 
to Web Page (HTML) button.

Updating the Project
The sensitivity calculations and results are held separately from the main project. However, you can 
force the project to adopt the variables that produce any of the measures shown in the analysis 
results matrix.

The project variables will be permanently changed and the project recalculated to reflect the Land 
Value, Profit% (and so on) shown in the Sensitivity Results.

To update the project with the current variables

Move to a cell in the analysis results matrix. Click on the Update button.
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Restrictions
The following restrictions apply to the fields available for sensitivity:

• % Fees cannot be sensitized;

• Fixed values such as Demolition costs cannot be sensitized;

• Any items entered into the Additional Costs or Revenues schedules cannot be sensitized.

Options
If you are working in a currency where numbers require a large number of digits, you may find that 
the results in the matrix do not fit entirely within each cell. If this is the case, you can change the 
way the results are displayed by switching off cell formatting.

To switch off cell formatting
Choose Format Results Cell from the Options menu.

To Do this

Format the result cells. Tick the Format Results Cells option.
Suppress formats in the result cells. Untick the Format Results Cells option.
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CHAPTER 13
Cash Flow

The Cash Flow is a flexible analysis tool that records all costs and receipts entered into the 
Definition section of the program. Financial calculations are carried out automatically when any 
value changes.

The ability to define precise cost distribution as well as relationships between various items of data 
offers a powerful, flexible tool that deals with almost every type of single or multi-phased scheme.

A development project is normally evaluated by the revenue return on expenditure. The simple 
mathematical surplus (or deficit) is a general guide only that the project is worth pursuing. The true 
performance of the money and its comparison with alternative forms of investment is more 
apparent after discounting the entire project to equate the costs and revenues to present day figures.

The Cash Flow undertakes these calculations in real-time by producing the discount (DCF) rate at 
which the Net Present Value is zero, or as near to zero as can be calculated.

Cash Flow
What’s on the Cash Flow Screen?
The cash flow is comprised of several main sections:

1. The toolbar that allows you to change the appearance and cycle of the cash flow.

2. The properties of each row, such as the Heading and Interest Set.

3. The cash flow grid containing the project costs and receipts.

4. The Interest/Inflation and Totals grid.

5. The status display on the bottom of the window, which shows information about the currently 
selected cell.
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Cash Flow Toolbar

You can change the appearance of the cash flow, its colour, font and so on by clicking on the Cash 
Flow Options button or selecting Options from the Tools menu.

The cash flow can be exported to Excel by clicking on the Export to Excel button or by using the 
Import and Export options in the File menu.

Select the amount of detail by choosing between Project Cash Flow and Finance Cash Flow 
views:

Project Cash Flow.

Finance Cash Flow.

When Structured Finance is applied to a project appraisal and the Finance Cash Flow view is 
selected, the project cash flow and finance cash flows can be expanded and collapsed using the 
buttons:

Expand All Cash Flows.
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Collapse All Cash Flows.

Change the viewing cycle by selecting Monthly, Quarterly, Semi-Annual or Annual from the 
Cash Flow View Cycle drop-down box.

If you wish to add new view cycles to the list, select the Edit View Cycles... option. See “Editing 
View Cycles” on page 197 for further details.

Show Zero Value Rows If this option is checked, all zero value rows will be displayed in the cash 
flow. If this option is not checked, then any zero value rows will not be displayed.

Row Properties
The row properties show you additional information about each row in the cash flow, in several 
columns immediately after the Row Heading column. You can hide these to show more data in the 
cash flow grid.

To display the Row Properties, click on the Cash Flow Options button  and check the Show 
Row Properties check box. Uncheck this option to hide row properties.

Heading Each row has a heading in the first column. The heading is normally filled in 
automatically from the Definition screen, but you can specify new headings in the cash 
flow. The heading is printed in the cash flow reports.
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Category Each row has a cost/revenue category automatically assigned when it is created. The 
category tells ARGUS Developer how to treat the item. You are not allowed to change 
the category.

Tagged Rows can be tagged so that an operation can be performed on the entire block. When a 
row is tagged, a “Y” shows in the cell and the row is coloured with a darker background.

Hidden A row may be hidden, so that its data cells are not included in row/column totals, neither 
do they attract any interest. When a row is hidden, a “Y” shows in the cell.

Locked A locked row is one on which the data cells cannot be changed by typing a value into the 
grid. When a row is locked, a “Y” shows in the cell.

Related Rows can be related to other rows by defining a relationship at a fixed percentage. 
Where a row is related, a “Y” shows in the cell.

Phase Shows the phase number to which the row belongs. You are not allowed to change the 
phase number.

Sign Shows the sign for the values on the row: ++ indicates a revenue, -- a cost, -+ a cost 
offsetting income and +- income offsetting cost.

Interest When Basic Finance (Interest Sets) is applied to a project, each row has an interest set 
attached to it. This governs the rate at which interest is calculated on each of the data 
cells. The interest set number is shown in this cell. When Structured Financing is applied 
to a project, this column is not displayed.

Inflation Each row may have an inflation or escalation set attached to it. This governs the rate at 
which inflation or escalation is calculated on each of the data cells. If inflation has been 
applied, then a “Y” is shown in the cell. If no inflation set is applied to a row, then “N” 
will be displayed.

GST Each row may carry Gross Sales Tax (GST) at any specified rate together with a rate at 
which GST may be recovered. If a row carries GST, a “Y” is shown in the cell.

Notes Each row can have notes attached. If a row has notes defined, a “Y” is shown in the cell. 
You can add notes by clicking on the Notes cell in the grid; this will open an editor 
window.

Cash Flow Grid
The cash flow is a grid of rows and columns. Each cell is the intersection of a row and column and 
holds periodic costs and receipts.

When starting ARGUS Developer for the first time, you should find that all costs are displayed in 
red and all receipts in blue. You can change the colour of the cell values by clicking on the Cash 
Flow Options button or by choosing Options from the Tools menu.

Generally, you first select the cell you want to work with, and then you enter data or choose a 
command. A selected cell appears highlighted on the screen. The active cell is the cell into which 
data is entered when you start typing. Only one cell is active at a time.

To change the active cell
Move the mouse pointer to a cell and click into it, or use the cursor keys.

To scroll through the grid
1. Move the mouse pointer to the down arrow in the vertical scroll bar on the right edge of the grid, 

and then click.
The grid moves down one row.

2. Click the scroll bar area below the scroll box, in the vertical scroll bar on the right edge of the 
grid. The grid scrolls down one screen.
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3. Move the mouse pointer into the scroll box. Hold the mouse button down, move the pointer 
back to the top of the vertical scroll bar, and then release the mouse button. This is called 
dragging. The grid scrolls back up to the first row.

Status display
The status display shows information about the currently selected cell. It is located on the bottom of 
the Cash Flow window (outlined in green here for illustrative purposes):

The following list shows the types of information displayed here (from left to right):

• How many of the phases are included/not included in the currently-displayed phase grouping;

• The current phase name;

• The currently selected cell’s location in the Cash Flow grid;

• The type of value the cell contains;

• The status of the currenly selected cell (whether it has “Normal” status or otherwise);

• An ID number which uniquely identifies the currently selected cell. If you need to do so, you 
can quote this number when making a call to technical support.

Useful status display options
In addition to the useful information described above, you can also use the status display to show 
an average, count or sum total of multiple cells.

To display an average
1. Select multiple cells in the grid by clicking and dragging to “paint” a range of cells.

2. The ID number (on the far right of the status display) will change to display a number.

3. Right-click on this number and select the Average menu option.

4. The number will change to show the average of the values in the cells you selected:

To display a cell count
1. Select multiple cells in the grid by clicking and dragging to “paint” a range of cells.

2. The ID number (on the far right of the status display) will change to display a number.

3. Right-click on this number and select the Count menu option.

4. The number will change to show the number of cells you selected:

To display a sum total
1. Select multiple cells in the grid by clicking and dragging to “paint” a range of cells.
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2. The ID number (on the far right of the status display) will change to display a number.

3. Right-click on this number and select the Sum menu option.

4. The number will change to show the total of the values in the cells you selected:

Other settings
When using the Average, Count and Sum features, there are also other menu options available 
when you right-click on the ID number:

• Include Hidden Rows  If you check this option, any hidden rows that are within the currently-
selected range of cells will be included in the Average, Count or Sum calculation.

• Include Zero Rows  If you check this option, any zero rows that are within the currently-
selected range of cells will be included in the Average, Count or Sum calculation.

• Include Heading Rows  If you check this option, any heading rows that are within the 
currently-selected range of cells will be included in the Average, Count or Sum calculation.

Cash Flow Commands
You can manipulate the information shown in the cash flow by adding and deleting rows, and 
changing links to other rows. The cash flow commands are accessed from the Cash Flow menu. 
Alternatively, you can right-click with the mouse to access the more frequently used commands. In 
addition, copy, cut and paste functions are accessed from the Edit menu.

Copy/Paste
You can copy and paste individual cells or entire rows of data within the cash flow. In addition, you 
can copy the distribution curve from one row to another. Please note that, whilst you can copy any 
row in the cash flow, you cannot paste to related rows.

To copy a cell
1. Select the cell that you want to copy

2. Choose Copy Cell from the Edit menu or press CTRL-C on the keyboard.

3. Select the cell or range of cells that you want to paste into.

4. Choose the Paste command from the Edit menu or press CTRL-V on the keyboard.
If you select any area-based cells when pasting, the associated area record will be updated.

To copy a row
1. Move to the row that you want to copy.

2. Choose Copy Row from the Edit menu.

3. Move to the row that you want to paste into.

4. Choose Paste from the Edit menu or press CTRL-V on the keyboard.

To copy a row’s distribution curve
1. Move to the row that you want to copy.

2. Choose Copy Row Distribution % from the Edit menu.

3. Move to the row that you want to paste into.

4. Choose the Paste command from the Edit menu or press CTRL-V on the keyboard.
The data values on the pasted row will now follow those on the copied row.
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Cut/Paste
You can cut and paste a cell from one period to another on the same cash flow row.

To cut a cell
1. Move to the cell that you want to cut.

2. Choose Cut Cell from the Edit menu.

3. Move to the cell that you want to paste into.

4. Choose the Paste command from the Edit menu or press CTRL-V on the keyboard.

Add Row
Use the Add Row command when the Definition screen does not have a pre-defined field for your 
particular cost or receipt, or when defining a cash flow from scratch.

To add new rows to the cash flow
1. Select Add Row from the Cash Flow menu.

2. Enter the number of rows by typing a number or by using the spinner arrows.

3. Choose either the default category or click the Choose another category radio button to choose 
your cost or receipt type.

4. Click on the Add button.

To code newly added rows
1. Select a category from the Category Browser list (see graphic below). It is important that you 

code each new row, as it is the code that determines where the row will be placed in the cash 
flow and how the row’s value will be treated in the calculations.

2. Make any selections from the Options section (see below for further explanation of the options 
listed).

3. Click on Accept Category. 
After each new line is added, a progress label is updated on the screen.
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Options
There are several options that determine what happens to a row after it is created:

Hide Cash Flow Row from Calculations Select this check box to hide the row from calculations. 
This box will be selected automatically if you code a line as any of the following: Annual Rent, 
Ground Rent, Rent History or Existing Income.

Show % Relation editor If you want to relate the row to another, select the Show Relation check 
box. When you click on Accept Category, the Relate form is displayed and you can relate the row 
to any other rows.

Add Source rows If you create a row that is normally dependent on other items being present (for 
example, Architect fee which is related to Construction among other things), you should select the 
Create Source check box. ARGUS Developer will automatically generate rows that the new fee 
depends on.

Add Area definition If you are creating a Rent, Sales or Construction row, you may want ARGUS 
Developer to generate an Area definition record. In this case, the new row is linked to an area 
definition.

If you are creating a Construction row, you will be asked to specify whether the construction data is 
linked to a Rent or Sales definition.

Edit Source
Select Edit Source from the Cash Flow menu, or by right-clicking with your mouse and selecting 
Edit Source from the drop-down menu. This opens the Detail Editor for the selected cash flow row 
which can then be edited or amended.

Please see “Editing Data” on page 94 for further details of the common controls in the Detail 
Editor.

Delete Row
You can delete a row from the cash flow to permanently remove it from the project. When you 
delete a row, it disappears from the Definition screen and the following rows shift up to fill the 
space.
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To delete a row from the cash flow
1. If you want to remove several rows in one go, tag the rows (see the section on Tag below).

2. Select Delete from the Cash Flow menu or press CTRL-DELETE to delete the row.

3. Confirm the deletion.
Rows are deleted from the cursor position downwards and the cash flow is recalculated.

If you delete a row that was created from an area definition, the area definition will be deleted. This 
means that if you delete a Capitalized Rent row, its MRV and Construction rows will be deleted 
too.

If you delete a row that has related fees attached to it, then the related fee is converted 
automatically into a fixed amount. You will not lose the information in the related fee cells.

Heading
You can change the standard heading of any row from within the cash flow to update area records 
and reports.

To change the heading
1. Move to the row whose heading you want to change.

2. Select Heading from the Cash Flow menu or press the H key on the keyboard.

3. Enter the new heading and press OK.

Lock/Unlock
You can lock rows in the cash flow to prevent manual values being entered into the data cells. 
Related rows are locked automatically on creation.

To lock a row
1. Move to the row that you want to lock.

2. Select Lock/Unlock from the Cash Flow menu or press the L key on the keyboard.

Omit (Hide)
You can mark rows as hidden so they are not included in the row/column totals, neither will they 
attract any interest.

Hidden rows can still be used as the basis for relationships, and it is possible to hide one or more 
rows in the worksheet and relate a normal fee line to it. In this case, only the figures in the related 
rows are used by the calculations.
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When printing cash flow reports, you can choose whether or not to print hidden lines.

To hide a row
1. Move to the row that you want to hide.

2. Select Omit (Hide) from the Cash Flow menu or press the O key on the keyboard.

3. If the row is currently hidden, the Omit dialog box will have the Unhide option selected.
If the row is currently unhidden, the Omit dialog box will have the Hide option selected.

Repeat
You can quickly copy a single cell backwards and forwards through any non-related row using a 
variety of standard distribution cycles: monthly, quarterly and so on. If you repeat a cell on an area-
based row, the associated area record will be updated.

To repeat a data cell
1. Move to the cell that you want to repeat.

2. Select Repeat from the Cash Flow menu or press the R key on the keyboard.

3. Choose the Repeat Cycle from the drop-down list.

• Periodic Cycle. Enter the number of months in the cycle and the number of months over which 
the cell will be repeated.

• Any other cycle. Enter the number of months over which the cell will be repeated.
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Sign
Every row in the Cash Flow carries a sign that indicates whether it is a Cost or Revenue. Two 
additional signs specify whether a Cost row will be used to offset/reduce Revenues or whether a 
Revenue row will be used to offset Costs.

To change the sign for a row
1. Move to the row for which you wish to change the sign.

2. Select Sign from the Cash Flow menu.

3. Choose a sign from the drop-down list.

Interest and Inflation
Interest, inflation and escalation sets can be selected and applied to a single or selection of rows in 
the Cash Flow. 

To apply interest/inflation/escalation sets
1. Select Interest & Inflation from the Cash Flow menu.

2. Select the interest, inflation and/or escalation set(s) to be applied from the drop-down lists. As 
you change set numbers the pre-defined rates are shown to the right of the field.

3. Choose the rows that the selected sets are to be applied to. Sets can be applied to the current 
row, to tagged rows, or to all lines in the cash flow, phase or category by selecting the required 
option.

4. Click Apply to apply your settings.
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Gross Sales Tax
You can apply a GST rate and recovery rate to individual rows by selecting GST from the Cash 
Flow menu.

The GST dialog is displayed with the corresponding cash flow row highlighted.

Type the values for GST rate and Recovery rate against the required item(s) in the table in the 
lower half of the GST form, and then click on the Save command button.
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For further information see Chapter 14 ’Gross Sales Tax’ on page 207.

Zero Row
You can remove the data values without removing the row from the Cash Flow by setting each cell 
to zero.

To zero either a cell or row
1. Move to the cell or row.

2. Select Zero Row... from the Cash Flow menu.

3. Choose the range that you want to zero and click on OK.

To zero tagged rows
1. Tag the range of rows (see the section on Tag below).

2. Select Zero Row... from the Cash Flow menu and click on OK.

Note: Any rows that are attached to an area definition will be updated automatically.

Row Properties
Row Properties provides additional information about the selected row in the Cash Flow.

Heading Each row has a heading in the first column. The heading is normally filled in 
automatically from the Definition screen, but you can specify new headings in the Cash Flow by 
clicking onto the Heading button. The heading is printed in the Cash Flow reports.

Phase Shows the phase number to which the row belongs. You are not allowed to change the phase 
number.

Order This refers to the block of similar lines to which the row belongs. The Cash Flow is 
constructed from a series of blocks of rows such as Revenue, Acquisition, Construction and so on. 
These blocks of lines are sorted by phase, so that all rows for revenue items for a phase are grouped 
together in the Cash Flow.

Group Order This is the order of individual lines within an Order block. 

Category Each row has a cost/revenue category automatically assigned when it is created. The 
category tells ARGUS Developer how to treat the item. You are not allowed to change the category.

Sub Group The sub group is used to direct an Additional Related fee to a specific position on the 
Project Pro Forma report. The default setting for Additional Related costs is cost group 50. To 
change the position of an Additional Related fee, select the appropriate category of the item that it 
should appear below in the Project Pro Forma.

Tag Rows can be tagged so that an operation can be performed on the entire block. When a row is 
tagged, this check box will be checked and the row is coloured with a darker background in the 
Cash Flow.
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Hide A row may be hidden, so that its data cells are not included in row/column totals, neither do 
they attract any interest. When a row is hidden, this check box will be checked.

Lock A locked row is one on which the data cells cannot be changed by typing a value into the 
grid. When a row is locked, this check box will be checked.

Timing If the distribution of the item in the Cash Flow has been manually altered, this check box 
will be checked. You can further adjust the timing by clicking on the Timing button.

Distribution This shows the current data distribution pattern. You can edit the data distribution by 
clicking on the Distribution button.

Relate Rows can be related to other rows by defining a relationship at a fixed percentage. Where a 
row is related, this field summarizes the percentage relation, the rows to which the item is related 
and the relation type.

Sign Shows the sign for the values on the row: ++ indicates a revenue, -- a cost, -+ a cost offsetting 
income and +- income offsetting cost.

Interest Each row has an interest set attached to it. This governs the rate at which interest is 
calculated on each of the data cells. The interest set number and the defined rates for that set are 
shown.

Interest Timing The interest timing, in advance or in arrears is shown here. This setting can be 
locked.

Inflation Each row may have an inflation or escalation set attached to it. This governs the rate at 
which inflation or escalation is calculated on each of the data cells. The set number and the defined 
rates for that set are shown.

GST Each row may carry Gross Sales Tax (GST) at any specified rate together with a rate at which 
GST may be recovered. If a row carries GST, the GST rate and recovery rate are shown.

Total Shows the total for the item in the Cash Flow. If escalation is applied, it shows the amount 
plus escalation.

Unescalated Shows the total excluding escalation.
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Cell Properties
By using the Cash Flow | Cell Properties menu option or right-clicking on a cell in the Cash Flow 
and using the Cell Properties menu option, you can see the properties of the cell that is currently 
selected.

Period Number  This is the month in which the selected value sits in the Cash Flow.

Value  This is the value of the cell.

Inflated Value  This is the value plus any inflation.

Distribution  This is the percentage of the cell in terms of the total for the entire row.
Fixed  This indicates whether or not the cell is fixed.

Export Cash Flow to Excel
You can export the Cash Flow to Excel in either of the following ways:

• Raw data with formulae.
This opens Excel and pushes all the data from your Cash Flow into a pre-defined template.

• Full export.
This opens the Import and Export wizard which allows you to export data to a range of 
applications. For further information on these options see “Importing and Exporting Data” on 
page 241.

Tag
You can tag a block of lines prior to using the Omit or Zero commands so that the command works 
on the whole block in one go. The tagged blocks are shown here outlined in green for illustrative 
purposes:
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To tag a block of rows
1. Before you can tag any rows, the row properties must be visible. To do this, use the Tools | 

Options... | Cash Flow menu option and make sure that Show Row Properties is checked.

2. To tag a row in the Cash Flow, click into the Tagged cell in the Row Properties section. The 
Tagged indicator will change to display a tick, and the tagged line will now be shown with a 
differently-coloured background (the color that is displayed here depends on your color 
settings).

• To tag a group of contiguous rows, hold down the SHIFT key as you make the selection.

• To tag a group of non-contiguous rows, hold down the CTRL key as you make the selection.

• To remove the tags from all tagged lines, click anywhere into the Cash Flow grid.

Finance Cash Flow: Basic Finance (Interest Sets)
The Cash Flow can be expanded to show a second grid containing column totals, interest and 
inflation rates, and GST payments and receipts when Basic (Interest Sets) has been selected as the 
financing method in the Finance tab of Assumptions for Calculation.

You can use the Finance view to override the periodic rates for any of the interest and inflation sets 
or to enter the fixed interest total for a period.

To show the Finance Cash Flow, click on the Finance Cash Flow button on the Cash Flow toolbar. 
The Finance grid is shown here outlined in green for illustrative purposes:
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In the Finance view, you can show the minimum of detail by using the Tools | Options... menu 
option, selecting the Cash Flow tab in the Options window then checking the Show Brief Finance 
Details check box. This view hides the inflation and interest rate rows and shows only GST (if 
applied), the period totals and total interest amounts.

Current Inflation Set
Shows the rates for any of the defined inflation sets. You can modify the profile of rates to easily 
recalculate inflation for any items attached to the set.

To change the current inflation/escalation set
1. Right-click within the Finance grid.

2. Select View Inflation/Escalation Sets from the popup menu.

3. Select the set number.

To enter stepped inflation/escalation rates
1. Click on the Inflation/Escalation Sets button on the main toolbar: 

2. Enter the stepped rates into schedule.

Current Interest Set
Shows the Debit and Credit rates for any of the defined interest sets. You can modify the profile of 
rates to easily recalculate interest for any items attached to the set.

To change the current interest set
1. Right-click within the Finance grid.

2. Select View Interest Sets from the popup menu.

3. Select the interest set name from the list.

To change a fixed interest rate
1. Click on the Inflation/Escalation Sets button on the toolbar.

2. Change the rates in the schedule.
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To enter stepped finance rates
1. Click on the Inflation/Escalation Sets button on the toolbar.

2. Enter the stepped rates into the schedule.

To enter a fixed finance cost
1. Move to the Total for Construction Loan row in the Finance grid.

2. Type the fixed finance cost into the required cell and press Return.
The Finance grid will display the amount in the Debit Rate cell and blank out the rate in the 
Credit Rate cell.

Finance Cash Flow: Structured Finance

To show the Finance Cash Flow, click on the Finance Cash Flow button on the Cash Flow toolbar.
When Structured Financing has been selected as the financing method in the Finance tab of 
Assumptions for Calculation, the Finance Cash Flow will display individual cash flows for each 
Debt and Equity partner created together with Project Cash Flow and Combined Partners cash 
flows.

For further information on Structured Finance, see “Structured Finance” on page 135.

Within the Finance Cash Flow, each individual partner cash flow can be expanded or hidden by 
clicking onto the “+/-” expansion button next to each partner’s name. All of the partner cash flows 
can be expanded or hidden simultaneously using the buttons:

Expand all Cash Flows.

Collapse all Cash Flows.

When your project has GST calculations active, the Project Partner Cash Flow will show several 
extra lines (in the Finance: Project Cash Flow Pre-Finance section of the Cash Flow): Net GST, 
GST Cost and GST Revenue. These extra rows are shown here outlined in green for illustrative 
purposes:
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• GST Revenue - this is the amount of GST that is added to the revenue. This will happen when 
there is a GST reclamation.

• GST Cost - this is the amount of GST that is added to or subtracted from the project costs. This 
will happen (a) when there is a GST payment but no reclamation; (b) when there is a GST 
reclamation.

• Net GST - this line shows the net amount of GST Paid and GST Reclaimed in each period. The 
Net GST will be used to (a) add to costs; (b) offset costs; and (c) add to revenues.

Editing View Cycles
In the Cash Flow, you can specify time periods other than the default options for viewing data. The 
default view cycles available from the Cash Flow View Cycle drop-down box are Monthly, 
Quarterly, Semi-Annual or Annual. To add new view cycles to this list, select the Edit View 
Cycles... option.

This opens the following window:

Here, you can add several different types of view cycle:

• Basic Cycle - A basic cycle allows you to specify a number of months for the cycle:
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• Calendar Cycle - A calendar cycle allows you to specify a cycle that can repeat at regular 
intervals throughout a calendar year.
For example, you can specify a recurring quarterly cycle that occurs throughout the year, 
beginning in April.

• Mortgage Takeout Cycle - a mortgage takeout cycle can allow you to specify a view cycle 
before and after the mortgage takeout in the cash flow, if you wish to display different view 
cycles.
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• Split Cycle - a split cycle allows you to view the cash flow using a mixture of the basic types 
(single, monthly, quarterly, semi-annual, annual).
Example: For the first 4 months you could specify a monthly cycle, then for the next 6 months, 
you could specify a quarterly cycle, and for the remainder you could specify a semi-annual view 
cycle.

Once you have added new view cycles to this window, you can use the up  or down  
arrows to specify their relative position in the list. This will determine their position when they are 
displayed in the Cash Flow View Cycle drop-down list:



200 Chapter 13: Cash Flow

ARGUS Developer version 4.05 Reference Manual

Note: You will not be able to delete or edit the default view cycle values, but you can change 
their order in the list.

Cashflow search facility
To search for a specific item in the cash flow, use the Edit | Find... menu option to open the Find 
dialog:

In the Find what field, type in what you are looking for - this could be a specific number, or row 
heading. Previous search strings will be stored so you can use them again at a later time - just select 
them from the drop-down.

Use the Look In controls to specify where you wish to search within the cashflow.

In the Search Options section, you can use the controls to fine-tune your search.

Use the controls in the When data is found section to specify what action will be taken when the 
object of the search has been found.

Click on Find, or Find Next if you wish to skip to the next occurrence.

Distribution summaries on totals
To view a visual summary of the distribution for each row item, hold your mouse pointer over the 

Total column. A pop-up window will appear, showing a graph of the distribution:
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If you do not have this Total column displayed, click on the Cash Flow Options button  to 
open the Options window.

Check the Show Row Total Column box to turn on the Total column.

Column and group options in the Project Cash Flow
In the Project Cash Flow, it is possible for you to quickly turn various column and row group 
options on or off. To do this, right-click anywhere in the column heading to open the menu:

This menu allows you to toggle various columns on or off:

• Row Total - This is a total of all the values on the row;

• Row Present Value - This shows the PV of the values on the row;

• Row Properties - This shows all the Row Properties columns.

Other cash flow items can be toggled on or off:

• Group Summaries - These are extra rows that contain totals for each group of rows that you 
have defined;

• Timeline - This displays the timeline in the heading row (the timeline indicates which months 
belong to each stage/phase);
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• Merge Section Summaries by Department Category - This merges together several levels of 
section summaries to produce one summary.

Grouping rows
In the cash flow, you can set up groupings of rows to make the cash flow presentation easier for 
you to read. You have a choice of  2 types of grouping complexity:

• Basic grouping;

• Advanced grouping.

Basic grouping
Right-click anywhere in the column heading to open the menu and select the Grouping... option.

This opens the Cashflow Basic Grouper dialog:

Here, you can define up to 4 levels of grouping by selecting types of rows and row attributes, and 
defining a sort direction.

For example, in level 1 you could select “Category”, and in level 2 you could select  “Cost Code”. 
This would perform the primary grouping on the category, and a secondary grouping on the cost 
code.

Other grouping criteria you can select here are attributes that have been set, such as “Locked”, 
“Hidden” or “Tagged”.

You can turn off a grouping level by selecting “(None)”. This will turn off the grouping level and 
any other level below it.

The default option is “Default Category Order”, which groups the rows in a default order (“factory 
settings”).

When you have defined a grouping pattern in this dialog and clicked on OK, the rows in the cash 
flow will arrange themselves according to this pattern.

Advanced grouping
Right-click anywhere in the column heading to open the menu and select the Advanced 
Grouping... option. This opens the Cashflow Advanced Grouping window:
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In the Cashflow Advanced Grouping window, you can move the existing groupings and row items 
about by using the arrow buttons.

If you wish to create new groups, you can use the Edit | Add Main Group and Edit | Add Sub 
Group options. You can give these groups any name you want, and you can drag existing row 
items from other groups into a group you have created.

When you click OK, the cashflow row and grouping structure will change to reflect the 
modifications you have made.

Sorting in the cash flow
You can specify a default sorting method for the cash flow rows by right-clicking on the column 
headings and selecting the Sorting... option. This opens the Cashflow Sorting dialog:

Here, you can define up to 4 levels of sorting by selecting types of rows and row attributes, and 
defining a sort direction.
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For example, in level 1 you could select “Category”, and in level 2 you could select  “Cost Code”. 
This would perform the primary sort on the category, and a secondary sort on the cost code.

Other sort criteria you can select here are attributes that have been set, such as “Locked”, “Hidden” 
or “Tagged”.

You can turn off a sort level by selecting “(None)”. This will turn off the sort level and any other 
level below it.

The default option is “Natural Order”, which sorts the rows in a default order (“factory settings”).

When you have defined a sorting pattern in this dialog and clicked on OK, the rows in the cash 
flow will arrange themselves according to this pattern.

Exporting to Excel

To export the cash flow data to Excel, click the Excel button on the Cash Flow page.

Alternatively, you may also use the Finance | Cash Flow Data from Current View menu option.

Highlighted Funding Source Report
To display a funding source report for a specific phase, select the appropriate phase tab and use 
either the Finance | Highlighted Funding Source Report... menu option, or if you are currently 
viewing the Finance Cash Flow, right-click on the cash flow heading and select the Highlighted 
Funding Source Report... menu option:

This will generate a funding source report for the selected phase:
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CHAPTER 14
Gross Sales Tax

Click on the GST Schedule button to apply Gross Sales Tax to any item previously entered through 
the Definition screen. If you cannot see the button, use the File | Administration | System 
Configuration | Country menu option. You can then check the Include Gross Sales Tax screens 
check box.

Default GST Settings
Use this section to set the Global GST rate, Global Recovery Rate, Recovery Cycle and the first 
period in which GST will be recovered.

You can switch the GST calculations on or off by selecting the GST Calculations Active in Cash 
Flow check box. The settings you have made to GST and recovery rates will be unaffected by this 
switch.

Applying GST
Use the GST schedule to apply the global GST options set, or to enter specific GST and Recovery 
rates for individual items.
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The global GST settings entered can be applied (and removed) to all items listed in the GST 
schedule simultaneously using the command buttons on the toolbar.

Apply Rates to All Rows This button will apply the global rates to all items.

Remove Rates in all Rows This button will remove rates from all items.

Global GST RateThis allows you to specify the GST rate that will be applied to all items if you 
click on the Apply Rates to All Rows button.

Global Recovery Rate This allows you to specify the recovery rate that will be applied to all items 
if you click on the Apply Rates to All Rows button.

Recovery Cycle every This is the periodic cycle on which GST is recovered. So, for example, if it 
is recovered quarterly, the recovery cycle would be 3 months; if it is recovered annually, the 
recovery cycle would be 12 months.

1st Recovery Month This allows you to specify the first month of the project in which GST is 
recovered. So for example, GST is first recovered in month 2 of the project if you specify 2 here.

The GST rates applied are displayed, item by item, in the GST Schedule. This schedule shows three 
columns: Heading, GST Rate and Recovery Rate.

The GST rate and Recovery rates may be varied for any item. Change any of the rates by moving to 
the cell and typing a new value.

Gross Sales Tax calculations may be viewed in the Finance Cash Flow. For further information, see 
“Finance Cash Flow: Basic Finance (Interest Sets)” on page 194.
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CHAPTER 15
Printing Reports

There are many reports available within ARGUS Developer, most of which are accessed from the 
Report Printer screen.

The Report Printer is opened by clicking on the Reports button.

Report Content: Standard Reports
When the Standard Reports button is selected in the Reports Group section, the Report Content 
tab contains a list of standard reports used in ARGUS Developer that can generate flexible files for 
any reporting purpose. The primary reports are the Project Pro Forma and Detailed Cash Flow.

• Project Pro Forma This report presents the costs, receipts and measures of performance in a 
straightforward, industry-standard manner, as displayed on the Project Pro Forma screen. It 
includes schedules of areas, rents and construction costs, together with all other inputs.

• Detailed Cash Flow This report shows the time-based flow of costs and receipts in the project. 
Each item has its own row in the report, and there are a variety of options that determine the 
look of the report.
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Include All Sections This selects all reports by checking the Include? column check box for each 

report.

Exclude All Sections This unchecks the Include? column check box for all reports.

To print a report
Click on the Reports button on the toolbar to open the Report Printer screen.

From the Report Content tab, select the report pages you want to include in your report by 

checking the Include? check box against the required report title.

Click onto the Print Report button on the toolbar to print the report.

Choose the Preview Report button to check the layout of the report before printing it.

Export to Wordprocessor This exports the report into Word. The .RTF file format is selected by 

default.

You can create an Adobe Acrobat .pdf file of your selected reports by clicking onto the Export to 

Adobe Acrobat (PDF) Format button. 

Reports can also be saved as HTML files by clicking onto the Export to Web Page (HTML) 

button.

Report Date By default, this will show today’s date. To change the date printed on reports edit this 

field.

Company Name This can be edited to change the company name displayed on reports.

Report Content: Enhanced Reports
When the Enhanced Reports button is selected in the Reports Group section, the Report 

Content tab contains a list of enhanced reports for specific purposes (such as Operated Assets, 

hotels and sales reports):
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Report Setup
To change the way the report looks on the page, choose the Report Setup tab. This is not available 
for Crystal Reports.

On this page, you can choose to suppress headers/footers and page numbers, and customize the 
Cash Flow report.
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To print page numbers
Check the Print Page Numbers check box. Page numbers will be appear centered in the footer at 
the bottom of each page of the report. Page numbering begins at 1 and increases sequentially by 1 
for each page.

To print the full file path and name
Check the Print Full File Path and Name check box. The full file path and name of your data file 
will appear left-aligned in the footer at the bottom of each page. For security reasons, you may 
want only the folder and file name to appear. In this case, uncheck this check box.

To print page headers
Check the Print Headers check box. The header appears at the top of each page. It contains your 
Company Name together with the primary and secondary titles of the project entered on the Project 
page.

To print page footers
Check the Print Footers check box. The footer appears at the bottom of each page. It contains the 
project file name, ARGUS Developer version number and report date.

To print the description “Part” or “Phase”
Select either Part or Phase from the drop-down list. This description appears on those sections of 
the report that print information on phases, such as the Timescale and Project Pro Forma.

Print Logo on Report
You can include a logo at the top of each page of the report by checking this option. The logo is a 
bitmap file and is located in the Report\Logo folder. Save your logo with the name 
ClientLogo.bmp and save it in this folder. You can select the logo’s position from the Position 
drop-down.

Options for Assumptions Report
There are several options in this section that you can use for controlling the content of the 
Assumptions Report:

Include Notes Use this option to include or exclude notes.

Include Timescale Use this option to include or exclude the timescale.

Include Assumptions Use this option to include or exclude assumptions.

Options for Cover Sheet
Cover Sheet as Final Page Use this option to force the cover sheet to be the final page in the 
report.

To change the Cash Flow cycle
Select Monthly, Quarterly, Semi Annually or Annual from the Cycle drop-down list. The cycle will 
be initially set by the Cash Flow View Cycle on the main Cash Flow screen, but can be overridden 
here.

To print row headings on all Cash Flow pages
Check the Print Headings on ALL pages check box.

The label chosen for each item in the cash flow will appear in the first column of every page on the 
Cash Flow report. To reduce the number of printed pages, you could uncheck this option. In this 
case, headings will appear only on the left-most pages of the report.
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To print Cash Flow amounts in 000’s
Check the Print in 000’s check box. The value printed in each period in the Cash Flow report is 
rounded to the nearest thousand. All interest amounts and column totals will also be printed in 
000’s.

To print rows with a zero value
Check the Print Zero Rows check box. Any row with a total value of zero will be included in the 
report. Uncheck this option to reduce the number of pages in the report.

To print section subtotals
Check the Print Section Subtotals check box. A subtotal will appear for each section in the Cash 
Flow report.

To print rows that are hidden
Check the Print Hidden Rows check box. Any row that has been hidden will be included in the 
report. Uncheck this option to reduce the number of pages in the report.

To print row numbers against each row
Check the Print Row Numbers check box. The line numbers allocated to each row in the Cash 
Flow will be printed. Uncheck this option to reduce the number of pages in the report.

To print the Cash Flow in portrait
When the Print Cash Flow in Portrait (Down page) check box is checked, the Cash Flow reports 
will be printed in portrait layout (in other words, down the page). The normal setting is to have the 
Cash Flow report printed in landscape (in other words, across the page). This option can help 
reduce the number of pages in the report for short projects with a large number of items.

To include a Cash Flow totals column
Check the Print Totals Column check box. A totals column will be included for each row in the 
Cash Flow after the row headings column in the detailed and grouped Cash Flow reports.
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Page Setup
To change the page layout and font for your report, choose the Page Setup tab. This is not available 
for Crystal Reports.

To change the margin settings
• Choose either Centimeters or Inches from the Units drop-down list.

• Modify the Top, Bottom, Left and Right values.

To change the Font
• Choose a font name and size from the drop-down lists.

• You can also enter a font size by typing a value. A sample of the font is shown in the Sample 
box below.

To change the paper size
• Choose a size from the Paper Size drop-down list. This option is useful for printing large Cash 

Flows on A3 paper.

Caveats and Watermarks
It is sometimes useful to include a message on each page of the report to indicate to the reader any 
special considerations. Caveats and Watermarks can be added in the Advanced tab of the Report 
Printer screen (see following screenshot). This is not available for Crystal Reports.

Caveats
ARGUS Developer allows the definition of an unlimited number of caveats, any of which can be 
attached to a project. A caveat can be printed at the foot of each page of a report, directly above the 
footer, by attaching it to the project.

To add a caveat to a report
To add a caveat to a report, check the Print Caveat on each Page check box, then browse to select 
the caveat to be attached to the report in the Caveat Name field. 
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To define a new caveat
Use the Caveat Editor button to open the following window:

Type in some text and click on OK.

To add the caveat to your library, simply save it as a new file in your template folder. This can then 
be attached to the report using the Caveat Name field, as set out above.

Note: An alternative method of opening the Caveat Editor is to use the Project | Caveat 
Editor... menu option from the main screen.

Watermark
A brief watermark may be added to each page of a report by checking the Show Watermark 
option.

Type in the text required and select the level of shading.
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Notes and Images
Additional Project Information

You can add extra text to the data file by using the Notes and Images button on the toolbar in the 
ARGUS Developer main screen.

Any text you have added here will appear in the Timescale & Assumptions report (the following is 
an example using the Report Preview feature):

Photograph, Map and Plan
You can attach an image to the .WCF file by means of a link to a file on the computer or network. 
If the recipient of the .WCF file has access to the link on the computer or network, they will see the 
attachment.
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Use the File | Load Graphic menu choice to select a BMP or JPEG file:



218 Chapter 15: Printing Reports

ARGUS Developer version 4.05 Reference Manual



Chapter 16:  Viewing a Project 219

ARGUS Developer version 4.05 Reference Manual

CHAPTER 16
Viewing a Project

You can view your project in several ways: Definition, Cash Flow, Project Pro Forma, Data 
Distribution and Graphical Analysis. When you switch from one view to another, the cursor 
remains in the same location to mark your place.

Two views show data for the current phase selection: single phase or linked phases.

Cash Flow
You can look at all costs and receipts line by line by selecting the Cash Flow tab. Use this view if 
you wish to see the distribution of data period by period. For further information, “Cash Flow” on 
page 179.

Project Pro Forma
You can see a traditional Pro Forma by selecting the Project Pro Forma tab. The Project Pro 
Forma is laid out with Revenues at the top, followed by Costs, with Profit and other performance 
measures at the end.
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The level of detail of information displayed in the Project Pro Forma can be changed; for example, 
a full or summary investment valuation can be displayed.

These options can be accessed by clicking onto the Project Pro Forma Options button or by 
selecting Options from the Tools menu. Check or uncheck the options as required in order to show 
or hide detailed information on the Project Pro Forma page.

For further information on these options see “Project Pro Forma” on page 270.

Data Distribution
Data Distribution displays a graph showing how each value is distributed over time for any defined 
item. It also allows you to retime and redistribute values (this topic is covered in more detail in 
“Data Distribution” on page 111).

To view the distribution of an item, click onto the Data Distribution button on the toolbar or select 
Data Distribution from the Tools menu.

From the Definition screen, click into a field then click on the Data Distribution button to view 
this item’s distribution.

From the Cash Flow, click onto a row then click the Data Distribution button, or right-click with 
your mouse and select Data Distribution from the menu.

A graph showing how the data is distributed over time is displayed.

This graph can be printed by clicking on the Print Graph button to preview the report, then click 
on Print.
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Graphical Analysis

Graphs can be generated to analyze the project in different ways by clicking on the View Graphs 
button on the toolbar.

The graphs available to view are:

• Revenue against Expenditure;

• Running Yield on Cost;

• Cost Breakdown;

• Rental Income;

• Occupied Area Over Time;

• Total Area Over Time;

• Occupied and Total Area over Time.

In the Cost Breakdown graph, you can change the graph display by using the Group Items That 
Are Less Than control to change the threshold sensitivity.

If you select the Revenue against Expenditure option from the drop-down, additional controls 
will become available:
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The Show Revenue, Show Expenditure, Show Interest and Show Cumulative check boxes 
allow you to display or hide various options in the graph.

To print a graph, click onto the Print button.

To preview a graph before printing, click onto the Print Preview button.

The graph can also be copied to the clipboard, to be pasted into another application such as Word or 
Excel, by clicking on the Copy To clipboard button or by using the Edit | Copy to clipboard 
menu option.

To switch graphs to a 3D display, check the 3D Graphs check box. If you uncheck this check box, 
the graphs will be displayed in 2D.



Chapter 17:  Data Checker 223

ARGUS Developer version 4.05 Reference Manual

CHAPTER 17
Data Checker

The Data Checker is a useful tool that assists you with identifying inconsistencies within your 
data. It is situated at the top right of the main ARGUS Developer screen and has three levels for 
both Project Data and Load Notes. These are Errors, Warnings and Hints.

On the main ARGUS Developer screen, the data checker’s status is shown as one of the images 
listed below. A green tick indicates there are no issues, an exclamation mark indicates the checker 
has registered some warnings, an information symbol suggests a hint and a red cross symbol 
indicates errors within the Project Data or Load Notes. 

1. No Issues:

2. Warning:

3. Hint:
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4. Data Error:

5. Data Error with Project Load Info:

Opening the Data Checker
If the program detects any warnings, errors or hints on project load the data checker is 
automatically opened.

When you click on either of the messages listed above, the data checker is opened for viewing. 
Another way to view the data checker is by clicking Tools | Show Data Checker. 

Once in the checker, the main screen is split into several headings:

• Phase - The phase in which the issue has been detected.

• Location - The area of the program that is affected by the issue (such as Cash Flow or rent 
schedule).

• Heading - The heading of the line in the Cash Flow.

• Description - Description of the issue found.

Fixing Data Checker Issues
When the program detects errors, warnings and hints you can double-click on the message and this 
will automatically open the part of the program where the issue lies. For example, if there is a 
timing issue, the program will automatically open the data distribution editor and you can then 
make the changes accordingly.

When the Project Load Info message appears, the file loaded may have had a discrepancy which 
will be automatically fixed by ARGUS Developer. These alterations will be documented in the 
Load Notes section in the data checker.

Some lines do not automatically open as the Cash Flow line may have been removed from the 
project.

Edit Menu
When the data checker recognizes any errors, warnings or hints the edit drop-down menu has a 
number of functions that can be used to quickly rectify the issues:

Edit Source - This will take you to the part of the program where the issue is located.

Allow Leases to start After Sale Date - Allows leases to start after the Sale Date. This is useful 
for loading .WCF files created in earlier versions.
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Align Lease Start Date to Capitalization Date for this Tenant - Aligns Lease Start Date to the 
Sale Date for the highlighted tenant.

Align Lease Start Date to Capitalization Date for all Tenants - Aligns Lease Start Date to the 
Sale Date for all tenants that are shown in the data checker.

Reset Timing on System Timed Item - Resets timing to default on the highlighted warning for 
manually timed or distributed lines.

Reset Timing on ALL System Timed Items - Resets timing to default on all system timed items 
for manually timed or distributed lines.

Remove Load Note - Deletes highlighted load note.

Remove All Load Notes - Deletes all load notes in data checker.

Filters

By clicking on the Edit Filters button or using the Tools | Edit Filters... menu option you can 
customize the errors, hints and warnings that appear under the classes Project Data and Load Notes.
For example, if you wanted to filter out any manually timed or distributed hints you could Add a 
new filter and call this filter Remove Manually Timed Hints. By unchecking the Item is 
manually timed or distributed box, it will no longer show these hints; instead, it will report at the 
bottom of the form that events have been hidden by the current filter.

Tools Menu
Reset Sort 
Reset Sort resets the data checker issues back to the original order. You can also perform this 
operation by using the Reset Sort button:
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Edit Filters...
This opens the Data Checker Filter form as described earlier in the chapter.
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CHAPTER 18
Managing Files

Creating a new Project
When you start ARGUS Developer, a new blank project is opened.

The new project is based on a stored default project template. To begin work, start entering the 
timescale, costs and receipts.

If you want to create a new project at any time, click on the Start New Project button on the 
toolbar.

If you are currently working on a project, you will be prompted to save it before the new project is 
created.

The new project will be created with your standard calculation options already in place.

Opening a Project

To open a project, click on the Open Project button on the toolbar.
When the Open dialog box appears, click onto the file name of the project you wish to open to 
highlight it, so that it appears in the File name box, then click on the Open button.

If you don’t see the project you want. The File name box initially shows projects in your 
designated Data Directory. If the project you want is not listed, browse to another drive or folder in 
the Look In box.

To open one of the projects you worked on most recently, select the project file name from the list 
at the bottom of the File menu in ARGUS Developer.

Information displayed when opening a project
When you open some projects, you may see additional information displayed. This may be because 
there are settings in the file which cause certain conditions to arise.

Messages may be displayed in the following types of windows:
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Data Checker
The Data Checker (see “Data Checker” on page 223 for further details):

Unknown Land Transfer Tax Schemes
The Unknown Land Transfer Tax Schemes window:

If this window appears, it will list any land transfer tax schemes in the project file that are not 
currently saved in your master Land Transfer Tax file. To update your master Land Transfer Tax 
file, check the schemes listed and click OK.

For further details of how to set up or manage land transfer tax schemes, see “Land Transfer Tax” 
on page 120.

Important notes on project load
In cases where a project file is loaded, but there is no license to support the data in the file 
(generally caused when the recipient of a Developer file does not have the same modules that were 
used by the creator of the file):
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• Where the project file contains Equity/JV data but there is no Equity/JV license available, the 
program will set the financing method to Basic (Interest Sets). The Equity/JV data will remain 
in the project and will be saved to the data file. This ensures that, if the file is opened on an 
installation with the Equity/JV license, the alternate financing method can be restored.

• Where the project file contains Finance module data but there is no Finance module license 
available, the program will set the financing method to Basic (Interest Sets). The Finance 
module data will remain in the project and will be saved to the data file. This ensures that, if the 
file is opened on an installation with the Finance module license, the alternate financing method 
can be restored.

• Where the project file contains Advanced Finance module data but there is no Finance module 
license available, the program will set the financing method to Basic (Interest Sets). The 
Advanced Finance module data will remain in the project and will be saved to the data file. This 
ensures that, if the file is opened on an installation with the Finance module license, the 
alternate financing method can be restored.

• Where the project file contains Advanced Finance module data but there is no Advanced 
Finance module license available, BUT there is a Finance module available, the program will 
set the profit distribution type for each source to Residual Percentage. The Advanced Finance 
module data will be removed. This data can only be reactivated by opening the project on a 
system with the Advanced Finance module present and re-entering the advanced profit 
distributions.

• Where the project file contains Operated Asset module data but there is no Operated Asset 
module license available, the program will set the use type of each area record that has an 
operated asset use type to Undefined. The Operated Asset module data will remain in the 
project and will be saved to the data file. This ensures that if the file is opened on an installation 
with the Operated Asset module license, the data can be restored.

Note: A warning will be given before any of the above-mentioned transformations of the data 
file take place. It will be possible to abandon loading the project at this point.

Note: Where the use types are modified to read Undefined, the program will calculate the 
area records on a normal rental income basis. As the operated asset data has been detached 
from the area records, the rent, rental income and capitalization will be zero.

Saving a Project

To save a project, click onto the Save Project button on the toolbar, or select the Save or Save As 
options from the File menu. 

When you save a project for the first time, ARGUS Developer displays the Save As dialog box so 
that you can type in a name for the project data file. By default, files will be saved into your 
designated Data Directory. If you wish to save the file to another drive or folder, browse to this 
drive or folder in the Save in box then click Save.

Naming a project in Windows
In Windows, a filename can be up to 255 characters long, including the path to your folder, 
followed by an optional period (.) and a file extension. ARGUS Developer will supply the file 
extension, which is .WCF. 

File names cannot include any of the following characters: forward slash (/), backslash (\), greater 
than sign (>), less than sign (<), asterisk (*), period (.), question mark (?), quotation mark (“), pipe 
symbol (|), colon (:), or semicolon (;).

You cannot use a period except to separate the filename from the extension.
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Emailing a Project
You can email any of your project data files to a client or to another user from within ARGUS 
Developer. To use this function, your email package must be fully MAPI compliant. If you are 
unsure whether your email package is MAPI compliant, ask your System Administrator.

To E-mail a project data file
1. If you want to send your open project file, you must first save the file to your hard drive.

2. Next, select Mail Data File from the File menu.

3. Choose a data file from the Open dialog browser and click onto the Open button.

4. The program will then open a new message with the selected data file automatically attached. 
You can then enter the recipient’s email address and any message.

5. Click on the Send button or select Send from the File menu.

You are also able to send .WCF files the usual way. Simply create a new email message and browse 
to the data folder location and attach the file.

Using the ARGUS Zone sidebar
The  ARGUS Zone sidebar is located on the left-hand side of the Developer main window (shown 
here outlined in green for illustrative purposes):

The sidebar allows you to work with Developer files that you have stored on ARGUS Zone. The 
sidebar provides access to folders within the Zone that you can use for collaborative purposes, 
wherever you are in the world. ARGUS Zone (formerly known as RealPulse) provides access to 
services and resources that aid you in your use of ARGUS products.

You can log into the Zone using the sidebar, or via the use of the ARGUS Zone website:

http://www.arguszone.com

http://www.arguszone.com
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If you are not yet a subscriber to ARGUS Zone, you can sign up by clicking on the Sign Up to 
ARGUS Zone link.

Once you have set up a user account and password for use with ARGUS Zone, you will be able to 
enter your user name and password in the boxes provided in the sidebar. Click the Login button to 
log in.

The sidebar will change to show a folder display similar to the following:

You can use this folder system to navigate in much the same way as Windows Explorer. The 
sidebar contains the following features:

• Logout button - Use this button if you wish to log out of ARGUS Zone.

• Workspace drop-down - Use this drop-down to select a workspace that you are permitted to 
access. Some of these workspaces may be for personal use, and some may be for collaborative 
use.

• Create button - Use this button to add a new workspace.

• Refresh button - Use this button to refresh the display.

• Details button - Use this button to show details about the workspace.

• Documents area tab - Select this tab to view the files and folders within the currently selected 
workspace.

• Members area tab - Select this tab to show a list of all the users who have access to this 
workspace.

• New document button - Use this button to bring a new file into the workspace. You can 
browse your hard drive or network for a file, then upload it to the Zone with this feature.
Note that if you need to delete or rename a file, you must go to the ARGUS Zone website to do 
so.

• Add folder button - Use this button to add a sub-folder under the folder you have currently 
selected.
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Note that if you need to delete or rename a sub-folder, you must go to the ARGUS Zone 
website to do so.

• Open with ARGUS Zone button - Use this button if you wish to go to the ARGUS Zone 
website and access the currently selected folder. This will open a web browser window, with the 
appropriate folder contents displayed in the Zone.

The following options only appear once you have selected a file in one of the folders:

• Open document button - Use this button to open the currently selected file with the 
appropriate application.

• Version history button - Use this button to view the version history and owner of the file.

• Check out button - Use this button to check out the currently selected file. Checking out 
allows you version-control a file; this is particularly useful in collaborative or group projects 
where there are several people who will contribute to the data in a file.

• Check in button - Use this button to check a file in. This option only appears if you have 
performed a check out procedure on a file.

• Undo check out button - Use this button to undo a check out procedure. This option only 
appears if you have performed a check out procedure on a file.

Adding a workspace
A workspace is an area within the Zone where you can store files and folders.

To add a new workspace to the list in the workspace drop-down, click on the Create button.

The sidebar changes to show the following:

Type in a name for the new workspace and click on the OK button.

Note: If you wish to permit other users to access this workspace, you will need to open the 
Workspace Explorer in the ARGUS Zone website, and invite the other users as collaborators.

Opening a workspace
To open a workspace in the Zone, use the workspace drop-down. You can select a workspace from 
the list. If you have not yet defined a workspace, you will need to go onto the ARGUS Zone 
website to do so, or use the Add button.

Opening a folder in the Zone
To open a folder with the Zone website, first select the folder or sub-folder and click on the Open 
with ARGUS Zone button. This will take you directly to the appropriate folder in the workspace, 
displayed in a web browser window.

Note: If you do this and you are taken to the login page of ARGUS Zone instead, it means 
that you have been automatically logged out of the Zone (because of account inactivity). To fix 
this, log in again, and repeat the Open with ARGUS Zone action.

Checking a file out
To check a file out, select the file and click on the Check out button.
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A padlock symbol will be displayed next to the file’s name, indicating that the file is locked for 
editing purposes.

You will be able to open the file, edit it and save it without other users overwriting it. After you 
have finished editing the file, you should check the file back in, so that other users can use the file. 
Each time you do this, a version-controlled backup of the file will be stored in the Zone.

If you wish to reverse a check out procedure, select the file and click on the Undo check out 
button.

Checking a file in
When you add a document to the Zone storage, it is checked in by default.

Each time you check a file in, a version-controlled backup of the file will be stored in the Zone.

To check a file in when it has been checked out, select the file and click on the Check in button.

Viewing the change history of a file
The change history of a file shows how many times a file has been checked in after revision, and 
shows the names of the users who have done this.

To view the change history, select the file name and click on the Version history button.

This opens the Version History window:

Note: If the document has gone through so many revised versions that you now have a very 
long list, you may wish to delete some of these minor versions, leaving the current version in 
place. You will only be able to do this by logging into the ARGUS Zone website.

Hiding the ARGUS Zone sidebar
On occasions when you are not using the ARGUS Zone sidebar, you can hide it by clicking on the 
vertical ARGUS Zone border that appears on the far left of the sidebar (shown here outlined in 
green for illustrative purposes).
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This is a toggle, so clicking on the border again will open the Zone sidebar.

To resize the Zone sidebar, you can use the mouse to drag the right-hand edge of the Zone sidebar. 
The mouse cursor will change automatically to a resizing cursor when you position it over the line 
between the Zone sidebar and the tabs in the main window.
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CHAPTER 19
Working with Templates

You can avoid the routine, repetitive work of creating new appraisals if you base them on templates 
designed for the types of development appraisal you create most often.

A template is an outline for the type of development, its costs, fees, yields and calculation options.

ARGUS Developer provides several templates. You can use them as they are or tailor them to your 
specific requirements.

Templates are held in a location common to all users of the system. The default location for 
templates is the Template folder within the installation folder. This is set on the Data File 
Locations page of System Configuration screen, which can be accessed by selecting 
Administration from the File menu (File | Administration | System Configuration | Data File 
Locations). Templates are stored as .ptl files.

By defining templates, you can ensure that all users start with your company default assumptions 
and fees. You might like to add non-standard fees and costs that are not pre-defined on the 
Definitions screen, for example Income from Advertisement Hoardings or Building Regulations 
fees.

Starting a New Project from a Template
You can save time by basing new projects on any of the stored project templates. 

From the File menu, choose New (Template), and then, if you have more than one template 
defined, select the template you wish to use from the list in the Start New Project form. ARGUS 
Developer opens a copy of the template as a new project.

Alternatively, clicking on the Start New Project button automatically opens the default template. 
The default template is set in File | Administration | System Configuration | Country.
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When the template has loaded, you can start work on the project by entering the title, address and 
so on, followed by the timescale, finance rates and residual options. The default assumptions and 
fees will be in place and you can start to enter your costs and receipts.

Modifying and Creating Templates
You can modify a template just as you would a project: open the template, edit the assumptions and 
fees, and then save the template. Creating a template is similar to creating and editing any normal 
project.

To modify an existing template
1. Open the template by selecting New (Template) from the File menu or by clicking onto the 

Start New Project button to open the default template.

2. Make any modifications.

3. Save the data file under the same file name, using Save As from the File menu.

To base a new template on an existing template
1. Open an existing template by selecting New (Template) from the File menu and selecting the 

template from the list provided in the Start New Project form.

2. Make any modifications.

3. Save the data file as a new template, by selecting Save As from the File menu and saving the 
file under a new name as a project template (.ptl) file type in the Template folder.

To base a new template on the Default Project template
1. Click on the Start New Project button on the toolbar to open the default template.

2. Make any modifications.

3. Save the data file as a new template, by selecting Save As from the File menu and saving the 
file under a new name as a project template (.ptl) file type in the Template folder.

To base a new template on an existing project
1. Open the project by selecting Open from the File menu or by clicking onto the Open Project 

button.

2. Make any modifications.

3. Save the project file as a new template, by selecting Save As from the File menu and saving the 
file as a project template (.ptl) file type in the Template folder.

Related Fees
An area record must be created in the cash flow before entering any percentage-related area-based 
fees. Examples of these fees include Contingency and Professional Fees. You need not fill in any of 
the headings, areas or rates in the area records.

You should, therefore, add blank Capitalized Rent and Unit Sales area records to your template. If 
you do not add these records, fee relations will not be up to date.

To create a blank area record in the cash flow
1. Go to the Definition screen.

2. Open either the Capitalized Rent or the Unit Sales area schedule.

3. Select the Save Zero Value Items option from the Options menu.

4. Click on the Done button.

Opening an Existing Template
You can open an existing project template by choosing New (Template) from the File menu.
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Select the template you want from the list in the Start New Project form. If you don’t see the file 
you want in the Template directory, use the browser to view another drive or directory.

Saving a Template
You can save a project template by using the File | Save As... menu option and saving it as Project 
Template file type (.ptl). By default, ARGUS Developer will save a template file into the Template 
folder. 

If you are running ARGUS Developer from a network, and have a common Template directory, the 
project template is then immediately available to all users.

To save a new template
1. Use the File | Save As... menu option.

2. Check that the new template is being saved into the Template folder or browse to another 
location, if required. Type the name into the File name field.

3. Select project template (.ptl) file type and click on Save.

To replace an existing template
1. Use the File | Save As... menu option.

2. Browse to select the template to be replaced from the file list. 

3. Confirm that you want to make permanent changes to the template.

Add new phases from Default Template
1. Use the Tools | Options... menu option.

2. Check the Add new phase from Default Template check box.
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CHAPTER 20
Spot Residual Values

You can obtain a residual value for many fields other than Land Value by selecting a field in 
Definition, or a row in the Cash Flow, and selecting Spot Residual Value from the Tools menu. 
Alternatively, you can press the F6 function key:

The spot residual function is available in Capitalized Rent and Unit Sales by clicking on the Spot 
Residual button, and in the Additional Revenues/Costs/Related schedules by selecting Spot 
Residual from the Edit menu.

If you attempt to run a spot residual in an incompatible field in Definition, a warning message is 
displayed.

ARGUS Developer must be in Fixed Land Cost mode before the spot residual can be run. If you 
select the function while the Land Residual mode is active, a warning will be displayed.

You will then be given the opportunity of switching to Fixed Land Cost mode, either retaining the 
calculated land value or removing this amount, and running the spot residual.

Select the result variable to be targeted by making a selection from the Target Type box. Next, 
enter the target value and click OK.

In some cases, ARGUS Developer will be unable to produce a result. A warning will be displayed 
and the data returned to its original state.

If a related percentage fee is the subject of the spot residual calculation, and its value drops below 
zero, a warning will be displayed and the fee percentage returned to its original state.
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Area-based Residuals

You can run spot residual calculations from within the area schedules for Capitalized Rent or Unit 
Sales by clicking on the Spot Residuals button. The spot residual function can be used to 
determine build costs, rents or sales values to fine tune a development.

When an area field is residualized, the program recalculates the area and updates the cash flow. If 
the resultant value is either negative or does not achieve the target profit, the current area and the 
cash flow are returned to their original state.

The fields available for spot residualizing within the area schedules are shown in the table below:

To residualize an area field
1. Click into the selected field and either click onto the Spot Residuals button or press the F6 key.

2. Enter the Target Type and Value and click OK.

Cash Flow-based Residuals
You can run spot residuals from within the cash flow across a range of different types of item: fixed 
amounts, percentage-related fees and area-based amounts.

If you choose a valid area-based row, the program will adjust the contents of the area record 
automatically. 

If you choose an MRV row, the Capitalized Rent will be updated automatically.

If you chose a Capitalized Rent row, the program may adjust either the Cap Rate or the MRV rate 
to arrive at the target value. To specify which variable is recalculated when the Capital Value is 
modified, select either Recalculate the Cap Rate or Recalculate the Rent Rate or Market 
Rental Value on the Receipts tab of Assumptions for Calculation. 

Note: You will not be able to residualize Rent Free Costs. These are calculated from an 
integral number of months and the residual function returns a non-integral value. Neither 
will you be able to residualize rents when tenants’ rental income streams are generated in the 
cash flow.

To residualize a cash flow row
1. Click into a cell in the selected row, and select Spot Residual Value from the Tools menu or 

right-click within a cell and select Spot Residual from the drop-down menu. Alternatively, you 
can press the F6 key.

2. Enter the Target Type and Value and click OK.

Building Rent Sales

Gross Area Net Area Net Area

Build Rate Annual Rent Rate (MRV rate pf2/pm2 p.a.) Sales Rate

Cost/Unit Annual Rent/Unit Sales/Unit

Gross Cost Annual Gross Rent Gross Sales

Cap Rate %

Manual Capital Value



Chapter 21:  Importing and Exporting Data 241

ARGUS Developer version 4.05 Reference Manual

CHAPTER 21
Importing and Exporting Data

If you have tenant or property details held in another system and want to use them in ARGUS 
Developer, you can import Area Definitions into ARGUS Developer by using the Import and 
Export Wizard.

The import function allows the user to add tenant/property information from a text file into the 
ARGUS Developer area schedules. The text file could be generated by any system that can output 
comma separated variable (CSV) files. It should have the extension .TXT.

For further information about the format of the interface file, please contact ARGUS Support.

Importing Data
The Import and Export Wizard will guide you through the process of getting information from 
another application into ARGUS Developer.

The Import and Export Wizard can be opened by selecting File | Import and Export | Import and 
Export Wizard...

To import floorspace details into a file for the first time
1. On the File menu, click Import and Export | Import and Export Wizard....

2. Select Import Area Schedule, then click the Next button.

3. Choose the file you want to import by entering its name or by using the browser button.

4. Uncheck the Update existing area definitions with new data and Ask before overwriting 
check boxes.

5. Click the Finish button.
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To re-import data into an existing project
1. On the File menu, click Import and Export | Import and Export Wizard....

2. Select Import Area Schedule, then click the Next button.

3. Choose the file you want to import by entering its name in the Import File field or by using the 
browser button.

4. Choose the required import options (see table below).

5. Click the Finish button to complete the process.

Exporting Data
When you wish to use the data you have created in ARGUS Developer in another package, you can 
use the Import and Export Wizard. For example, you may wish to use the cash flow data and 
combine it with floorspace information to perform analysis on a property, or to use the development 
costs only to model the refurbishment of a property in ARGUS Valuation - Capitalisation.

ARGUS Developer data can also be exported into ARGUS Multiview and ARGUS Development 
Budget.

You can export ARGUS Developer’s data to a range of applications: Microsoft® Excel®, ARGUS 
Valuation - Capitalisation® and to any other application that accepts Comma Separated Value files.

Microsoft® Excel®
Excel® provides the ultimate in flexibility when working with numerical data such as cash flows. 
Formatting functions allow you to present your information in a variety of styles, and its formula-
based approach allows you to combine different figures for detailed analysis.

To Do this
Overwrite the project’s existing area 
definitions. Areas will be matched on the 
Heading and Phase Number.

Check the Update existing area definitions 
with new data check box.

Add definitions as new records. Uncheck the Update existing area definitions 
with new data check box.

Review definitions before overwriting. Check the Ask before overwriting check box.
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Working closely with Excel®, ARGUS Developer defines a set of templates that can be used for 
presentation and analysis of cash flows and appraisal summaries. Templates are provided to handle 
the differing types of data generated by a development project.

Export to Excel®
When you export into Excel®, ARGUS Developer will open up the application on your desktop 
and push the data into one of several pre-defined templates. The template and the data are chosen 
according to the type of report that you want to create.

A simple report will contain a detailed line-by-line cash flow for each item in the project. After the 
data section, the GST and Interest value rows are included, followed by the column totals. When 
the report has been pushed to Excel®, ARGUS Developer will provide some additional formatting 
for the row and column headings.

Export to ARGUS Valuation - Capitalisation®
The export to ARGUS Valuation - Capitalisation produces a file that contains all the information 
required to generate an investment cash flow. The ARGUS Valuation - Capitalisation cash flow 
calculates a single Purchase Price and one Capitalization value for each tenant. Since ARGUS 
Developer also calculates these values for each project, you are given the option to suppress these 
values to avoid double-counting. 

After the export has been completed, you will need to go into ARGUS Valuation - Capitalisation 
and attach the export data file to the relevant portfolio or property.

Export to ARGUS Multiview®
ARGUS Developer cash flow data can be exported to ARGUS Multiview. It will save the file as a  
.CCF file and then ARGUS Multiview can read these files.

Export to ARGUS Development Budget®
ARGUS Developer cash flow data can be exported to ARGUS Development Budget. It will save 
the file as a .XML file, and ARGUS Development Budget can then import these files. See also 
“Exporting data to ARGUS Development Budget®” on page 246 for a step-by-step description of 
the procedure.

Export to Comma Separated Values file
ARGUS Developer data can also be exported to Comma Separated Value files (.CSV). These can 
be opened in other applications such as word processors, spreadsheets, databases and other 
proprietary packages.

When the export has been completed, you can go to another package and open the file. At this 
point, there may be options available for importing the file.

Export to reXML®
ARGUS Developer data can be exported to reXML, in the form of specially-formatted XML files. 
These files can be opened in products compatible with reXML.

To export files in reXML format, use the File | Import and Export | Export to reXML... menu 
option. You will be prompted to enter a file name and location. See also “Exporting data to 
reXML” on page 250.
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Export to Version 2.06
For occasions when you need backwards compatibility, you can save ARGUS Developer files in 
Visual Developer 2.06 format.

To export files in 2.06 format, use the File | Import and Export | Export to Version 2.06... menu 
option. You will be prompted to enter a file name and location.

Alternatively, you can use the the Import and Export Wizard to perform the same task.

Import and Export Wizard
The Wizard will guide you through the process of getting your data from ARGUS Developer into 
another application.

On the File menu, select Import and Export | Import and Export Wizard...

You then have several options:

• Import Area Schedule

• Export Area Schedule

• Export Cash Flow

• Export Project Pro Forma

• Export to version 2.06 (WCF version 20) format

Follow the instructions in the Import and Export Wizard to complete the process.

Export Cash Flow
1. Select Import and Export | Import and Export Wizard... from the File menu, and click onto 

the Export Cash Flow option, then click Next.

2. Choose to export to Microsoft Excel, ARGUS Valuation - Capitalisation, ARGUS 
Multiview, ARGUS Development Budget or as Comma Separated Values, then click Next.
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a) To export the data to Microsoft Excel, there are several options:

Create a Simple Cash Flow Report. You must then enter the cash flow cycle required (in months) 
and specify whether hidden row values and group labels are to be exported. To reduce the number 
of rows of data in the exported cash flow, uncheck both these check boxes.

Create a new Cash Flow Analysis Report. Choose a template for the report from the list provided 
or, if you do not see the template you require in the default Excel Analysis Template folder, use the 
browser to view another drive or directory.

Update an existing Cash Flow Analysis Report. Choose a report from the list provided or, if you 
do not see the report you require, use the browser to view another drive or directory. See “Updating 
an existing Cash Flow Analysis Report” on page 246 for a quicker way to get to this section.

Click Next then Finish to complete the export process.

b) To export the data to ARGUS Valuation - Capitalisation, you must specify whether the 
Purchase Price and Capitalization are to be exported. To suppress these values, uncheck the Export 
Purchase Price and Fees and Export Capitalization and Fee options. Click Finish.
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c) To export the data as Comma Separated Values, enter the cash flow cycle required (in months) 
and specify whether hidden row values and group labels are to be exported. To reduce the number 
of rows of data in the exported cash flow, uncheck both tick boxes. Click Finish to complete the 
process.

Updating an existing Cash Flow Analysis Report
If you have already created an existing cash flow analysis report in an Excel file, you may wish to 
update this frequently. To make this process quicker, a separate menu option is available for this 
purpose, so you don’t have to spend time clicking on options in the Import and Export Wizard.

Use the File | Import and Export | Update Analysis Report... menu option to open this specific 
part of the Import and Export Wizard:

Select the appropriate file and click Finish to complete the process.

Exporting data to ARGUS Development Budget®
If you have ARGUS Development Budget, you will want to export data from ARGUS Developer.
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To do this, you will have to arrange the data in a form that can be easily read by ARGUS 
Development Budget. To structure your data correctly, you should use the same cost codes in both 
systems.

To use the same cost code structure as ARGUS Development Budget, you can create a cost code 
template file (this is an XML file containing all the cost code items that you have set up in ARGUS 
Development Budget - see “Exporting a Cost Code Set” in your ARGUS Development Budget 
reference manual for further details).

Once you have created this template file, you can proceed to convert your data in ARGUS 
Developer.

Use the Cost Codes | Cost Code Setup... menu option to open the Cost Code Setup window:

Click on the Use Cost Codes for this project check box.

Use the Cost Code File control to browse for the XML file you created. If you followed the 
instructions in your ARGUS Development Budget reference manual, you should find the XML file 
in ARGUS Developer’s Template directory (for example, C:\Program Files\ARGUS 
Software\ARGUS Developer\Template).

When you have selected the XML file, the Default Cost Code and Finance Charge Cost Code 
drop-downs will be populated with a list of all the cost code items.

Use the Default Cost Code drop-down to select a cost code that will be used as an initial default 
setting for all the cost items in the cash flow. This is optional - you can leave it blank by deleting 
the text from the field.

You can change the number of cost codes that are shown in these drop-downs by specifying a 
number in the Number of Codes for Selection box.

Click on the OK button to proceed.

A message will be displayed (this message will be displayed each time you change the settings):

Click on the Yes button to proceed.

Open your cash flow by clicking on the Cash Flow tab.

You will notice that there is a new Cost Code column in the cash flow, each cell containing the cost 
code that you selected for use as the default cost code.
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This default cost code (which is an initial setting) will need to be replaced by the correct cost code. 
To assign the correct cost codes, click on the drop-down arrow and scroll through the list of cost 
codes. Select the cost code that most closely matches the row item in the cash flow:

Perform this procedure for all the items shown in the cash flow.

Alternatively, you can assign these cost codes by going into each of the editors that are called from 
the Definition page. To do this, click on the Definition tab.

Click on the Detail View button  next to any of the cost items to open the editor window:

In the Cost Code column, you can select the appropriate cost code from the drop-down list.

Once you have finished setting up all the cost code assignments, you will want to export the cash 
flow in ARGUS Development Budget format.
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To do this, use the File | Import and Export | Import and Export Wizard... menu option to open 
the Import and Export Wizard:

Select the Export Cash Flow option and click on Next to proceed.

Select the ARGUS Development Budget option and click on the Finish button.
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You will be prompted to enter a name for the export file:

Type in a name for the XML file and click on Save to proceed.

The file should now be ready for you to import into a budget worksheet in ARGUS Development 
Budget, using the Forecast Data Wizard. See “Importing data into the budget worksheet” in your 
ARGUS Development Budget reference manual.

Exporting data to reXML
ARGUS Developer data can be exported to reXML, in the form of specially-formatted XML files. 
The resulting files can be opened in products compatible with reXML (such as ARGUS Valuation - 
DCF).

To export files in reXML format, use the File | Import and Export | Export to reXML... menu 
option to open a dialog like the following (the default export function is shown below):

See the following section for information about the options in this dialog.

Available options for exporting to reXML
Regardless of the status of the check box selections, when you click OK, ARGUS Developer will 
display a standard Save As... dialog that prompts for an export file name:
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Once the file name is entered (it defaults to the name of the current Developer file, but with an 
.XML extension), the XML export file is written and the program returns to the main Developer  
workspace. This file can be read by ARGUS Valuation-DCF using the appropriate File Import/
Export menu option when there is no DCF file open.

The default setting (where Start Projection from earliest Lease start date is left unchecked) as 
shown in the picture at the start of this section, exports the monthly development cost and basic 
Area information from the start month to the last month of the Project as defined in ARGUS 
Developer. Note that Sales values and Finance information are not exported. Also note that no Unit 
Area assumption or calculation information is written to the file - this export includes only Cap 
Area record information.

What is exported when using this option:

• Project Name, Start Date, End Date.

• All project development costs, line by line and month by month, for the currently selected 
Phase or Group of Phases as Development Costs. These are categorized as Land/Acquisition 
Costs, Hard/Construction Costs, or Soft/Development Costs as appropriate.
Note that Finance Costs are not part of Development Costs.

• All “Cap Areas” (lease records) from all selected Phases, with basic rent roll information - 
Name, Type, Size, Start Date, Term/Expire, Detail Base rent prior to vacancy allowance (if any) 
over the term of the lease, and Market Leasing Assumption categorization which is based on 
unique Market Rent and Length of term within the Developer file.
Note that Cap Area data does not include TIs, Commissions, Vacant Costs, Rent Additions and 
Costs.

• Operated Asset revenue and expense information is not exported.

If the Start Projection from earliest Lease Start Date option is checked, you have the further 
option to choose whether or not to check the Export Development costs option.

If the Export Development costs option is not checked, there are no costs exported to the XML 
file - only Area information, in the same detail as described above.

If the Export Development costs option is checked, development costs up to, but not including the 
earliest lease start date for the current phase view are written to the XML file, as a single lump sum 
on a specific line headed “Costs Prior to Leasing”. The other development costs occurring on or 
after the earliest lease start date are listed individually and monthly by line item.

Note: The ARGUS Developer file name will be exported as the property name - this is used by 
ARGUS Valuation-DCF to search for a file name to update if “Update model” is chosen.
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CHAPTER 22
Working with Other Currencies

Convert your project into another currency by selecting Currency from the Tools menu.

The currency conversion function is available in the Project, Definition, Cash Flow or Project Pro 
Forma screens.

When you first enter the currency screen, you will see your home currency on the first row of the 
table. To enable currency conversion, you must add the appropriate currency to the table by 
entering its name, symbol and conversion rate. Multiple entries can be made as required.

To add a new currency, click on the Add Currency button or select Add Currency from the Edit 
menu. A new row will appear in the table in which you should enter the name of the currency you 
wish to use, the symbol used to represent the currency and the conversion rate (Units/Home Rate) 
to be used.

To delete an item from the currency list, select the item and click on the Delete Currency button or 
select Delete Currency from the Edit menu. 

To convert your project to a new currency, check the Home Rate? option check box for the 
required currency and ARGUS Developer will convert all values in the project using the Units/
Home Rate entered. You can enter amounts to 6 decimal places.

During the conversion, ARGUS Developer works through each of the Capitalized Rent and Unit 
Sales definitions from the area schedules, and converts the rates and unit values. All Gross Costs 
and Capital Values are then recalculated and written to the cash flow.

Next, all the fixed values are converted and the project is recalculated. All reports will now show 
the converted values with the appropriate currency symbol.
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CHAPTER 23
Use Type Classes

You can customize the list of Use Type Classes to include an unlimited number of descriptions. A 
Use Type can be recorded against each tenant or property entered in the Area Schedules.

ARGUS Developer comes with a Fixed, or standard, set of Use Type Classes. Additional types can 
be entered under the Custom heading.

To customize Use Classes, use the File | Administration | Edit Use Types... menu option and click 
on the Custom tab in the Use Type Classes editor:

Adding a new Use Type - to add a new Use Type Class, click on the Add a Use Type button on 
the toolbar, or use the Use Type | Add Use Type... menu option. This opens the following dialog:

Enter the name of the new use class into the text box and click OK.
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Deleting a Use Type - to delete a Use Type Class, select the use type and click on the Delete a Use 
Type button on the toolbar, or use the Use Type | Delete Use Type... menu option.

Changes to the list are immediately available to the person who made the change. They are only 
available to other users once they have closed and reopened the software.

Note: ARGUS recommends that no other users are running ARGUS Developer when the 
changes are made. After changes have been made, the user who made the changes should 
then close the program before everyone is allowed access once more.

The list of use type classes is saved with each project data file. This ensures that your use type 
classes are available to any clients or colleagues to whom you send the project data.
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CHAPTER 24
System Configuration

There are a number of options available to change the system configuration. These can be accessed 
by selecting System Configuration from the Administration option in the File menu.

Country
ARGUS Developer takes country-specific formatting instructions directly from the Windows 
operating system installed on your PC. However, where you are preparing a development appraisal 
that must be formatted for another country, you will need to change some of the formatting 
instructions.

You can use the Country settings to change the way in which numbers are formatted. The Country 
settings will be stored with the project data file and will remain in effect until you change them or 
select the Start New Project button. After selecting the Start New Project button, the Country 
settings will revert to the Windows defaults stored in your default project file.

To add a new configuration, click on the Add Configuration button on the toolbar.
Select a Country from the drop-down list, enter a configuration name into the dialog box and press 
OK.

To delete a configuration, select the configuration from the Country drop-down list and click on the 
Remove Configuration button on the toolbar.
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Language
Select the required language from the drop-down list.

Country
Select the name of the Country from the drop-down list. This does not automatically fill in the 
other fields on this screen.

Country Specific Settings
New Project Template
Select the default new project template from the drop-down list. This is the default template that is 
opened by clicking on the Start New Project button.

Various check boxes enable certain options to be enabled or disabled in the program for different 
country configurations:

• Include Gross Sales Tax screens
If this is checked, then the Gross Sales Tax screens are enabled and can be opened by clicking 
on the GST Schedule button. If this option is not checked, then the GST Schedule button is 
removed from the button bar and the Gross Sales Tax screens are not available for use.

• Include ITZA rent screens
To activate the Retail Zoning (Area ITZA) rent screens this option should be checked. ITZA 
definition screens may then be opened in the Capitalized Rent form by clicking on the Retail 
Zoning (Area ITZA) button or selecting Zoning (Area ITZA) from the Area menu. If this is 
unchecked, then the ITZA options are disabled.

• Include Leasehold Valuations
To enable the valuation of leasehold interests, defined in the Capitalized Rent screen, this option 
must be checked. If this option is unchecked, then freehold interests only may be valued.

• Show Leasing/Rent Review Fees options
If this option is checked, users may specify whether Leasing/Rent Review fees are calculated on 
gross MRV or MRV net of deductions. These options may be selected in the Calculation tab of 
Assumptions for Calculations. If this box is not checked, these options are hidden.

• Show Undrawn Loan Fees
If this option is checked, undrawn loan fees are displayed on the the Finance Fees page of the 
Finance window (see “Assumptions Setup: Finance Fees tab” on page 150).

• Show Municipal Costs
To enable the definition of Municipal Costs in the Definition screen, this box must be checked. 
If this option is unchecked, the Municipal Costs field will not be visible in the Definition 
screen.

• Show Purchaser’s Costs
To enable the definition of Purchaser’s Costs in the Definition screen, this box must be checked. 
If this option is unchecked, the Purchaser’s Costs field will not be visible in the Definition 
screen.

• Show Developer’s Profit
If this is checked, the Developer’s Profit option may be selected from the Definition menu in 
the toolbar. If this is not checked, Developer’s Profit is disabled.

• Show Net Development Yield option
If this option is checked, then the user may specify whether the calculation of the Development 
Yield is to be net of service charge and deductions and net of ground rent. These options may be 
defined in the Calculation tab of Assumptions for Calculation. If this box is not checked, these 
options are hidden.

• Show Margin Tax option
To enable the definition of Margin Tax in the Gross Sales Tax dialog and Cash Flow screen, this 
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box must be checked. If this option is unchecked, the Margin Tax options will not be visible in 
the Gross Sales Tax dialog or Cash Flow screen. This feature is not used in the USA or Canada.

• Show Section 106 and Section 278 Costs
To enable the definition of Section 106 and Section 278 costs in the Definition screen, this box 
must be checked. If this option is unchecked, the Section 106 Costs and Section 278 Costs will 
not be available as menu options when you click on the Other Construction button in the 
Definition screen. This feature is not used in the USA or Canada.

• Enable Annual % Finance Fees
To enable the editing of the % pa Amount field in the Finance Fees tab (in the Structured 
Finance screen, when you have the “Related” fee type selected), this box must be checked. If 
this option is unchecked, the % pa Amount field will not be editable. See also “Assumptions 
Setup: Finance Fees tab” on page 150.

Format
The Format tab allows currency and other settings to be defined for project templates and for the 
current project listed in the Templates box. 

Select the current project or template from the Templates list provided.

To edit the settings for the selected template or project, click onto the Edit button. This enables the 
Format Settings fields to be amended, as shown below. Click Save to save changes, or Cancel to 
return to the default settings for the selected template.

Country
Type in the country name.

Decimal Symbol
Enter the symbol to be used for indicating decimal values into the Decimal Symbol box.

1000’s Grouping Symbol
Enter the symbol that will be used to group the digits in large values into the 1000’s Grouping 
Symbol box.
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Currency Symbol
Enter the symbol that identifies a country’s currency into the Currency Symbol box.

Position of Currency Symbol
You can specify where the currency symbol appears in relation to a currency value. A placeholder 
symbol represents the setting that is specified in the Currency Symbol box.

Set for Current Locale
This resets all the settings in the Format tab for the selected template to those defined for the 
current locale.

Set from <country> Locale
This resets all the settings in the Format tab for the default template to those defined for the 
selected country configuration, as defined on the Country tab of System Configuration.

Reports
The Reports tab provides a list of all reports available in ARGUS Developer. Only those reports 
which are checked in the Show? column will be visible and available for selection by users from 
the Report Printer form.
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Colors
You can change the colors that ARGUS Developer uses to display text and numbers on screen by 
making settings on the Colors tab.

To change a setting, select the item you want from the Scheme Element list, and click in the Color 
column alongside it. Then, select a color from the palette:

Color Scheme
You can choose from a variety of color schemes that are coordinated throughout ARGUS 
Developer. You can change colors at any time without affecting your project data.

You can select existing color schemes from the Color Scheme drop-down.

For each of the color schemes, the color of text and backgrounds in the Cash Flow, Results Bar, 
Project Pro Forma and Phase tab highlight can be customized. To do this, click in the Color column 
for the required scheme element and the color palette (as shown above) allows you to select the 
color for that specific element.
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Note: The color schemes work best on monitors that can display 16-bit colors or more. If you 
only have 16 or 256 colors available, use the “Default” color scheme. Ask your Systems 
Administrator for information on setting up your monitor to display more colors.

Reset to Default Colors

If you wish to cancel all changes and return to the default colors, click the Reset to Default Colors 
button. You will be prompted to confirm that you wish to reset the color scheme:

Data File Locations
Use the Data File Locations tab to tell ARGUS Developer where to load and save its data files.

User Data Folder
The default location for saving and loading data files. The Data folder is common to all users of the 
system.

General Template Folder
The default location for the template data files. The templates control the creation of the Cash Flow 
and the layout of the Project Pro Forma. They are common to all users of the system.

If you create any Project Template files, they should be stored in this directory.

General Excel Template Folder
The default location for general Excel template files which are used when data is exported into 
Excel as a simple cash flow. They are common to all users of the system.

Cash Flow Analysis Excel Template Folder
The default location for Cash Flow Analysis Excel template files. The templates are used when 
data is exported into Excel to create analysis reports. They are common to all users of the system.

Report Folder
The location of report template files.

Backup Folder
The default location for saving backup files. When the option to create backups is selected, backup 
files are created each time a data file is saved. The Backup Directory is common to all users of the 
system.

International Folder
The location of files used for translations of the program into different languages. Each country has 
a sub-folder containing the translation dictionaries.
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Properties
By selecting Properties... from the File menu in the main ARGUS Developer window, you can 
view information relating to the open project file.

General tab

File name The file name which was given to the file when it was last saved.

Location The filename and path where the file is currently saved.

Type of file Description of file type.

Format This will be either ARGUS or ARGUS XML windows cash flow.

Size (in Bytes) The size of the file in bytes.

Last Save Date The date and time of the last time the file was saved.
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Last Save Program Version The program version in which the file was last saved. 

Attributes Indicates whether the data file is read-only or not. If the check box is ticked, the file is 
read-only.

Tracking tab
The Tracking tab enables you to see the save history of the file.

Created By The name of the user. This is taken from the Created by field on the Project page.

Machine/User Name The name used to identify your computer and user name within your 
organization. This also identifies changes made to the file when it is sent to another organization.

Company The Company Name. This is taken from the license name issued when the license was 
activated.

Date Saved The date and time of the last time the file was saved by that particular user.

Version The program version in which the file was saved.
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CHAPTER 25
Changing Settings and Display 
Options

Options
You can change many of the default settings to customize the way in which ARGUS Developer 
works. For example, you may want to:

• Automatically save your project at specified intervals while you work;

• Change the units of measurement;

• Change the font settings.

To change the default settings, choose Options from the Tools menu.

Alternatively, in the Cash Flow and Project Pro Forma, you can click the Options button: 

The Options dialog box is divided into four tabs: General, Cash Flow, Project Pro Forma and 
Save. 

When you select a tab, the options for that tab are shown. Settings are determined by selecting or 
clearing the check boxes or by typing or selecting new information. The new settings take effect 
when you close the dialog box by clicking the OK button, and remain in effect until you change 
them.

General
Display Options
Show Project Toolbar
You can hide the Project Toolbar from display to give more room on the screen. Clear the Show 
Project Toolbar check box to hide the toolbar.

Show Gray Background on Merged Fields
When this option is checked, the fields in the Definition screen for the Merged Phases tab will be 
displayed with a gray background and black font. If unchecked, the fields are displayed with a 
white background and gray font.

Show Names on Area Tabs
For the tenant/area name (from the Heading field in the Area Schedule) to appear on area tabs in 
the Area Schedules (Capitalized Rent and Unit Sales) check this option. If this option is unchecked, 
then the tabs will display the area number, such as Area 1, Area 2 and so on. This applies to both 
Capitalized Rent and Unit Sales entries.

Show Names on Phase Tabs
For the Phase Name to appear on phase tabs, check the Show Names on Phase Tabs option. If this 
check box is cleared, the standard phase numbering will appear on phase tabs, such as Phase 1, 
Phase 2, and so on.
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Dialogs Follow Main Window
If this option is checked, dialog boxes will automatically open in the main window in which the 
ARGUS Developer program is open. If this option is unchecked, the dialog will open in the 
window in which it was last closed.

This option only applies if you have more than one monitor.

Show Unit Sales Buttons
For users who do not intend to work on developments involving Non-Capitalized Sales, you may 
prefer to hide the button that opens the Unit Sales form in the Definition screen. Clear the Show 
Unit Sales Buttons check box to hide this option in the Definition screen.

Show Single/Multi Sales Buttons
You may prefer to hide the buttons that open the Single Unit Sales and Multi Unit Sales forms in 
the Definition screen. Clear the Show Single/Multi Sales Buttons check box to hide these options 
in the Definition screen.

Show Version in Title Bar
Check this check box if you wish to display the ARGUS Developer version number in the main 
title bar.

Formatting Options
Number of Decimals
To increase or decrease the precision of figures on the Project Pro Forma and printed reports, you 
can specify the number of decimal places using the spinner arrows.

Measurement Units
Specifies whether the floor space definitions are held in Imperial (square feet) or Metric (square 
meters). Changing this option will recalculate all area-based definitions to the new standard. Floor 
space, rent, sales and construction rates are converted. In addition, all step increments in the 
Sensitivity Analysis function will be converted.
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The Site Area will also be converted between the two standards.

Note: Switching between the two standards can create small discrepancies due to metric area 
measurements and monetary values being held to two decimal places.

Land Measured in
Specifies the unit of measurement for the Site Area. The units are displayed against the Site Area 
field on the Definition page. When you enter a value into the Site Area field, the Project Pro Forma 
shows the cost of the land per unit of measurement.

Add New Phases from Default Template
This check box allows you to specify whether or not new phases will use the default template when 
you create them.

Reset Actions
Reset Window Positions and Sizes
This option resets all window positions and sizes to the default settings.

Restore Hidden Prompts
When prompt messages appear in the program, the user is given the option to choose not to be 
asked again for the project. Checking this option will restore hidden prompts when a user has 
previously opted not to be prompted again.

Timescale and Phasing
Add New Phases from Default Template
When adding a new phase, if you wish this new phase to include default information such as 
timescale, fee relations, escalation sets etc, from your default template, check the Add New Phases 
from Default Template option. If this option is unchecked, then ARGUS Developer will create a 
new blank phase.

Cash Flow
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Show Row Properties
If this option is checked, additional columns will be displayed on the left hand side of the Cash 
Flow screen, setting out the properties of each row in the cash flow. You can display more data 
columns in the Cash Flow by clearing this check box to hide these fixed columns.

Show Brief Finance Details
When Basic Finance (Interest Sets) is applied to a project, you can hide some of the GST, Interest 
and Inflation data rows in the Finance Cash Flow by selecting this option. Select the Brief Finance 
Display check box to hide Interest and Inflation Rate rows. If GST has been set for any items, the 
program will show GST paid and reclaimed, regardless of the Brief Finance Details check box 
setting.

Show Row Total Column
An additional column at the start of the cash flow is displayed showing row totals when this option 
is checked. Clear the Show Row Total Columns check box to hide this column.

Show PV Column
An additional column at the start of the cash flow is displayed showing the row total’s Present 
Value when this option is checked. Clear the Show PV Column check box to hide this column.

Show Timeline
The Timeline is displayed at the top of the cash flow directly beneath the date row, indicating the 
duration of each stage of the project, when this option is selected. If this check box is cleared, the 
timeline will not be displayed.

Show Period Zero
If you check this option, period zero will be displayed in the Cash Flow and in the Data 
Distribution window, on the Editor tab (see “Data Distribution” on page 111). By default, this 
option is switched off.

Show MRV History Rows
If this option is checked, additional rows will be displayed in the cash flow showing the market 
rental value (MRV) for each unit of accommodation defined in the Capitalized Rent screen during 
the cash flow, taking into account any rental escalation settings. These rows are hidden from 
calculations. To hide these rows from display, clear the Show MRV History Rows check box.

Show MRV Rows
If this option is checked, a separate row showing the market rental value (MRV) at exit for each 
unit of accommodation defined in the Capitalized Rent screen will be displayed in the cash flow. If 
this check box is cleared, then MRV rows will not be displayed.

Show Zero Value Rows
If this option is checked, all zero value rows will be displayed in the cash flow. If this option is not 
checked, then any zero value rows will not be displayed.

Show Unit Information Rows
If this option is checked, rows showing information about the number of units under construction 
will be displayed in the cash flow.

Show Summaries
If this option is checked, a summary total row will be displayed at the bottom of each section in the 
cash flow.

Show Summaries in Bold
If this option is checked, the summary total row will be displayed in bold.
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Formatting Options
Heading Column Width (Pixels)
This allows you to increase the width of the row heading column in the cash flow to accommodate 
long item headings in full. To change the width, type a value into the Heading Column Width box 
or use the spinner arrows.

Total Column Width (Pixels)
To change the column width for totals, type a value into the Total Column Width box or use the 
spinner arrows. This will define the width for the total column and PV column.

Data Column Width (Pixels)
If you are working with currencies that have a large number of digits, you may need to increase the 
width of the data columns to see each figure in full. To change the width, type a value into the Data 
Column Width box or use the spinner arrows.

Use 1000’s Separator
You can format numbers with or without a separator between every third digit. To include a 
separator, select the Use 1000’s Separator box.

Negative Number Format
You can choose from three different formats for displaying negative numbers in the cash flow: 
plain, –ve sign or bracketed.

Font for Cash Flow
You can choose the font used to display the Cash Flow data on screen. Click onto the Font for 
Cash Flow button to display the Font dialog box. You can select the font name and size, but not 
any of the other font properties.

Editing Options
Placement of value when editing non-monthly Cash Flow
If you are editing a cash flow that is displayed in a non-monthly cycle, such as quarterly or annual, 
ARGUS Developer needs to know where it should place any edited values. You have the option of 
placing the value at the start of the cycle or at the end of the cycle; in other words, if you were 
editing a quarterly cash flow, the value would be placed in either the first month of the quarter or in 
the final month of the quarter.

Remove linked area records after deletion
When you are deleting area-based rows from the cash flow, you can have the program 
automatically delete the area record that generated it. This means that any other rows linked to the 
same record, such as the MRV or Capitalized Rent will be automatically deleted.

Alternatively, rather than remove the area record, you can instruct the program to keep the area 
record and any linked rows. In this case, only part of the area record will be removed and its 
relevant field values set to zero.

To Do this
Delete the area record and any linked rows. Check the Remove Linked Area Records check 

box.
Keep the area record any linked rows. Uncheck the Remove Linked Area Records check 

box.
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Project Pro Forma

Investment Valuation
Select the Investment Valuation check box to show the full Investment Valuation on the Project 
Pro Forma page which displays a breakdown of each of the Unit Sales and Capitalized Rent 
definitions including the number of units, area, rate and yield. To show a summary of Sales and 
Rents, clear the Investment Valuation check box.

Itemized Tenant Income
When tenants’ income flow is activated in the cash flow, a breakdown by accommodation unit is 
displayed in the Project Pro Forma screen when the Itemized Tenant Income check box is 
selected. To display a single summary line only, clear this check box.

Itemized Construction Costs
To show a breakdown of each of the Construction Cost definitions that includes the number of 
units, area and rate, select the Itemized Construction Costs check box. To show a summary line 
instead, clear the check box.

Itemized Rent Free Costs
You can show a detailed list of the Rent Free costs by selecting the Itemized Rent Free Costs 
check box. To show a summary line that shows only the total cost, clear the check box.

Itemized Additional Revenue
You can show full schedule of additional revenue, including the heading and amount, by selecting 
the Itemized Additional Revenues check box. To show a summary line that shows only the total 
additional revenue, clear the check box.

Itemized Additional Costs
To show a full schedule of any additional costs defined, including the heading and amount, in 
Project Pro Forma, select the Itemized Additional Costs check box. To show a summary line that 
shows only the total costs, clear the check box.
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Itemized Fixed Acquisition Costs
A full schedule of all fixed acquisition costs will be displayed in the Project Pro Forma if this 
option is checked. To show a summary line of the total fixed acquisition costs only, clear the check 
box.

Itemized Other Professional Fees
You can show a full list of all the Other Professional Fees, including the heading, percentage and 
amount, by selecting this option. To show a summary line that displays only the total amount, clear 
the check box.

Itemized Other Acquisition Costs
To show a full schedule of Other Acquisition Costs in Project Pro Forma, select the Itemized 
Other Acquisition Costs check box. To show a summary line that shown only the total costs, clear 
the check box.

Itemized Other Construction Costs
You can show a full schedule of Other Construction Costs, including the heading and amount, by 
selecting the Itemized Other Construction Costs check box. To show a summary line that shows 
only the total costs, clear the check box.

Inflation/Escalation Schedule
The Inflation/Escalation schedule can be included at the end of the Project Pro Forma report by 
selecting the Inflation/Escalation Schedule check box. The schedule shows each item in the Area 
Schedules to which inflation or escalation has been applied. Each line shows the area item heading, 
the unescalated Capitalized Rent, the amount of escalation and the total Capitalized Rent (with 
escalation) for the item.

Timescale
You can show a summary of the phase timescale detailing the length and date of each stage by 
selecting the Timescale check box. This timescale summary is displayed in the Finance section of 
the Project Pro Forma. The timescale is only shown for single phase projects or, in a multi-phased 
scheme, when a single phase is viewed. 

IRR
There are several types of IRR you can specify here. You can suppress the display of the IRR on 
the Project Pro Forma screen and printed report by clearing any of the various IRR check boxes. To 
display the IRR, select the appropriate check box.

Profit on Cost, Profit on GDV
There are two types of profit you can specify here. You can enable or suppress the display of the 
Profit on Cost or Profit on GDV on the Project Pro Forma screen and printed report by checking or 
unchecking the appropriate check boxes.

Development Yield
You can enable or suppress the display of the Development Yield on the Project Pro Forma screen 
and printed report by checking or unchecking the check box.

Formatting Options
Visible Columns
The Project Pro Forma is displayed on an invisible grid. You can set the number of columns in the 
grid by typing a number between 5 and 8 into the Visible Columns box. The Project Pro Forma 
template has 7 columns at present; the extra one is for future expansion. You must set the number 
of visible columns to 7 in order to display the full Investment Valuation in the Project Pro Forma.



272 Chapter 25: Changing Settings and Display Options

ARGUS Developer version 4.05 Reference Manual

Heading Column Width (Pixels)
You can set the width of the column used to display the line headings by typing a number between 

50 and 300 into the Heading Column Width (Pixels) box. You may need to adjust this setting 

after changing the font size, or to suit the resolution of your monitor.

Data Column Width (Pixels)
You can set the width of the column used to display each item’s values, totals and sub-totals by 

typing a number between 40 and 300 into the Data Column Width (Pixels) box. You may need to 

adjust this setting after changing the font size, or to suit the resolution of your monitor.

Font for Project Pro Forma
The font used to display the Project Pro Forma on screen may be altered. Select the Font for 

Project Pro Forma button to display the Font dialog box. The font name and size can be changed, 

but not the other font properties.

Save

Always Create Backup File
Copies the previous version of a project to a backup file every time you save your project. Each 

new backup replaces the previous backup file. ARGUS Developer saves the file with the extension 

.WCK and places it in the Backup Directory specified in the Data File Locations tab in File | 

Administration | System Configuration...

Automatic Save
Automatically saves a copy of your project at the interval you enter in the Minutes box (enter a 

number from 1 to 120). If your computer hangs (stops responding) or you lose power unexpectedly, 

ARGUS Developer opens this file the next time you start. The file may contain unsaved 

information that would otherwise be lost from the project.

Note: The Automatic Save does not replace the Save command. You must still save your 

project when you finish working on it.

Show Automatic Save Messages
Shows a message indicating each time that it has performed the auto-save function based on the 

frequency suggested in the Automatic Save Every ....... Minutes box.
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CHAPTER 26
Contact details

Find us on the Web: http://www.argussoftware.com or http://www.arguszone.com

UK contact details:
ARGUS Software (UK)
London
UNITED KINGDOM

Tel : +44 (0)20 8906 4059 or 0845 6440 400

Fax: +44 (0)020 8959 6079

Support Tel : +44 (0)20 8238 8345
Support email: supportEU@argussoftware.com

Info email: infoEU@argussoftware.com

US contact details:
ARGUS Software
Houston, TX
USA

Tel : +1 713-621-4343
Fax: +1 713-621-2787

Support Tel: +1 888-472-1005
Support email: support@argussoftware.com

Info email: info@argussoftware.com

ARGUS Software
Plano, TX
USA

Tel : +1 469-791-1000
Fax: +1 469-791-1810

Support Tel: +1 888-472-1005
Support email: support@argussoftware.com

Info email: info@argussoftware.com

ARGUS Software
Cherry Hill, NJ
USA

Tel : +1 856-874-4449
Fax: +1 856-874-9179

Support Tel: +1 888-472-1005
Support email: support@argussoftware.com

Info email: info@argussoftware.com

Canada contact details:
ARGUS Software
Coquitlam, BC
CANADA

Toll-free: 1-888-472-1005
Tel : +1 604-472-1001
Fax: +1 604-472-1002

Support email: support@argussoftware.com

Info email: info@argussoftware.com

http://www.argussoftware.com
http://www.arguszone.com
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Australia and Asia Pacific region contact details:
ARGUS Software
Sydney NSW
AUSTRALIA

Tel : +61 2 9262 1332

Fax: +61 2 9262 1350

Support email: support@argussoftware.com

Info email: infoasiapacific@argussoftware.com

Malaysia and East Asia region contact details:
ARGUS Software
Kuala Lumpur
MALAYSIA

Tel : +603 6203 2876

Fax: +603 6203 1802

Support email: support@argussoftware.com

Info email: infoeastasia@argussoftware.com

Singapore region contact details:
ARGUS Software
SINGAPORE

Tel : +65 6332-9778

Fax: +65 6338-7959
Support email: support@argussoftware.com

Info email: info@argussoftware.com

Japan region contact details:
ARGUS Software
Kanagawa-Ken
JAPAN

Tel : +81 467-39-1187

Fax: +81 467-39-1186

Support email: support@argussoftware.com

Info email: info@argussoftware.com

South Africa region contact details:
ABO Software
Cape Town
SOUTH AFRICA

Toll-free: 080 226 7638

Tel : +27 (0)21 447 9592

Fax: +27 (0)21 426 2708
Info email: info@abosoftware.co.za
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A

Acquisition Costs 119
Acquisition Price 119
Fixed Acquisition Price 119
Land Transfer Tax 120
Other Acquisition Costs 122
Site Area 122

Adding a workspace 232
Additional Data 129

Additional Costs 131
Additional Related 131
Additional Revenue 130
Developer’s Profit 133
Rent Additions/Costs 132
Rent Review Fees 130
Sales Additions/Costs 133

Address 6
Administration 257

Colors 261
Color Schemes 261
Reset to Default Colors 262

Country 257
Country Specific Settings 258
Default New Project Template 258
Developer’s Profit 258
Gross Sales Tax 258
ITZA rents 258
Language 258
Leasehold Valuations 258
Leasing/Rent Review Fee options 258
Municipal Costs 258
Net Development Yield option 258
Purchaser’s Costs 258

Data File Locations 262
Backup Folder 262
CF Analysis Excel Template Folder

262
General Excel Template Folder 262
General Template Folder 262
International Folder 262
Report Folder 262
User Data Directory 262

Format 259
1000’s Grouping Symbol 259
Currency Symbol 260
Decimal Symbol 259
Position of Currency Symbol 260
Set for Current Locale 260
Set from country locale 260

Properties 263
Reports 260
Tracking 264

Amount per unit items 104
Anchoring phases 26
Anchoring stages 28
Area, Construction and Unit Sales

Unit Sales 53
ARGUS Development Budget 246
ARGUS Software web address 273
ARGUS Zone 3, 230
ARGUS Zone sidebar 3, 230

C

Calculation Assumptions 7

Calculation 13
Distribution 19
Expenditure 8
Finance 12
Inflation and Escalation 16
Interest Sets 15
Receipts 9
Residual Options 18

Capitalized Rent and Unit Sales 33
% Rents 42

% of Turnover 42
Breakpoint pm per unit area 43
Breakpoint Type 42
Sales Volume pa 42
Sales Volume pa per unit area 42
Turnover Rent Escalation 43

Annual Rent 39
% Vacancy/Fixed Non-rec Cost 40
Financial 45
Gross Sales Tax 45
Interest Set 45
Leasing Commissions Profile 40
Rent Additions/Costs 41
Rent Free Period 40

Area Options 65
Gross to Net Ratio 65
Imperial and Metric Units 66
Lock Gross - Net Ratio 65
Name Area Tabs 67
Rent Free Methods 66
Stepped Base Rent=MRV Rate 67
Tenant’s Income Stream 66
Valuation Tables 66

Construction Costs 37
Construction Interest 39
Cost Inflation 39
Financial 39
Gross Sales Tax 39
Timing of Construction Costs 37

Deposits/Pre-Sales 55
Floor Areas 36
General Area Information 36
Hotel Valuation 50
Lease Options 43

Monthly Rent Rates 45
Tenant Improvement Rate 44

Quick Entry Area Schedule 57
Rent Capitalization 52

Cap Rate% 52
Manual Capital Value 52
Timing of Sale 52

Stepped Rents 46
Cash Flow 179

Cash Flow Commands 184
Add New Row Options 186
Add Row 185
Cell Properties 193
Copy/Paste 184
Cut/Paste 185
Delete Row 186
Edit Source 186
Gross Sales Tax 190
Heading 187
Interest and Inflation 189
Lock/Unlock 187
Omit/Hide 187
Repeat 188
Row Properties 191
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Sign 189
Tag 193
Zero Row 191

Cash Flow Grid 182
Cash Flow Options 180
Cash Flow Toolbar 180
Cash Flow View Cycle 181
Export Cash Flow to Excel 193
Finance Cash Flow

Basic Finance (Interest Sets) 194
Current Inflation Set 195
Current Interest Set 195
Structured Finance 159, 196

Reports 209
Row Properties 181

Category 182, 191
Gross Sales Tax 182, 192
Group Order 191
Heading 181, 191
Hide 182, 192
Inflation 182, 192
Interest 182, 192
Interest Timing 192
Lock 182, 192
Order 191
Phase 182, 191
Relate 182, 192
Sign 182, 192
Sub Group 191
Tag 182, 191
Timing 192
Total 192

Settings and Display Options 267
Brief Finance Display 268
Data Column Width 269
Editing - Placement of Value 269
Font 269
Heading Column Width 269
MRV History Rows 268
MRV Rows 268
Negative Number Format 269
Period Zero 268
Remove Linked Area Records 269
Row Properties 268
Row Total Column 268
Timeline 268
Use 1000’s separator 269

What’s on the Cash Flow Screen? 179
Cashflow

Cash Flow View Cycle 197
Exporting to Excel 204
Settings and Display Options

PV Column 268
Show Summaries 268
Show Summaries in Bold 268
Total Column Width 269
Unit Information Rows 268
Zero Value Rows 268

Caveats 214
Cell Properties 193

Distribution 193
Fixed 193
Inflated Value 193
Period Number 193
Value 193

Change history 233
Checking a file in 233
Checking a file out 232

Colors 261
Company Name

Change the Company Name 210
Construction Cost Breakdown 63
Construction Costs 123

Municipal Costs 124
Other Construction Costs 124

Copy Down 60, 62
Copying an Operated Asset profile 89
Copying values 60
Cost Code File 247
Country 257

Country Specific Settings 258
Creating a Project 5, 227
Currency

Currency Conversion 253
Currency Symbol 260
Position of Currency Symbol 260

D

Data Checker 223
Filters 225
Fixing Data Checker Issues 224
Opening Data Checker 224

Data Distribution 19, 220
Construction Payments 19
Sales Deposits 20
Sales Receipts 20

Data File 262
Data File Locations 262

Backup Folder 262
CF Analysis Excel Template Folder 262
General Excel Template Folder 262
General Template Folder 262
Report Folder 262
User Data Directory 262

Default Cost Code 247
Definition 91
Deposits/Pre-Sales 55
Developer’s Profit 133, 258
Development Timescale 21
Distribution summaries on totals 200

E

Editing Data 94
Amount per unit items 104
Copying a Phase 115
Copying an Area 115
Customizing Labels 116
Fixed Amount Items 98
Related/Percentage Data 99

Email a Project 230
Entering Costs/Receipts

Definition 91
Field Expansion 91
Navigation 91
Results Bar 92

Entering Costs/Receipts and editing data 91
Escalation 16

Escalation Sets 16
Stepped 17

Export 193
Project Pro Forma 246

Export to reXML 243
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Export to Version 2.06 244
Exporting data to ARGUS Development Budget
246
Exporting data to ReXML 250

F

File Properties 263
Tracking 264

Fill Down 60, 61
Finance

Basic (Interest Sets) 136
Calculation Assumptions 12
Charging Period 12
Compounding Period 12
Include Interest in IRR Calculations 13
Interest Sets 15
Interest/PR Sets Definition 149
Structured Finance 135, 196
Structured Finance Module 136

Fixed Amount items 98
Forecast Data Wizard 250

G

Graphical Analysis 221
Graphical Distribution

Enable Partial Distribution 114
Locking a cell’s value 113

Graphs 221
Gross Sales Tax 207, 258

Applying GST 207
Cash Flow 190
Cash Flow Row Properties 182, 192
Default GST Settings 207
GST Calculations Active 207

H

Hide Rows 182, 187, 192
Hiding the ARGUS Zone sidebar 233
Highlighted Funding Source Report 204
Hotels 50

Occupancy Profile 51
Occupancy Rate 51
Vacancy Allowance 50

I

Imperial measurements 266
Import & Export

Export Summary 246
Importing and Exporting Data 241

Export to ARGUS Development Budget®
243

Export to ARGUS Multiview® 243
Export to ARGUS Valuation - Capitalisa-

tion® 243
Export to Comma Separated Values file 243
Export to Excel® 243
Exporting Data 242
Import and Export Wizard 244

Export Cash Flow 244

Importing Data 241
Microsoft® Excel® 242

Inflation 16
Cash Flow 189
Cash Flow Row Properties 182, 192
Inflation Sets 16
Stepped 17

Interest
Calculation Assumptions 12
Cash Flow 189
Cash Flow Row Properties 182
Cashflow Row Properties 192
Interest Sets 15

Interest/PR Sets 149
Internal Rate of Return (IRR)

Combined Sources IRR 165
Equity IRR 166
Include Interest in IRR Calculations 13
Initial IRR Guess Rate 14
IRR % 159
IRR Calculations 164
Pre-Finance IRR 164
Project Pro Forma 271

Inter-relating phases and stages 26
Inter-Source Transactions 135

L

Labels - customizing 116
Land Transfer Tax 108, 120
Language 258
Leasing Void Period 44
Lock Rows 182, 187, 192

M

Managing Files 227
Creating a new project 227
Emailing a Project 230
Naming a project 229
Opening a project 227
Saving a project 229

Marketing, Leasing & Disposal Costs 127
Leasing Cost 127
Purchasers Costs 128
Sales Fees 128

Measurement Units 66, 266
Merging phases 26
Metric measurements 266
Multi Unit Sales 72
Municipal Costs 258
Municipal Fees 124

N

Negative Land Value 18
Notes and Images 216

O

Occupancy Profile - Hotels 51
Occupancy Rate - Hotels 51
Open Project 227
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Opening a folder in the Zone 232
Opening a workspace 232
Operated Asset profile 89
Operated Assets 77
Options 265

P

Period Zero 268
Printing Reports 209

Cash Flow cycle 212
Cash Flow totals 213
Caveats 214
Company Name 210
Detailed Cash Flow 209
Footers 212
Headers 212
Notes and Images 216
Options for Assumptions Report 212
Options for Cover Sheet 212
Page Numbers 212
Page setup 214

Font 214
Margin settings 214
Paper size 214

Print Cash Flow amounts in 000’s 213
Print full file path and name 212
Print hidden rows 213
Print Logo on Report 212
Print rows with a zero value 213
Print the Cash Flow in portrait 213
Print the description “Part” or “Phase” 212
Project Pro Forma 209
Report Setup 211
Row headings on Cash Flow pages 212
Row numbers 213
Section subtotals 213
To Print a Report 210
Watermarks 215

Professional Fees 125
Other Professionals 125

Profit
Residual Target 18

Project Pro Forma 219
Export 246
Report 209
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